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Safety information

Always follow basic safety precautions
when using this product to reduce risk
of injury from fire or electric shock.

1. Read and understand all
instructions in the documentation that
comes with the printer.

2. Observe all warnings and
instructions marked on the product.

3. Unplug this product from wall
outlets before cleaning.

4. Do not install or use this product
near water, or when you are wet.

5. Install the product securely on
a stable surface.

6. Install the product in a protected
location where no one can step on or
trip over the line cord, and the line
cord cannot be damaged.

7. If the product does not operate
normally, see Solve a problem.

8. There are no user-serviceable parts
inside. Refer servicing to qualified
service personnel.

Accessibility
The printer provides a number of
features that make it accessible for
people with disabilities.

Visual

The printer software is accessible for
users with visual impairments or low

vision through the use of your
operating system's accessibility
options and features. It also supports
most assistive technology such as
screen readers, Braille readers, and
voice-to-text applications. For users
who are color blind, colored buttons
and tabs used in the software and on
the printer control panel have simple
text or icon labels that convey the
appropriate action.

Mobility

For users with mobility impairments,
the printer software functions can be
executed through keyboard
commands. The software also
supports Windows accessibility
options such as StickyKeys,
ToggleKeys, FilterKeys, and
MouseKeys. The printer doors,
buttons, paper trays, and paper guides
can be operated by users with limited
strength and reach.

Support

For more details about the
accessibility of this product and HP's
commitment to product accessibility,
visit HP's website at www.hp.com/
accessibility.

For accessibility information for the
Mac OS X, visit the Apple website at
www.apple.com/accessibility.

http://www.hp.com/accessibility
http://www.hp.com/accessibility
http://www.apple.com/accessibility/


Contents

1 Get started
Accessibility................................................................................................................................6
Eco..............................................................................................................................................7
Understand the printer parts.......................................................................................................8

Front view.............................................................................................................................8
Printing supplies area...........................................................................................................8
Back view..............................................................................................................................9

Use the printer control panel......................................................................................................9
Overview of buttons and lights...........................................................................................10
Change printer settings......................................................................................................11
Print reports........................................................................................................................11

Finding the printer model number.............................................................................................11
Select print media.....................................................................................................................11

Recommended papers for printing and copying.................................................................12
Recommended papers for photo printing...........................................................................13
Tips for selecting and using media.....................................................................................14

Load media...............................................................................................................................14
Load standard-size media..................................................................................................14
Load envelopes..................................................................................................................15
Load cards and photo paper...............................................................................................17
Load custom-size media.....................................................................................................17

Install the accessories..............................................................................................................19
Install the duplexer.............................................................................................................19
Install Tray 2.......................................................................................................................19
Configure trays...................................................................................................................21
Turn on accessories in the printer driver............................................................................22

To turn on accessories (Windows)...............................................................................22
To turn on accessories (Mac OS X)..............................................................................22

Maintain the printer...................................................................................................................23
Clean the exterior ..............................................................................................................23

Update the printer.....................................................................................................................23
Turn the printer off....................................................................................................................23

2 Print
Print documents........................................................................................................................24

Print documents (Windows)................................................................................................25
Print documents (Mac OS X)..............................................................................................25

Print brochures.........................................................................................................................25
Print brochures (Windows).................................................................................................26
Print brochures (Mac OS X)................................................................................................26

Print on envelopes....................................................................................................................26
Print on envelopes (Windows)............................................................................................27
Print on envelopes (Mac OS X)..........................................................................................27

1



Print photos..............................................................................................................................28
Print photos on photo paper (Windows).............................................................................28
Print photos on photo paper (Mac OS X)...........................................................................28

Print on special and custom-size paper....................................................................................29
Print on special or custom-size paper (Mac OS X).............................................................29

Print borderless documents......................................................................................................30
Print borderless documents (Windows)..............................................................................31
Print borderless documents (Mac OS X)............................................................................31

Print on both sides (duplexing).................................................................................................32

3 HP ePrint
Set up HP ePrint.......................................................................................................................34

Set up HP ePrint using the HP printer software ................................................................34
Set up HP ePrint using the printer’s control panel..............................................................35
Set up HP ePrint using the embedded web server.............................................................35

Use HP ePrint...........................................................................................................................35
Print using HP ePrint..........................................................................................................36
Find the printer’s email address.........................................................................................36
Turn off HP ePrint...............................................................................................................36

Remove Web Services.............................................................................................................36

4 Work with ink cartridges
Information on ink cartridges and the printhead.......................................................................37
Check the estimated ink levels.................................................................................................38
Print with one or more depleted cartridges...............................................................................38
Replace the ink cartridges........................................................................................................38
Store printing supplies..............................................................................................................40
Usage information collection....................................................................................................40

5 Solve a problem
HP support................................................................................................................................41

Obtain electronic support....................................................................................................42
HP support by phone..........................................................................................................42

Before you call..............................................................................................................43
Phone support period...................................................................................................43
Telephone support numbers.........................................................................................43
After the phone support period.....................................................................................44

General troubleshooting tips and resources.............................................................................45
Solve printer problems..............................................................................................................45

The printer shuts down unexpectedly.................................................................................46
Alignment fails....................................................................................................................46
The printer is not responding (nothing prints).....................................................................46
The printer prints slowly......................................................................................................47
The printer is making some unexpected noises.................................................................48
Blank or partial page printed...............................................................................................48
Something on the page is missing or incorrect...................................................................49
Placement of the text or graphics is wrong.........................................................................49

Print quality troubleshooting.....................................................................................................50
Solve paper-feed problems......................................................................................................54

2



Solve problems using HP ePrint and HP websites...................................................................55
Solve problems using HP ePrint.........................................................................................56
Solve problems using HP websites....................................................................................57

Solve wired (Ethernet) network problems.................................................................................57
General network troubleshooting........................................................................................57

Solve wireless problems...........................................................................................................57
Basic wireless troubleshooting...........................................................................................58
Advanced wireless troubleshooting....................................................................................58

Step 1: Make sure your computer is connected to your network..................................59
Step 2: Make sure that the printer is connected to your network.................................60
Step 3: Check to see if the firewall software is blocking communication......................61
Step 4: Make sure the printer is online and ready........................................................61
Step 5: Make sure the wireless version of the printer is set as the default printer
driver (Windows only)...................................................................................................62
Step 6: Make sure your computer is not connected to your network over a Virtual
Private Network (VPN)..................................................................................................62

After resolving the problems ..............................................................................................63
Wireless Direct Printing......................................................................................................63

Configure your firewall software to work with the printer..........................................................64
Solve printer management problems........................................................................................65

Embedded web server cannot be opened..........................................................................65
Troubleshoot installation issues...............................................................................................66

Hardware installation suggestions......................................................................................66
HP software installation suggestions..................................................................................67
Solve network problems.....................................................................................................67

Understand the Printer Status Report......................................................................................68
Understand the network configuration page.............................................................................70
Printhead maintenance.............................................................................................................73

Clean the printhead............................................................................................................74
Align the printhead..............................................................................................................75
Remove and reinstall the printhead....................................................................................75

Clear jams.................................................................................................................................77
Clear paper jams................................................................................................................77
Avoid paper jams................................................................................................................79

Control-panel lights reference..................................................................................................79

A Technical information
Warranty information................................................................................................................86

Hewlett-Packard limited warranty statement......................................................................87
Ink cartridge warranty information......................................................................................88

Contents

3



Printer specifications................................................................................................................89
Physical specifications........................................................................................................89
Product features and capacities.........................................................................................89
Processor and memory specifications................................................................................90
System requirements..........................................................................................................90
Network protocol specifications..........................................................................................90
Embedded web server specifications.................................................................................91
Media specifications...........................................................................................................91

Understand specifications for supported media...........................................................91
Set minimum margins...................................................................................................94
Guidelines for printing on both sides of a page............................................................95

Print specifications..............................................................................................................95
HP ePrint and HP website specifications...........................................................................95

HP ePrint specifications................................................................................................95
HP website specifications.............................................................................................96

Environmental specifications..............................................................................................96
Electrical specifications.......................................................................................................96
Acoustic emission specifications........................................................................................96

Regulatory information.............................................................................................................97
FCC statement....................................................................................................................97
Notice to users in Korea.....................................................................................................98
VCCI (Class B) compliance statement for users in Japan..................................................98
Notice to users in Japan about the power cord..................................................................98
Noise emission statement for Germany.............................................................................98
LED indicator statement.....................................................................................................98
Gloss of housing of peripheral devices for Germany..........................................................99
European Union Regulatory Notice....................................................................................99
Regulatory information for wireless products...................................................................100

Exposure to radio frequency radiation........................................................................100
Notice to users in Brazil..............................................................................................100
Notice to users in Canada..........................................................................................100
Notice to users in Taiwan...........................................................................................101

Regulatory model number................................................................................................101
Environmental product stewardship program.........................................................................102

Paper use.........................................................................................................................102
Plastics.............................................................................................................................102
Material safety data sheets...............................................................................................102
Recycling program............................................................................................................102
HP inkjet supplies recycling program...............................................................................102
Disposal of waste equipment by users in private households in the European Union.....103
Power consumption..........................................................................................................104
Chemical Substances.......................................................................................................104
Battery information...........................................................................................................104

Battery disposal in Taiwan..........................................................................................104
Attention California users...........................................................................................104

RoHS notices (China only)...............................................................................................105
RoHS notices (Ukraine only)............................................................................................105

Third-party licenses................................................................................................................106

4



B HP supplies and accessories
Order printing supplies online.................................................................................................114
Supplies..................................................................................................................................114

Ink cartridges and printheads...........................................................................................114
HP media..........................................................................................................................115

C Network setup
Change basic network settings...............................................................................................116

View and print network settings........................................................................................116
Turn the wireless radio on and off....................................................................................116

Change advanced network settings.......................................................................................116
Set link speed...................................................................................................................117
View IP settings................................................................................................................117
Change IP settings...........................................................................................................117
Configure the printer’s firewall settings.............................................................................117

Creating and using firewall rules................................................................................118
Reset network settings.....................................................................................................119

Set up the printer for wireless communication........................................................................119
Before you begin..............................................................................................................120
Set up the printer on your wireless network.....................................................................120
Set up the printer using the HP printer software (Recommended)...................................120
Set up the printer using WiFi Protected Setup (WPS)......................................................120

To connect the printer using the Push Button Method...............................................121
To connect the printer using the PIN Method.............................................................121

Set up the printer using the embedded web server (EWS)..............................................121
Change the connection type.............................................................................................121

To change from an Ethernet connection to a wireless connection.............................122
To change from a USB connection to a wireless connection.....................................122
To change from a wireless connection to a USB or Ethernet connection .................122

Test the wireless connection............................................................................................122
Guidelines for ensuring wireless network security............................................................122

Overview of security settings......................................................................................123
Add hardware addresses to a wireless router (MAC filtering)....................................123
Other wireless security guidelines..............................................................................123

Guidelines for reducing interference on a wireless network.............................................124
Uninstall and reinstall the HP software...................................................................................124

Windows...........................................................................................................................124
Mac OS X.........................................................................................................................125

D Printer management tools
Toolbox (Windows).................................................................................................................126
HP Utility (Mac OS X).............................................................................................................126
Embedded web server............................................................................................................126

About cookies...................................................................................................................127
To open the embedded web server..................................................................................127

Index............................................................................................................................................137

Contents

5



1 Get started
This guide provides details about how to use the printer and how to resolve problems.

• Accessibility

• Eco

• Understand the printer parts

• Use the printer control panel

• Finding the printer model number

• Select print media

• Load media

• Install the accessories

• Maintain the printer

• Update the printer

• Turn the printer off

NOTE: If you are using the printer with a computer running Windows XP Starter
Edition, Windows Vista Starter Edition, or Windows 7 Starter Edition, some features
might not be available. For more information, see System requirements.

Accessibility
The printer provides a number of features that make it accessible for people with
disabilities.

Visual

The HP software provided with the printer is accessible for users with visual
impairments or low vision by using your operating system's accessibility options and
features. The software also supports most assistive technology such as screen
readers, Braille readers, and voice-to-text applications. For users who are color blind,
colored buttons and tabs used in the HP software and on the printer control panel have
simple text or icon labels that convey the appropriate action.

Mobility

For users with mobility impairments, the HP software functions can be executed
through keyboard commands. The HP software also supports Windows accessibility
options such as StickyKeys, ToggleKeys, FilterKeys, and MouseKeys. The printer
doors, buttons, paper trays, and paper guides can be operated by users with limited
strength and reach.

Support

For more details about the accessibility of this printer and HP's commitment to product
accessibility, visit HP's website at www.hp.com/accessibility.

For accessibility information for Mac OS X, visit the Apple website at www.apple.com/
accessibility.
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Eco
Hewlett-Packard is committed to providing quality products in an environmentally
sound manner. Design for recycling has been incorporated into this product. For more
information, see Environmental product stewardship program

HP is committed to helping customers reduce their environmental footprint. HP has
provided these features to help you focus on ways to assess and reduce the impact of
your printing choices.

For more information about HP's environmental initiatives, visit www.hp.com/hpinfo/
globalcitizenship/environment/.

Manage power

To conserve electricity, try the following:

• Turn on the printer's Sleep Mode feature, and then select the option for the shortest
time. After the printer has been inactive for this period of time, the printer will go

into low-power mode. To configure this feature, touch  (eco button) on the
printer’s control panel display, touch Sleep, and then touch the desired option.

• Use the printer's Schedule On and Off feature, and then select the days and time
you want the printer to turn on and turn off automatically. For example, you can
schedule the printer to turn on at 8am and turn off at 8pm from Monday to Friday.
In this way, you will save energy during the night and weekends. To configure this

feature, touch  (eco button) on the printer's control panel display, touch
Schedule On and Off, and then set the time to turn on and off the printer.

• Adjust the screen brightness to a dimmer setting. To configure this feature, touch

 (eco button) on the printer's control panel display, touch Screen
Brightness, and then set the desired option.

NOTE: The printer's Sleep Mode and Schedule On and Off features are
temporarily not available if one or more of the ink cartridges are missing. After the
cartridge is reinstalled, these features resume.

CAUTION: HP recommends that you replace any missing cartridges as soon as
possible to avoid print quality issues and possible extra ink usage or damage to the
ink system. Never turn off the printer when ink cartridges are missing.

Conserve printing supplies

To conserve printing supplies such as ink and paper, try the following:

• Change the print mode to a draft setting. Draft setting uses less ink.

• Do not clean the printhead unnecessarily. This wastes ink and shortens the life of
the cartridges.

• Reduce paper usage by printing on both sides of the paper. If the printer has an HP
automatic two-sided printing accessory (duplexer), see Print on both sides
(duplexing). Otherwise, you can first print just the odd pages, flip the pages over,
and then print just the even pages.

Eco 7
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Understand the printer parts
This section contains the following topics:

• Front view
• Printing supplies area
• Back view

Front view

1

2

3

4

8

7

5
6

1 Top cover

2 Ink-cartridge access door

3 Output tray

4 Control-panel display

5  (Power button)

6 Control panel

7 Output tray extension

8 Tray 1

Printing supplies area

2

1
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1 Ink-cartridge access door

2 Ink cartridges

Back view

1

2

34

1 Ethernet network port

2 Rear universal serial bus (USB) port

3 Power input

4 Automatic two-sided printing accessory (duplexer)

Use the printer control panel
This section contains the following topics:

• Overview of buttons and lights

• Change printer settings

• Print reports

Use the printer control panel 9



Overview of buttons and lights

For more information about control panel light patterns and messages, see Control-
panel lights reference.

21 3 4

12

5

6

7

911 810

Label Name and Description

1 Printhead align control panel icon. Shows that the printhead requires alignment.

2 Ink cartridge access door open icon. Shows that the printer's ink cartridge access door or
top cover is open.

3 Out of paper icon. Shows that the printer is out of paper.

4 Paper jam icon. Shows that the printer has a paper jam.

5  Resume button and light. Press to continue a print job after a paper jam or adding paper.
Press to cancel a print job when a media size mismatch occurs. Press and hold for three
seconds to print a demo page. The Resume light blinks when the button must be pressed to
resume printing.

6  Cancel button. Press once to stop a print job, or press and hold for three seconds to print
a printer status report.

7  Power button and light. Press to turn the printer on or off. The light indicates whether the
printer is on or off.

8  ePrint button and light. Press to enable the HP ePrint function. The light indicates when
the printer is connected to an ePrint server. Press and hold for three seconds to print the
firmware information page.

9  Wireless button and light. Press to turn the wireless network feature on or off. The
button is lit when the wireless network is on.

10 Wired network icon. Shows that a wired network connection exists.

11 Wireless network icon. Shows that a wireless network connection exists.

Chapter 1
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Label Name and Description

12 Ink cartridge information icons. Displays ink cartridge information, including fill levels.

NOTE: Ink level warnings and indicators provide estimates for planning purposes only.
When you receive a low on ink message, consider having a replacement cartridge available
to avoid possible printing delays. You do not need to replace cartridges until prompted to do
so.

Change printer settings

If the printer is connected to a computer, you can change the printer settings using HP
software tools available on your computer — such as the HP printer software, HP
Utility (Mac OS X), or the EWS. For more information about these tools, see Printer
management tools.

Print reports

Use the control panel to print the following reports for the printer.

• Printer status report. Press and hold the  (Cancel) button for three seconds.

• Network configuration page and Wireless network test page. Press the

 (Wireless) button and then release.

• Demo page. Press and hold the  (Resume) button for three seconds.

Finding the printer model number
In addition to the model name that appears on the front of the printer, the printer has
a specific model number. You can use this number when obtaining support and to help
determine which supplies or accessories are available for your printer.

The model number is printed on a label located near the ink-cartridge access door.

Select print media
The printer is designed to work well with most types of office media. It is best to test
a variety of print media types before buying large quantities. Use HP media for
optimum print quality. Visit the HP website at www.hp.com for more information about
HP media.

HP recommends plain papers with the ColorLok logo for printing
and copying of everyday documents. All papers with the
ColorLok logo are independently tested to meet high standards
of reliability and print quality, and produce documents with crisp,
vivid color, bolder blacks and dry faster than ordinary plain
papers. Look for papers with the ColorLok logo in a variety of
weights and sizes from major paper manufacturers.

(continued)
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This section contains the following topics:

• Recommended papers for printing and copying

• Recommended papers for photo printing

• Tips for selecting and using media

Recommended papers for printing and copying

If you want the best print quality, HP recommends using HP papers that are specifically
designed for the type of project you are printing.

Depending on your country/region, some of these papers might not be available.

HP Brochure Paper

HP Professional Paper

These papers are glossy-coated or matte-coated on both sides for
two-sided use. They are the perfect choice for producing professional
quality marketing materials such as brochures and mailers, as well as
business graphics for report covers and calendars.

HP Premium
Presentation Paper

HP Professional Paper

These papers are heavy two-sided matte papers perfect for
presentation, proposals, reports, and newsletters. They are
heavyweight for an impressive look and feel.

HP Bright White Inkjet
Paper

HP Bright White Inkjet Paper delivers high-contrast colors and sharp
text. It is opaque enough for two-sided color usage with no
showthrough, which makes it ideal for newsletters, reports, and flyers.
It features ColorLok Technology for less smearing, bolder blacks, and
vivid colors.

HP Printing Paper HP Printing Paper is a high-quality multifunction paper. It produces
documents that look and feel more substantial than documents
printed on standard multipurpose or copy paper. It features ColorLok
Technology for less smearing, bolder blacks, and vivid colors.

HP Office Paper HP Office Paper is a high-quality multifunction paper. It is suitable for
copies, drafts, memos and other everyday documents. It features
ColorLok Technology for less smearing, bolder blacks, and vivid
colors.

HP Office Recycled
Paper

HP Office Recycled Paper is a high-quality multifunction paper made
with 30% recycled fiber. It features ColorLok Technology for less
smearing, bolder blacks, and vivid colors.

HP Premium Plus
Photo Paper

HP’s best photo paper is heavyweight for producing professional
quality photos. Features an instant-dry finish for easy handling
without smudging. It resists water, smears, fingerprints, and humidity.
It is available in several sizes, including A4, 8.5 x 11 inch, 10 x 15 cm
(4 x 6 inch), 13 x 18 cm (5 x 7 inch), and two finishes – glossy or soft-
gloss (satin matte). It is acid-free for longer lasting documents.

HP Advanced Photo
Paper

This thick photo paper features an instant-dry finish for easy handling
without smudging. It resists water, smears, fingerprints, and humidity.
Your prints have a look and feel comparable to a store processed
photo. It is available in several sizes, including A4, 8.5 x 11 inch, 10
x 15 cm (4 x 6 inch), 13x18 cm (5 x7 inch), and two finishes – glossy
or soft gloss (satin matte). It is acid-free for longer lasting documents.

HP Everyday Photo
Paper

Print colorful, everyday snapshots at a low cost, using paper
designed for casual photo printing. This affordable, photo paper dries
quickly for easy handling. Get sharp, crisp images when you use this
paper with any inkjet printer. Available in semi-gloss finish in 8.5 x11

Chapter 1
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inch, A4, 4 x 6 inch and 10 x 15 cm. It is acid-free for longer lasting
documents.

HP Iron-On Transfers HP Iron-on Transfers (for color fabrics or for light or white fabrics) are
the ideal solution for creating custom T-shirts from your digital photos.

To order HP papers and other supplies, go to www.hp.com. Go to Shop for Products
and Services, and select Ink, toner and paper .

NOTE: At this time, some portions of the HP website are available in English only.

Recommended papers for photo printing

For the best print quality, HP recommends using HP papers that are specifically
designed for the type of project you are printing. Depending on your country/region,
some of these papers might not be available.

Depending on your country/region, some of these papers might not be available.

HP Premium Plus
Photo Paper

HP’s best photo paper is heavyweight for producing professional
quality photos. Features an instant-dry finish for easy handling
without smudging. It resists water, smears, fingerprints, and humidity.
It is available in several sizes, including A4, 8.5 x 11 inch, 10 x 15 cm
(4 x 6 inch), 13 x 18 cm (5 x 7 inch), and two finishes – glossy or soft-
gloss (satin matte). It is acid-free for longer lasting documents.

HP Advanced Photo
Paper

This thick photo paper features an instant-dry finish for easy handling
without smudging. It resists water, smears, fingerprints, and humidity.
Your prints have a look and feel comparable to a store processed
photo. It is available in several sizes, including A4, 8.5 x 11 inch, 10
x 15 cm (4 x 6 inch), 13x18 cm (5 x7 inch), and two finishes – glossy
or soft gloss (satin matte). It is acid-free for longer lasting documents.

HP Everyday Photo
Paper

Print colorful, everyday snapshots at a low cost, using paper
designed for casual photo printing. This affordable, photo paper dries
quickly for easy handling. Get sharp, crisp images when you use this
paper with any inkjet printer. Available in semi-gloss finish in 8.5 x11
inch, A4, 4 x 6 inch, and 10 x 15 cm. It is acid-free for longer lasting
documents.

HP Photo Value Packs HP Photo Value Packs conveniently package original HP ink
cartridges and HP Advanced Photo Paper to save you time and take
the guesswork out of printing affordable, lab-quality photos with your
HP printer. Original HP inks and HP Advanced Photo Paper have
been designed to work together so your photos are long lasting and
vivid, print after print. Great for printing out an entire vacation’s worth
of photos or multiple prints to share.

To order HP papers and other supplies, go to www.hp.com. Go to Shop for Products
and Services and select Ink, toner and paper.

NOTE: At this time, some portions of the HP website are available in English only.

(continued)
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Tips for selecting and using media

For the best results, observe the following guidelines.

• Always use media that conforms to the printer specifications. For more information,
see Media specifications.

• Load only one type of media at a time into a tray.

• When loading the trays, make sure the media is loaded correctly. For more
information, see Load media.

• Do not overload the tray. For more information, see Load media

• To prevent jams, poor print quality, and other printing problems, avoid loading the
following media in the trays.

◦ Multipart forms

◦ Media that is damaged, curled, or wrinkled

◦ Media with cutouts or perforations

◦ Media that is heavily textured, embossed, or does not accept ink well

◦ Media that is too lightweight or stretches easily

◦ Media that contains staples or clips

Load media
This section provides instructions for loading media into the printer.

This section contains the following topics:

• Load standard-size media

• Load envelopes

• Load cards and photo paper

• Load custom-size media

Load standard-size media

To load media

Use these instructions to load standard media.

1. Pull out Tray 1.

Chapter 1
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2. Insert the media print-side down in the center of the tray. Make sure the stack of
media aligns with the line on the width guide, and is not higher than the paper stack
line on the guide.

NOTE: Do not load paper while the printer is printing.

3. Slide the media guides in the tray to adjust them for the media size that you have
loaded, and then reinsert the tray.

4. Pull out the extension on the output tray.

Load envelopes

To load envelopes

Use these instructions to load an envelope.

1. Pull out Tray 1.

Load media 15



2. Insert the envelopes print-side down and load according to the graphic. Make sure
the stack of envelopes does not exceed the line marking in the tray.

NOTE: Do not load paper while the printer is printing.

3. Slide the media guides in the tray to adjust them for the media size that you have
loaded, and then reinsert the tray.

4. Pull out the extension on the output tray.

Chapter 1
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Load cards and photo paper

To load cards and photo paper

Use these instructions to load photo paper.

1. Pull out Tray 1.

2. Insert the media print-side down in the center of the tray. Make sure the stack of
media aligns with the line on the width guide, and is not higher than the paper stack
line on the guide.

NOTE: Do not load paper while the printer is printing.

3. Slide the media guides in the tray to adjust them for the media size that you have
loaded, and then reinsert the tray.

4. Pull out the extension on the output tray.

Load custom-size media

To load custom-size media

Use these instructions to load custom-size media.

CAUTION: Use only custom-size media that is supported by the printer. For more
information, see Media specifications.
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1. Pull out Tray 1.

2. Insert the media print-side down in the center of the tray. Make sure the stack of
media aligns with the line on the width guide, and is not higher than the paper stack
line on the guide.

NOTE: Do not load paper while the printer is printing.

3. Slide the media guides in the tray to adjust them for the media size that you have
loaded, and then reinsert the tray.

4. Pull out the extension on the output tray.

Chapter 1
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Install the accessories
This section contains the following topics:

• Install the duplexer

• Install Tray 2

• Configure trays

• Turn on accessories in the printer driver

Install the duplexer

You can print on both sides of a sheet of paper automatically. For information on using
the duplexer, see Print on both sides (duplexing).

To install the duplexer

▲ Slide the duplexer into the back of the printer until the unit locks into place. Do not
press the buttons on either side of the duplexer when installing the unit; use them
only for removing the unit from the printer.

Install Tray 2

NOTE: Tray 2 is available as an optional accessory.

Tray 2 can hold up to 250 sheets of plain paper. For ordering information, see HP
supplies and accessories.

To install Tray 2

1. Unpack the tray, remove the packing tapes and materials, and move the tray to the
prepared location. The surface must be sturdy and level.

2. Turn off the printer, and disconnect the power cord.
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3. Set the printer on top of the tray.

CAUTION: Be careful to keep your fingers and hands clear of the bottom of
the printer.

4. Connect the power cord and turn on the printer.

5. Enable Tray 2 in the printer driver. For more information, see Turn on accessories
in the printer driver.

To load Tray 2

1. Pull the tray out of the printer by grasping under the front of the tray.

2. Insert the paper print-side down in the center of the tray. Make sure the stack of
paper aligns with the line on the width guide, and does not exceed the line marking
on the guide.

NOTE: Tray 2 can be loaded only with plain paper.
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3. Slide the media guides in the tray to adjust them for the size that you have loaded.

4. Gently reinsert the tray.

5. Pull out the extension on the output tray.

Configure trays

NOTE: Tray 2 is an optional accessory. For ordering information, see Order
printing supplies online.

To configure the trays, you must have Tray 2 installed and turned on.

By default, the printer draws media from Tray 1. If Tray 1 is empty, the printer draws
media from Tray 2 (if it is installed and loaded with media). You can change this default
behavior by using the following features:

• Tray Lock: Use this feature to protect special media such as letterhead or
preprinted media from accidental use. If the printer runs out of media while printing
a document, it will not use media from a locked tray to complete the print job.

• Default Tray: Use this feature to determine the first tray from which the printer
draws media.

NOTE: To use the tray lock and default tray settings, you must select the
automatic tray selection option in the printer software. If the printer is on a network
and you set a default tray, the setting will affect all users of the printer.
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Tray 2 is designed to hold only plain paper.

The following table lists possible ways you can use the tray settings to meet your
printing needs.

I want to... Follow these steps

Load both trays with the same media, and
have the printer pick media from one tray if the
other one is empty.

• Load media in Tray 1 and Tray 2. For
more information, see Load media.

• Make sure tray lock is disabled.

Have both special media (such as
transparencies or letterhead) and plain paper
loaded in the trays.

• Load special media in Tray 1 and plain
paper in Tray 2.

• Make sure the default tray is set to Tray 2.

• Make sure tray lock is set to Tray 1.

Load media in both trays but have the printer
pick media from a specific tray first.

• Load media in Tray 1 and Tray 2.

• Make sure default tray is set to the
appropriate tray.

To configure the trays

1. Make sure the printer is turned on.

2. Perform one of the following:

• Embedded web server: Click the Settings tab and click Paper Handling in
the left panel.

• Print driver (Windows): Click the Printer services button on the Features
tab, and then select Paper Handling.

• HP Printer Utility (Mac OS X): Click Paper Handling from the Printer
Settings panel.

3. Click OK or Apply after changing the desired tray settings.

Turn on accessories in the printer driver

• To turn on accessories (Windows)

• To turn on accessories (Mac OS X)

To turn on accessories (Windows)

1. Click Start, point to Settings, and then click Printers or Printers and Faxes.
- Or -
Click Start, click Control Panel, and then double-click Printers.

2. Right-click the printer icon, and then click Properties.

3. Select the Device Settings tab. Click the accessory that you want to turn on, click
Installed from the drop-down menu, and then click OK.

To turn on accessories (Mac OS X)

Mac OS X automatically turns on all accessories in the printer driver when you install
the printer software. If you add a new accessory later, follow these steps:

1. Open the System Preferences and then select Print & Fax.

2. Select the printer from list of printers, and then click Options & Supplies.
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3. Click the Driver tab.

4. Select the options you want to install, and then click OK.

Maintain the printer
This section provides instructions for keeping the printer in top working condition.
Perform this maintenance procedure as necessary.

• Clean the exterior

Clean the exterior 

WARNING! Before cleaning the printer, turn off the power and unplug the power
cord from the electrical socket.

Use a soft, damp, lint-free cloth to wipe dust, smudges, and stains off of the case. The
exterior of the printer does not require cleaning. Keep fluids away from the interior of
the printer, as well as from the printer control panel.

Update the printer
HP is always working to improve the performance of its printers and bring you the
latest features. If the printer is connected to a network and Web Services has been
enabled, you can check for and install printer updates.

To update the printer, complete the following steps:

1. Open the EWS. For more information, seeEmbedded web server.

2. Click the Web Services tab, and then click Product Update in the Web Services
Settings section.

3. Click Check Now and follow the onscreen instructions.

TIP: To enable the printer to automatically check for updates, click the Web
Services tab, and then click Product Update. In the Auto Product Update
section, click On, and then click Apply.

Turn the printer off

Turn the printer off by pressing the  (Power) button located on the printer. Wait until
the power light turns off before unplugging the power cord or turning off a power strip. If
you incorrectly turn the printer off, the print carriage might not return to the correct
position causing problems with the ink cartridges and print quality issues.

CAUTION: If you incorrectly turn the printer off, the print carriage might not return
to the correct position causing problems with the ink cartridges and print quality
issues.

CAUTION: HP recommends that you replace any missing cartridges as soon as
possible to avoid print quality issues and possible extra ink usage or damage to the
ink system. Never turn off the printer when ink cartridges are missing.
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2 Print
Most print settings are automatically handled by the software application. Change the
settings manually only when you want to change print quality, print on specific types of
paper, or use special features. For more information about selecting the best print
media for your documents, see Select print media.

Choose a print job to continue:

Print documents

Print brochures

Print on envelopes

Print photos

Print on special and custom-size paper

Print borderless documents

Print documents
Follow the instructions for your operating system.

• Print documents (Windows)

• Print documents (Mac OS X)

NOTE: This printer includes HP ePrint, a free service from HP that allows you to
print documents on your web-connected printer anytime, from any location, and
without any additional software or printer drivers. For more information, see HP
ePrint.
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Print documents (Windows)
1. Load paper in the tray. For more information, see Load media.

2. On the File menu in your software application, click Print.

3. Make sure the printer you want to use is selected.

4. To change settings, click the button that opens the Properties dialog box.
Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

5. Change the paper orientation on the Layout tab, and paper source, media type,
paper size, and quality settings on the Paper/Quality tab. To print in black and
white, click the Advanced button, and then change the Print in Grayscale option.

6. Click OK.

7. Click Print or OK to begin printing.

Print documents (Mac OS X)
1. Load paper in the tray. For more information, see Load media.

2. Select a paper size:

a. From the File menu in your software application, click Page Setup.

NOTE: If you do not see a Page Setup menu item, go to step 3.

b. Make sure the printer you want to use is selected in the Format For pop-up
menu.

c. Select the paper size from the Paper Size pop-up menu, and then click OK.

3. From the File menu in your software application, click Print.

4. Make sure the printer you want to use is selected.

5. Select the paper size from the Paper Size pop-up menu (if available).

6. Change the print settings for the option provided in the pop-up menus, as
appropriate for your project.

NOTE: If you do not see any options, click the blue disclosure triangle next to
the Printer pop-up menu.

7. Click Print to begin printing.

Print brochures
Follow the instructions for your operating system.

• Print brochures (Windows)

• Print brochures (Mac OS X)

NOTE: This printer includes HP ePrint, a free service from HP that allows you to
print documents on your web-connected printer anytime, from any location, and
without any additional software or printer drivers. For more information, seeHP
ePrint.
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Print brochures (Windows)

NOTE: To set print settings for all print jobs, make the changes in the HP software
provided with the printer. For more information on the HP software, see Printer
management tools.

1. Load paper in the tray. For more information, see Load media.

2. On the File menu in your software application, click Print.

3. Make sure the printer you want to use is selected.

4. To change settings, click the button that opens the Properties dialog box.
Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

5. Change the paper orientation on the Layout tab, and paper source, media type,
paper size, and quality settings on the Paper/Quality tab. To print in black and
white, click the Advanced button, and then change the Print in Grayscale option.

6. Click OK.

7. Click Print or OK to begin printing.

Print brochures (Mac OS X)
1. Load paper in the tray. For more information, see Load media.

2. Select a paper size:

a. From the File menu in your software application, click Page Setup.

NOTE: If you do not see a Page Setup menu item, go to step 3.

b. Make sure the printer you want to use is selected in the Format For pop-up
menu.

c. Select the paper size from the Paper Size pop-up menu, and then click OK.

3. From the File menu in your software application, click Print.

4. Make sure the printer you want to use is selected.

5. Select the paper size from the Paper Size pop-up menu (if available).

6. Click Paper Type/Quality from the pop-up menu, and then select the following
settings:

• Paper Type: The appropriate brochure paper type

• Quality: Normal or Best

NOTE: If you do not see these options, click the blue disclosure triangle next
to the Printer pop-up menu.

7. Select any other print settings that you want, and then click Print to begin printing.

Print on envelopes
Avoid envelopes with the following characteristics:

• Very slick finish

• Self-stick adhesives, clasps, or windows
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• Thick, irregular, or curled edges

• Areas that are wrinkled, torn, or otherwise damaged

Make sure the folds of envelopes you load in the printer are sharply creased.

NOTE: For more information about printing on envelopes, see the documentation
available with the software program you are using.

Follow the instructions for your operating system.

• Print on envelopes (Windows)

• Print on envelopes (Mac OS X)

Print on envelopes (Windows)
1. Load envelopes print-side down in the tray. For more information, see Load media.

2. On the File menu in your software application, click Print.

3. Make sure the printer you want to use is selected.

4. To change settings, click the button that opens the Properties dialog box.
Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

5. On the Layout tab, change the orientation to Landscape.

6. Click Paper/Quality, and then select the appropriate envelope type from the Paper
Size drop-down list.

TIP: You can change more options for the print job by using the features
available on the other tabs in the dialog box.

7. Click OK, and then click Print or OK to begin printing.

Print on envelopes (Mac OS X)
1. Load envelopes in the tray. For more information, see Load media.

2. Select a paper size:

a. From the File menu in your software application, click Page Setup.

NOTE: If you do not see a Page Setup menu item, go to step 3.

b. Make sure the printer you want to use is selected in the Format For pop-up
menu.

c. Select the appropriate envelope size from the Paper Size pop-up menu, and
then click OK.

3. From the File menu in your software application, click Print.

4. Make sure the printer you want to use is selected.

5. Select the appropriate envelope size in the Paper Size pop-up menu (if available).

6. Select the Orientation option.

NOTE: If you do not see these options, click the blue disclosure triangle next
to the Printer pop-up menu.

7. Select any other print settings that you want, and then click Print to begin printing.
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Print photos
Do not leave unused photo paper in the input tray. The paper might start to curl, which
could impair the quality of your printout. Photo paper should be flat before printing.

Follow the instructions for your operating system.

• Print photos on photo paper (Windows)

• Print photos on photo paper (Mac OS X)

NOTE: This printer includes HP ePrint, a free service from HP that allows you to
print documents on your web-connected printer anytime, from any location, and
without any additional software or printer drivers. For more information, see HP
ePrint.

Print photos on photo paper (Windows)
1. Load paper in the tray. For more information, see Load media.

2. On the File menu in your software application, click Print.

3. Make sure the printer you want to use is selected.

4. To change settings, click the option that opens the printer Properties dialog box.
Depending on your software application, this option might be called Properties,
Options, Printer Setup, Printer, or Preferences.

5. On the Paper/Quality tab, select the appropriate photo paper type from the Media
drop-down menu.

6. Click Advanced, and then select Best or Maximum DPI from the Output Quality
drop-down menu.

7. To print the photo in black and white, click the Grayscale drop-down menu, and
then select one of the following options:

• High-Quality Grayscale: uses all the available colors to print your photo in
grayscale. This creates smooth and natural shades of gray.

• Black Ink Only: uses black ink to print your photo in grayscale. The gray
shading is created by varying patterns of black dots, which might result in a
grainy image.

8. Click OK, and then click Print or OK to begin printing.

Print photos on photo paper (Mac OS X)
1. Load paper in the tray. For more information, see Load media.

2. Select a paper size:

a. From the File menu in your software application, click Page Setup.

NOTE: If you do not see a Page Setup menu item, go to step 3.

b. Make sure the printer you want to use is selected in the Format For pop-up
menu.

c. Select the paper size from the Paper Size pop-up menu, and then click OK.

3. From the File menu in your software application, click Print.

4. Make sure the printer you want to use is selected.
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5. Select the appropriate paper size from the Paper Size pop-up menu (if available).

6. Click Paper Type/Quality from the pop-up menu, and then select the following
settings:

• Paper Type: The appropriate photo paper type

• Quality: Best or Maximum dpi

NOTE: If you do not see these options, click the blue disclosure triangle next
to the Printer pop-up menu.

7. If necessary, change the photo and color options:

a. Click the disclosure triangle beside Color Options and select the appropriate
Photo Fix options:

• Off: Applies no automatic adjustments to the image.

• Basic: Automatically focuses the image; moderately adjusts image
sharpness.

b. To print the photo in black and white, click Grayscale from the Color pop-up
menu, and then select one of the following options:

• High Quality: Uses all the available colors to print your photo in grayscale.
This creates smooth and natural shades of gray.

• Black Print Cartridge Only: Uses black ink to print your photo in
grayscale. The gray shading is created by varying patterns of black dots,
which might result in a grainy image.

8. Select any other print settings that you want, and then click Print to begin printing.

Print on special and custom-size paper
If your application supports custom-size paper, set the size in the application before
printing the document. If not, set the size in the printer driver. You might need to
reformat existing documents to print them correctly on custom-size paper.

Use only custom-size paper that is supported by the printer. For more information, see
Media specifications.

NOTE: Defining custom-size media sizes is only available in the HP printing
software in Mac OS X.

Follow the instructions for your operating system.

• Print on special or custom-size paper (Mac OS X)

Print on special or custom-size paper (Mac OS X)

NOTE: Before you can print on custom-size paper, you must set up the custom
size in the HP software provided with the printer. For instructions, see Set up
custom sizes (Mac OS X).
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1. Load the appropriate paper in the tray. For more information, see Load media.

2. Select a paper size:

a. From the File menu in your software application, click Page Setup.

NOTE: If you do not see a Page Setup menu item, go to step 3.

b. Make sure the printer you want to use is selected in the Format For pop-up
menu.

c. Select the paper size from the Paper Size pop-up menu, and then click OK.

3. From the File menu in your software application, click Print.

4. Make sure the printer you want to use is selected.

5. Select the appropriate paper size from the Paper Size pop-up menu (if available).

6. Click Paper Handling from the pop-up menu.

7. Under Destination Paper Size, click Scale to fit paper size, and then select the
custom size.

8. Select any other print settings that you want, and then click Print to begin printing.

Set up custom sizes (Mac OS X)
1. Load paper in the tray. For more information, seeLoad media.

2. From the File menu in your software application, click Page Setup, and then make
sure the printer you want to use is selected in the Format For pop-up menu.
- OR -
From the File menu in your software application, click Print, and then make sure
the printer you want to use is selected.

3. Select Manage Custom Sizes in the Paper Size pop-up menu.

NOTE: If you do not see these options in the Print dialog, click the blue
disclosure triangle next to the Printer pop-up menu.

4. Click the + on the left side of the screen, double-click Untitled, and type a name for
the new, custom size.

5. In the Width and Height boxes, type the dimensions, and then set the margins, if
you want to customize them.

6. Click OK.

Print borderless documents
Borderless printing lets you print to the edges of certain photo media types and a range
of standard media sizes.

NOTE: You cannot print a borderless document if the paper type is set to Plain
paper.

NOTE: Before printing a borderless document, open the file in a software
application and assign the image size. Make sure the size corresponds to the
media size on which you are printing the image.

NOTE: Not all applications support borderless printing.
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Follow the instructions for your operating system.

• Print borderless documents (Windows)

• Print borderless documents (Mac OS X)

Print borderless documents (Windows)
1. Load paper in the tray. For more information, see Load media.

2. On the File menu in your software application, click Print.

3. Make sure the printer you want to use is selected.

4. To change settings, click the button that opens the Properties dialog box.
Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

5. Click the Paper/Quality tab, and then click the Advanced button.

6. In the Borderless Printing option, click Print Borderless, and then click the OK
button.

7. In the Media drop-down list, select the appropriate paper type.

8. Click OK, and then click Print or OK to begin printing.

Print borderless documents (Mac OS X)
1. Load paper in the tray. For more information, see Load media.

2. Select a borderless paper size:

a. From the File menu in your software application, click Page Setup.

NOTE: If you do not see a Page Setup menu item, go to step 3.

b. Make sure the printer you want to use is selected in the Format For pop-up
menu.

c. Select an available borderless paper size from the Paper Size pop-up menu,
and then click OK.

3. From the File menu in your software application, click Print.

4. Make sure the printer you want to use is selected.

5. Select the paper size from the Paper Size pop-up menu (if available).

6. Click Paper Type/Quality from the pop-up menu, and then select the following
settings:

• Paper Type: The appropriate paper type

• Quality: Best or Maximum dpi

NOTE: If you do not see these options, click the blue disclosure triangle next
to the Printer pop-up menu.

7. Make sure the Print Borderless check box is selected.

8. If necessary, click the blue disclosure triangle beside Color Options and select the
appropriate Photo Fix options:

• Off: Applies no automatic adjustments to the image.

• Basic: Automatically focuses the image; moderately adjusts image sharpness.

9. Select any other print settings that you want, and then click Print to begin printing.
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Print on both sides (duplexing)
You can print on both sides of a sheet of media automatically by using the HP
Automatic Two-sided Printing Accessory (duplexer).

TIP: You can perform manual duplexing by first printing only the odd pages,
flipping the pages over, and then printing only the even pages.

Perform two-sided printing (Windows)

1. Load the appropriate media. For more information, see Guidelines for printing on
both sides of a page and Load media.

2. Make sure the duplexer is installed correctly. For more information, see Install the
duplexer.

3. With a document open, click Print on the File menu, and then under the Print on
Both Sides options on the Layout tab, select either Flip on Long Edge or Flip on
Short Edge.

4. Change any other settings, and then click OK.

5. Print your document.

Perform two-sided printing (Mac OS X)

1. Load the appropriate media. For more information, see Guidelines for printing on
both sides of a page and Load media.

2. Make sure the duplexer is installed correctly. For more information, see Install the
duplexer.

3. Select a paper size:

a. From the File menu in your software application, click Page Setup.

NOTE: If you do not see a Page Setup menu item, go to step 4.

b. Make sure the printer you want to use is selected in the Format For pop-up
menu.

c. Select the paper size from the Paper Size pop-up menu, and then click OK.

4. From the File menu in your software application, click Print.

5. Make sure the printer you want to use is selected.

6. Select the paper size from the Paper Size pop-up menu (if available).

NOTE: You might need to select the paper-size option labeled Two-Sided
margins.
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7. Click the Two-Sided Printing pop-up menu, select Print Both Sides, and then
click the appropriate binding options for the document.
- OR -
Click the Layout pop-up menu, and then select the appropriate binding options for
the document from the Two-Sided pop-up menu.

NOTE: If you do not see any options, click the blue disclosure triangle next to
the Printer pop-up menu.

8. Select any other print settings that you want, and then click Print to begin printing.
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3 HP ePrint
HP ePrint is a free service from HP that allows you to print to your web-connected
printer anytime, from any location. It’s as simple as sending an email to the email
address assigned to your printer when you enable Web Services on the printer. No
special drivers or software are needed. If you can send an email, you can print from
anywhere, using HP ePrint.

Once you have signed up for an account on ePrintCenter, you can sign in to view your
HP ePrint job status, manage your HP ePrint printer queue, control who can use your
printer’s HP ePrint email address to print, and get help for HP ePrint.

NOTE: To use HP ePrint, the printer must be connected to the Internet (either
using an Ethernet cable or wireless connection). You cannot use these web
features if the printer is connected using a USB cable.

This section contains the following topics:

• Set up HP ePrint
• Use HP ePrint
• Remove Web Services

Set up HP ePrint
To set up HP ePrint, complete the following steps.

NOTE: Before you set up HP ePrint, make sure you are connected to the Internet
using either a wired (Ethernet) or wireless connection.

Set up HP ePrint using the HP printer software

In addition to enabling key printer features, you can use the HP printer software that
came with your printer to set up HP ePrint. If you didn’t set up HP ePrint when you
installed the HP software on your computer, you can still use the software to set up HP
ePrint.

To set up HP ePrint, complete the following steps for your operating system:

Windows

1. From the computer desktop, click Start, select Programs or All Programs, click
HP, click the folder for your printer, and then select the icon with your printer’s
name.

2. Double-click Web Connected Solutions, and then double-click ePrint Setup. The
printer’s embedded web server opens.

3. On the Web Services tab, click Setup in the Web Services Settings section.

4. Click Accept Terms of Use and Enable Web Services, and then click Next.

5. Click Yes to allow the printer to automatically check for and install product updates.

6. If your network uses proxy settings when connecting to the Internet, enter these
settings.

7. Follow the instructions on the Web Services information sheet to finish the setup.
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Mac OS X

▲ To set up and manage Web Services in Mac OS X, you can use the printer’s
embedded web server (EWS). For more information, see Set up HP ePrint using
the embedded web server.

Set up HP ePrint using the printer’s control panel

The printer’s control panel provides an easy way to set up and manage HP ePrint.

To set up HP ePrint, complete the following steps:

1. On the printer control panel, press the  (HP ePrint) button. The printer prints the
HP ePrint Setup page.

2. Follow the instructions on the page to set up HP ePrint.

Set up HP ePrint using the embedded web server

You can use the printer’s embedded web server (EWS) to set up and manage HP
ePrint.

To set up HP ePrint, complete the following steps:

1. Open the EWS. For more information, see Embedded web server.

2. On the Web Services tab, click Setup in the Web Services Settings section.

3. Click Accept Terms of Use and Enable Web Services, and then click Next.

4. Click Yes to allow the printer to automatically check for and install product updates.

5. If your network uses proxy settings when connecting to the Internet, enter these
settings.

6. Follow the instructions on the Web Services information sheet to finish the setup.

Use HP ePrint
HP ePrint allows you to print to your web-connected printer anytime, from any location.

To use HP ePrint, make sure to have the following:

• An Internet- and email-capable computer or mobile device

• An HP ePrint-capable printer on which Web Services has been enabled

TIP: For more information about managing and configuring HP ePrint settings and
to learn about the latest features, visit ePrintCenter (www.eprintcenter.com).
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Print using HP ePrint

To print documents using HP ePrint, complete the following steps:

1. On your computer or mobile device, open your email application.

NOTE: For information about using the email application on your computer or
mobile device, see the documentation provided with the application.

2. Create a new email message, and then attach the file that you want to print. For a
list of files that can be printed using HP ePrint, as well as guidelines to follow when
using HP ePrint, see HP ePrint and HP website specifications

3. Enter the printer’s email address in the “To” line of the email message, and then
select the option to send the email message.

NOTE: Make sure that the printer’s email address is the only address listed in
the “To” line of the email message. If other email addresses are listed in the
“To” line, the attachments you are sending might not print.

Find the printer’s email address

To obtain the printer’s email address, press the  (HP ePrint) button on the printer
control panel.

The printer prints an information page that contains the printer’s email address.

Turn off HP ePrint

To turn off HP ePrint, complete the following steps:

1. Open the EWS. For more information, see Embedded web server.

2. Click the Web Services tab, and then click ePrint in the Web Services Settings
section.

3. Click Turn Off ePrint.

NOTE: To remove all Web Services, see Remove Web Services.

Remove Web Services
To remove Web Services, complete the following steps:

1. Open the EWS. For more information, see Embedded web server.

2. Click the Web Services tab, and then click Remove Web Services in the Web
Services Settings section.

3. Click Remove Web Services.
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4 Work with ink cartridges
To ensure the best print quality from the printer, you need to perform some simple
maintenance procedures. This section provides guidelines for handling the ink
cartridges, instructions for replacing the ink cartridges, and aligning and cleaning the
printhead.

This section contains the following topics:

• Information on ink cartridges and the printhead

• Check the estimated ink levels

• Print with one or more depleted cartridges

• Replace the ink cartridges

• Store printing supplies

• Usage information collection

Information on ink cartridges and the printhead
The following tips help maintain HP ink cartridges and ensure consistent print quality.

• The instructions in this user guide are for replacing ink cartridges, and are not
intended for first time installation.

• CAUTION: HP recommends that you replace any missing cartridges as soon
as possible to avoid print quality issues and possible extra ink usage or damage
to the ink system. Never turn off the printer when ink cartridges are missing.

• Keep all ink cartridges in the original sealed packages until they are needed.

• Be sure to turn off the printer properly. For more information, see Turn the printer
off.

• Store ink cartridges at room temperature (15-35° C or 59-95° F).

• Do not clean the printhead unnecessarily. This wastes ink and shortens the life of
the cartridges.

• Handle ink cartridges carefully. Dropping, jarring, or rough handling during
installation can cause temporary printing problems.

• If you are transporting the printer, do the following to prevent ink leaking from the
printer or other damage from occurring to the printer:

◦ Make sure you turn off the printer by pressing  (Power). Wait until all sounds
of internal motion stop before unplugging the printer. For more information, see
Turn the printer off.

◦ Make sure you leave the ink cartridges and printhead installed.

◦ The printer must be transported sitting flat; it should not be placed on its side,
back, front, or top.

Related topics

• Check the estimated ink levels

• Clean the printhead
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Check the estimated ink levels
You can check the estimated ink levels from the printer software or from the printer
control panel. For information about using these tools, see Printer management tools
and Use the printer control panel. You can also print the Printer Status page to view
this information (see Understand the Printer Status Report).

NOTE: Ink level alerts and indicators provide estimates for planning purposes
only. When you receive a low on ink message, consider having a replacement
cartridge available to avoid possible printing delays. You do not need to replace the
ink cartridges until prompted to do so.

NOTE: If you have installed a refilled or remanufactured cartridge, or a cartridge
that has been used in another printer, the ink level indicator might be inaccurate or
unavailable.

NOTE: Ink from the cartridges is used in the printing process in a number of
different ways, including in the initialization process, which prepares the printer and
cartridges for printing, and in printhead servicing, which keeps print nozzles clear
and ink flowing smoothly. In addition, some residual ink is left in the cartridge after it
is used. For more information, see www.hp.com/go/inkusage.

Print with one or more depleted cartridges
The printer can operate with one or more depleted cartridges. However, printing with
depleted cartridges slows the printer and affects the quality of printed documents. If the
black cartridge is depleted, blacks are not as dark. If a color cartridge is depleted,
output is in grayscale. When possible, replace the depleted cartridge. Do not remove
the depleted cartridge until you have a new ink cartridge available to replace. For
information about how to install new cartridges, see Replace the ink cartridges.

CAUTION: Wait until you have a new ink cartridge available before removing the
old ink cartridge. Do not leave the ink cartridge outside of the printer for an
extended period of time. This can result in damage to both the printer and the ink
cartridge.

Replace the ink cartridges

NOTE: For information on recycling used ink supplies, see HP inkjet supplies
recycling program.

If you do not already have replacement ink cartridges for the printer, see HP supplies
and accessories.

NOTE: At this time, some portions of the HP website are available in English only.

CAUTION: HP recommends that you replace any missing cartridges as soon as
possible to avoid print quality issues and possible extra ink usage or damage to the
ink system. Never turn off the printer when ink cartridges are missing.
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Use these steps to replace the ink cartridges.

To replace the ink cartridges

1. Make sure the printer is turned on.

2. Open the ink-cartridge access door.

NOTE: Wait until the print carriage stops moving before proceeding.

3. Press the front of the ink cartridge to release it, and then remove it from the slot.

4. Remove the new ink cartridge from its packaging.

5. Using the color-coded letters for help, slide the ink cartridge into the empty slot until
it is securely installed in the slot.

CAUTION: Do not lift the latch handle on the print carriage to install the ink
cartridges. Doing so could cause the printhead or ink cartridges to be
incorrectly seated, which can cause errors or print quality problems. The latch
must remain down to correctly install the ink cartridges.

Make sure that you insert the ink cartridge into the slot that has the same colored
letter as the color you are installing.
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6. Repeat steps 3 through 6 for each ink cartridge you are replacing.

7. Close the ink-cartridge access door.

Related topics

HP supplies and accessories

Store printing supplies
Ink cartridges can be left in the printer for extended periods of time. However, to assure
optimal ink cartridge health, be sure to turn off the printer properly. For more
information, see Turn the printer off.

Usage information collection
The HP cartridges used with this printer contain a memory chip that assists in the
operation of the printer.

In addition, this memory chip collects a limited set of information about the usage of the
printer that might include the following: the date when the cartridge was first installed,
the date when the cartridge was last used, the number of pages printed using the
cartridge, the page coverage, the printing modes used, any printing errors that might
have occurred, and the printer model. This information helps HP design future printers
to meet our customers' printing needs.

The data collected from the cartridge memory chip does not contain information that
can be used to identify a customer or user of the cartridge or their printer.

HP collects a sampling of the memory chips from cartridges returned to HP's free
return and recycling program (HP Planet Partners: www.hp.com/recycle). The memory
chips from this sampling are read and studied to improve future HP printers. HP
partners who assist in recycling this cartridge might have access to this data, as well.

Any third party possessing the cartridge might have access to the anonymous
information on the memory chip. If you prefer to not allow access to this information,
you can render the chip inoperable. However, after you render the memory chip
inoperable, the cartridge cannot be used in an HP printer.

If you are concerned about providing this anonymous information, you can make this
information inaccessible by turning off the memory chip's ability to collect the printer's
usage information:

To turn off usage information collection

1. On the printer control panel, press and hold the  (Wireless) and  (Resume)
buttons.

2. The ink supply icons will blink four times.

3. Press and hold the  (Wireless) and  (Resume) buttons again to turn usage
information collection back on.

NOTE: If you turn off the memory chip's ability to collect the printer's usage
information, you can still continue to use the cartridge in the HP printer.
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5 Solve a problem
The information in this chapter suggests solutions to common problems. If your printer
is not operating correctly and those suggestions did not solve your problem, try using
one of the following support services to obtain assistance.

This section contains the following topics:

• HP support

• General troubleshooting tips and resources

• Solve printer problems

• Print quality troubleshooting

• Solve paper-feed problems

• Solve problems using HP ePrint and HP websites

• Solve wired (Ethernet) network problems

• Solve wireless problems

• Configure your firewall software to work with the printer

• Solve printer management problems

• Troubleshoot installation issues

• Understand the Printer Status Report

• Understand the network configuration page

• Printhead maintenance

• Clear jams

• Control-panel lights reference

HP support

If you have a problem, follow these steps

1. Check the documentation that came with the printer.

2. Visit the HP online support website at www.hp.com/go/customercare. This website
provides information and utilities that can help you correct many common printer
problems. HP online support is available to all HP customers. It is the fastest
source for up-to-date printer information and expert assistance and includes the
following features:

• Fast access to qualified online support specialists

• HP software and driver updates for the HP printer

• Valuable troubleshooting information for common problems

• Proactive printer updates, support alerts, and HP newsgrams that are available
when you register the printer

For more information, see Obtain electronic support.

3. Call HP support. Support options and availability vary by printer, country/region,
and language. For more information, see HP support by phone.
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Obtain electronic support

To find support and warranty information, go to the HP website at www.hp.com/go/
customercare. This website provides information and utilities that can help you correct
many common printer problems. If prompted, select your country/region, and then click
Contact HP for information about calling for technical support.

This website also offers technical support, drivers, supplies, ordering information and
other options such as:

• Access online support pages.

• Send HP an email message for answers to your questions.

• Connect with an HP technician by using online chat.

• Check for HP software updates.

You can also obtain support from the HP software for Windows or Mac OS X, which
provide easy, step-by-step solutions to common printing problems. For more
information, see Printer management tools.

Support options and availability vary by printer, country/region, and language.

HP support by phone

The phone support numbers and associated costs listed here are those in effect at time
of publication and are applicable only for calls made on a land line. Different rates may
apply for mobile phones.

For the most current HP list of telephone support numbers and call costs information,
see www.hp.com/go/customercare. This website provides information and utilities that
can help you correct many common printer problems.

During the warranty period, you may obtain assistance from the HP Customer Care
Center.

NOTE: HP does not provide telephone support for Linux printing. All support is
provided online at the following website: https://launchpad.net/hplip. Click the Ask
a question button to begin the support process.

The HPLIP website does not provide support for Windows or Mac OS X. If you are
using these operating systems, see www.hp.com/go/customercare. This website
provides information and utilities that can help you correct many common printer
problems.

This section contains the following topics:

• Before you call

• Phone support period

• Telephone support numbers

• After the phone support period
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Before you call

Call HP support while you are in front of the computer and the printer. Be prepared to
provide the following information:

• Model number (for more information, see Finding the printer model number)

• Serial number (located on the back or bottom of the printer)

• Messages that appear when the situation occurs

• Answers to these questions:

◦ Has this situation happened before?

◦ Can you re-create it?

◦ Did you add any new hardware or software to your computer at about the time
that this situation began?

◦ Did anything else occur prior to this situation (such as a thunderstorm or
moving the printer)?

Phone support period

One year of phone support is available in North America, Asia Pacific, and Latin
America (including Mexico).

Telephone support numbers

In many locations, HP provides toll free telephone support during the warranty period.
However, some of the support numbers might not be toll free.
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For the most current list of telephone support numbers, see www.hp.com/go/
customercare. This website provides information and utilities that can help you correct
many common printer problems.
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After the phone support period

After the phone support period, help is available from HP at an additional cost. Help
may also be available at the HP online support website: www.hp.com/go/customercare.
This website provides information and utilities that can help you correct many common
printer problems. Contact your HP dealer or call the support phone number for your
country/region to learn more about support options.
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General troubleshooting tips and resources

NOTE: Many of the following steps require HP software. If you did not install the
HP software, you can install it using the HP software CD included with the printer,
or you can download the HP software from the HP support website (www.hp.com/
go/customercare). This website provides information and utilities that can help you
correct many common printer problems.

Try these when you begin troubleshooting a printing problem.

• For a paper jam, see Clear jams.

• For paper-feed problems, such as the paper skew and paper pick, see Solve
paper-feed problems.

• Power light is on and not blinking. When the printer is turned on for the first time, it
takes approximately 12 minutes to initialize it after the ink cartridges are installed.

• Power cord and other cables are working, and are firmly connected to the printer.
Make sure the printer is connected firmly to a functioning alternating current (AC)
power outlet, and is turned on. For voltage requirements, see Electrical
specifications.

• Media is loaded correctly in the input tray and is not jammed in the printer.

• All packing tapes and materials are removed.

• The printer is set as the current or default printer. For Windows, set it as the default
in the Printers folder. For Mac OS X, set it as the default in the Print & Fax
preferences of the System Preferences. For more information, see your computer's
documentation.

• Pause Printing is not selected if you are using a computer running Windows.

• You are not running too many programs when you are performing a task. Close
programs that you are not using or restart the computer before attempting the task
again.

Solve printer problems

TIP: You can visit the HP online support website at www.hp.com/go/customercare
for information and utilities that can help you correct many common printer
problems.

This section contains the following topics:

• The printer shuts down unexpectedly

• Alignment fails

• The printer is not responding (nothing prints)

• The printer prints slowly

• The printer is making some unexpected noises

• Blank or partial page printed

• Something on the page is missing or incorrect

• Placement of the text or graphics is wrong
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The printer shuts down unexpectedly

Check the power and power connections

Make sure the printer is connected firmly to a functioning alternating current (AC)
power outlet. For voltage requirements, see Electrical specifications.

Alignment fails

If the alignment process fails, make sure you have loaded unused, plain white paper
into the input tray. If you have colored paper loaded in the input tray when you align the
ink cartridges, the alignment fails.

If the alignment process fails repeatedly, you might have a defective sensor or ink
cartridge. Contact HP support. Go to www.hp.com/go/customercare. This website
provides information and utilities that can help you correct many common printer
problems. If prompted, select your country/region, and then click Contact HP for
information on calling for technical support.

The printer is not responding (nothing prints)

There are print jobs stuck in the print queue

Open the print queue, cancel all documents, and then reboot the computer. Try to print
after the computer reboots. For more information, refer to the Help system for the
operating system.

Check the printer setup

For more information, see General troubleshooting tips and resources.

Check the HP software installation

If the printer is turned off when printing, an alert message should appear on your
computer screen; otherwise, the HP software provided with the printer might not be
installed correctly. To resolve this, uninstall the HP software completely, and then
reinstall the HP software. For more information, see Uninstall and reinstall the HP
software.

Check the cable connections

• Make sure both ends of the USB cable or Ethernet cable are secure.

• If the printer is connected to a network, check the following:

◦ Check the Link light on the back of the printer.

◦ Make sure you are not using a phone cord to connect the printer.

Check any personal firewall software installed on the computer

The personal software firewall is a security program that protects a computer from
intrusion. However, the firewall might block communication between the computer and
the printer. If there is a problem communicating with the printer, try temporarily
disabling the firewall. If the problem persists, the firewall is not the source of the
communication problem. Re-enable the firewall.
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The printer prints slowly

Try the following solutions if the printer is printing very slowly.

• Solution 1: Use a lower print quality setting

• Solution 2: Check the ink levels

• Solution 3: Contact HP support

Solution 1: Use a lower print quality setting

Solution: Check the print quality setting. Best and Maximum dpi provide the
best quality but are slower than Normal or Draft. Draft provides the fastest print
speed.

Cause: The print quality was set to a high setting.

If this did not solve the issue, try the next solution.

Solution 2: Check the ink levels

Solution: Check the estimated ink levels in the ink cartridges.

NOTE: Ink level alerts and indicators provide estimates for planning purposes
only. When you receive a low on ink message, consider having a replacement
cartridge available to avoid possible printing delays. You do not need to replace
the ink cartridges until prompted to do so.

NOTE: The printer can operate with one or more depleted cartridges.
However, printing with depleted cartridges slows the printer and affects the
quality of printed documents. If the black cartridge is depleted, blacks are not as
dark. If a color cartridge is depleted, output is in grayscale. When possible,
replace the depleted cartridge. Do not remove the depleted cartridge until you
have a new ink cartridge available. For information about how to install new
cartridges, see Replace the ink cartridges.

CAUTION: Wait until you have a new ink cartridge available before removing
the old ink cartridge. Do not leave the ink cartridge outside of the printer for an
extended period of time. This can result in damage to both the printer and the
ink cartridge.

NOTE: While ink cartridges are not damaged when left outside of the printer,
the printhead does need to have all cartridges installed at all times after the
printer is set up and in use. Leaving one or more cartridge slots empty for an
extended period may lead to print quality problems and possibly damage the
printhead. If you have recently left a cartridge out of the printer for an extended
period and have noticed poor print quality, clean the printhead. For more
information, see Clean the printhead.

For more information, see:

Check the estimated ink levels

Cause: The ink cartridges might have insufficient ink. Insufficient ink may cause
the printhead to overheat. When the printhead overheats, the printer slows down to
allow it to cool.
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If this did not solve the issue, try the next solution.

Solution 3: Contact HP support

Solution: Contact HP support for service.

Go to: www.hp.com/go/customercare. This website provides information and
utilities that can help you correct many common printer problems.

If prompted, choose your country/region, and then click Contact HP for information
on calling for technical support.

Cause: There was a problem with the printer.

The printer is making some unexpected noises

You might hear some unexpected noises made by the printer. These are the servicing
sounds when the printer performs automatic servicing functions to maintain the health
of the printheads.

NOTE: To prevent any potential damage to your printer:

Do not turn off the printer while the printer is performing any servicing. If you are
turning off the printer, wait for the printer to come to a complete stop before turning

off using the  (Power) button. See Turn the printer off.

Make sure all ink cartridges are installed. If any of the ink cartridge is missing, the
printer will perform extra servicing to protect the printheads.

Blank or partial page printed

Clean the printhead

Complete the printhead cleaning procedure. For more information, see Clean the
printhead. The printhead may need to be cleaned if the printer was turned off
incorrectly.

NOTE: Incorrectly turning off the printer can cause print quality problems like
blank or partial pages. Printhead cleaning can solve these problems, but turning off
the printer correctly can prevent them in the first place. Always turn the printer off

by pressing the  (Power) button on the printer. Wait until the  (Power) light
goes out before unplugging the power cord or turning off a power strip.

Check the media settings

• Make sure you select the correct print quality settings in the printer driver for the
media loaded in the trays.

• Make sure the page settings in the printer driver match the page size of media
loaded in the tray.

More than one page is being picked

For more information on paper-feed problems, see Solve paper-feed problems.
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There is a blank page in the file

Check the file to make sure there is no blank page.

Something on the page is missing or incorrect

Check the Print Quality Diagnostic page

Print a Print Quality Diagnostic page to help you decide whether to run any
maintenance tools to improve the print quality of your printouts. For more information,
see Print quality troubleshooting.

To print and evaluate the Print Quality Diagnostic page, hold down the  (Power)
button, press the  (Cancel) button seven times, press the  (Resume) button two

times, and then release the  (Power) button.

Check the margin settings

Make sure the margin settings for the document do not exceed the printable area of the
printer. For more information, see Set minimum margins.

Check the color print settings

Make sure Print in Grayscale is not selected in the printer driver.

Check the printer location and length of USB cable

High electromagnetic fields (such as those generated by USB cables) can sometimes
cause slight distortions to printouts. Move the printer away from the source of the
electromagnetic fields. Also, it is recommended that you use a USB cable that is less
than 3 meters (9.8 feet) long to minimize the effects of these electromagnetic fields.

Placement of the text or graphics is wrong

Check how the media is loaded

Make sure the media width and length guides fit snugly against the edges of the stack
of media, and make sure the tray is not overloaded. For more information, see Load
media.

Check the media size

• Content on a page might be cut off if the document size is larger than the media
that you are using.

• Make sure the media size selected in the printer driver match the size of media
loaded in the tray.

Check the margin settings

If the text or graphics are cut off at the edges of the page, make sure the margin
settings for the document do not exceed the printable area of your printer. For more
information, see Set minimum margins.
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Check the page-orientation setting

Make sure the media size and page orientation selected in the application match the
settings in the printer driver. For more information, see Print.

Check the printer location and length of USB cable

High electromagnetic fields (such as those generated by USB cables) can sometimes
cause slight distortions to printouts. Move the printer away from the source of the
electromagnetic fields. Also, it is recommended that you use a USB cable that is less
than 3 meters (9.8 feet) long to minimize the effects of these electromagnetic fields.

If the above solutions do not work, the problem may be caused by the inability of the
application to interpret print settings correctly. See the release notes for known
software conflicts, refer to the application's documentation, or contact the software
manufacturer for specific help.

Print quality troubleshooting
Try the solutions in this section to resolve print quality problems in your printout.

TIP: You can visit the HP online support website at www.hp.com/go/customercare
for information and utilities that can help you correct many common printer
problems.

• Solution 1: Make sure you are using genuine HP ink cartridges

• Solution 2: Check the ink levels

• Solution 3: Check the paper loaded in the input tray

• Solution 4: Check the paper type

• Solution 5: Check the print settings

• Solution 6: Print and evaluate a print quality report

• Solution 7: Contact HP support

Solution 1: Make sure you are using genuine HP ink cartridges

Solution: Check to see if your ink cartridges are genuine HP ink cartridges.

HP recommends that you use genuine HP ink cartridges. Genuine HP ink
cartridges are designed and tested with HP printers to help you easily produce
great results, time after time.

NOTE: HP cannot guarantee the quality or reliability of non-HP supplies.
Printer service or repairs required as a result of using a non-HP supply are not
covered under warranty.

If you believe you purchased genuine HP ink cartridges, go to:

www.hp.com/go/anticounterfeit

Cause: Non-HP ink cartridges were being used.

If this did not solve the issue, try the next solution.
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Solution 2: Check the ink levels

Solution: Check the estimated ink levels in the ink cartridges.

NOTE: Ink level alerts and indicators provide estimates for planning purposes
only. When you receive a low-ink alert, consider having a replacement cartridge
available to avoid possible printing delays. You do not need to replace the ink
cartridges until prompted to do so.

NOTE: The printer can operate with one or more depleted cartridges.
However, printing with depleted cartridges slows the printer and affects the
quality of printed documents. If the black cartridge is depleted, blacks are not as
dark. If a color cartridge is depleted, output is in grayscale. When possible,
replace the depleted cartridge. Do not remove the depleted cartridge until you
have a new ink cartridge available. For information about how to install new
cartridges, see Replace the ink cartridges.

CAUTION: Wait until you have a new ink cartridge available before removing
the old ink cartridge. Do not leave the ink cartridge outside of the printer for an
extended period of time. This can result in damage to both the printer and the
ink cartridge.

CAUTION: While ink cartridges are not damaged when left outside of the
printer, the printhead does need to have all cartridges installed at all times after
the printer is set up and in use. Leaving one or more cartridge slots empty for
an extended period may lead to print quality problems and possibly damage the
printhead. If you have recently left a cartridge out of the printer for an extended
period and have noticed poor print quality, clean the printhead. For more
information, see Clean the printhead.

For more information, see:

Check the estimated ink levels

Cause: The ink cartridges might have insufficient ink.

If this did not solve the issue, try the next solution.

Solution 3: Check the paper loaded in the input tray

Solution: Make sure the paper is loaded correctly and that it is not wrinkled or
too thick.

• Load paper with the print side facing down. For example, if you are loading
glossy photo paper, load the paper with the glossy side down.

• Make sure the paper lays flat in the input tray and is not wrinkled. If the paper is
too close to the printhead during printing, the ink might be smeared. This can
happen if the paper is raised, wrinkled, or very thick, such as a mailing
envelope.

For more information, see:

Load media.

Cause: The paper was loaded incorrectly, or it was wrinkled or too thick.
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If this did not solve the issue, try the next solution.

Solution 4: Check the paper type

Solution: HP recommends that you use HP papers or any other paper type that
is appropriate for the printer.

Always make sure the paper you are printing on is flat. For best results when
printing images, use HP Advanced Photo Paper.

Store specialty media in its original packaging inside a resealable plastic bag on a
flat surface in a cool, dry place. When you are ready to print, remove only the paper
you plan to use immediately. When you have finished printing, return any unused
photo paper to the plastic bag. This prevents the photo paper from curling.

NOTE: For this issue, there is not a problem with your ink supplies. Therefore,
replacing the ink cartridges is not necessary.

For more information, see:

Select print media

Cause: The wrong kind of paper was loaded in the input tray.

If this did not solve the issue, try the next solution.

Solution 5: Check the print settings

Solution: Check the print settings.

• Check the print settings to see if the color settings are incorrect.
For example, check to see if the document is set to print in grayscale. Or, check
to see if advanced color settings such as saturation, brightness, or color tone,
are set to modify the appearance of colors.

• Check the print quality setting and make sure it matches the type of paper
loaded in the printer.
You might need to choose a lower print quality setting if colors are running into
each other. Or, choose a higher setting if you are printing a high-quality photo,
and then make sure photo paper such as HP Advanced Photo Paper is loaded
in the input tray.

NOTE: On some computer screens, colors might appear differently than they
do when printed on paper. In this case, there is nothing wrong with the printer,
print settings, or ink cartridges. No further troubleshooting is required.

For more information, see:

Select print media

Cause: The print settings were set incorrectly.

If this did not solve the issue, try the next solution.
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Solution 6: Print and evaluate a print quality report

Solution:

To print a print quality report

• Control panel: Press and hold the  (Power) button, press the  (Cancel)
button seven times, press the  (Resume) button two times, and release the

 (Power) button.

• Embedded web server: Click the Tools tab, click Print Quality Toolbox
under Utilities, and then click Print Quality Report.

• HP Utility (Mac OS X): In the Information And Support section, click Print
Quality Diagnostics, and then click Print.

If defects are seen on the Print Quality Diagnostic report, follow the steps below:

1. If the Print Quality Diagnostic report shows faded, partial, streaked, or missing
color bars or patterns, check for depleted ink cartridges, and replace the ink
cartridge that corresponds to the defective color bar or color pattern. If there is
no depleted ink cartridge, remove and reinstall all ink cartridges to make sure
they are properly installed.

2. Align the printhead. For more information, see Align the printhead.

3. Clean the printhead. For more information, see Clean the printhead.

4. Replace the printhead. For more information, see Remove and reinstall the
printhead.

Cause: Print quality problems can have many causes: software settings, a poor
image file, or the printing system itself. If you are unhappy with the quality of your
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prints, a Print Quality Diagnostic page can help you determine if the printing system
is working correctly.

Solution 7: Contact HP support

Solution: Contact HP support for service.

Go to: www.hp.com/go/customercare. This website provides information and
utilities that can help you correct many common printer problems.

If prompted, choose your country/region, and then click Contact HP for information
on calling for technical support.

Cause: There was a problem with the printhead.

Solve paper-feed problems

TIP: You can visit the HP online support website at www.hp.com/go/customercare
for information and utilities that can help you correct many common printer
problems.

Media is not supported for the printer or tray

Use only media that is supported for the printer and the tray being used. For more
information, see Media specifications.

Media is not picked up from a tray

• Make sure media is loaded in the tray. For more information, see Load media. Fan
the media before loading.

• Make sure the paper guides are set to the correct markings in the tray for the
media size you are loading. Also make sure the guides are snug, but not tight,
against the stack.

• Make sure media in the tray is not curled. Uncurl paper by bending it in the
opposite direction of the curl.

Media is not coming out correctly

• Make sure the output tray extender is fully extended; otherwise, printed pages may
fall off the printer.
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• Remove excess media from the output tray. There is a limit to the number of sheets
the tray can hold.

Pages are skewing

• Make sure the media loaded in the trays is aligned to the paper guides. If needed,
pull out the trays from the printer and reload the media correctly, making sure that
the paper guides are aligned correctly.

• Load media into the printer only when it is not printing.

• Remove and replace the duplexer.

◦ Push the button on either side of the duplexer, and then remove the unit.

◦ Reinsert the duplexer into the printer.

Multiple pages are being picked up

• Fan the media before loading.

• Make sure the paper guides are set to the correct markings in the tray for the
media size you are loading. Also make sure the guides are snug, but not tight,
against the stack.

• Make sure the tray is not overloaded with paper.

• Use HP media for optimum performance and efficiency.

Solve problems using HP ePrint and HP websites
This section provides solutions to common problems using HP ePrint and HP websites.

• Solve problems using HP ePrint

• Solve problems using HP websites
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Solve problems using HP ePrint

If you are having problems using HP ePrint, check the following:

• Make sure the printer is connected to the Internet using an Ethernet or wireless
connection.

NOTE: You cannot use these web features if the printer is connected using
a USB cable.

• Make sure the latest product updates have been installed on the printer. For more
information, see Update the printer.

• Make sure HP ePrint is enabled on the printer. For more information, see Set up
HP ePrint using the printer’s control panel.

• Make sure the network hub, switch, or router is turned on and working correctly.

• If you are connecting the printer using an Ethernet cable, make sure you are not
connecting the printer using a phone cord or a crossover cable to connect the
printer to the network and that the Ethernet cable is securely connected to the
printer. For more information, see Solve wired (Ethernet) network problems.

• If you are connecting the printer using a wireless connection, make sure the
wireless network is functioning properly. For more information, see Solve wireless
problems.

• If you are using HP ePrint, check the following:

◦ Make sure the printer’s email address is correct.

◦ Make sure that the printer’s email address is the only address listed in the “To”
line of the email message. If other email addresses are listed in the “To” line,
the attachments you are sending might not print.

◦ Make sure you are sending documents that meet the HP ePrint requirements.
For more information, see HP ePrint specifications.

• If your network uses proxy settings when connecting to the Internet, make sure the
proxy settings you are entering are valid:

◦ Check the settings being used by the Web browser you are using (such as
Internet Explorer, Firefox, or Safari).

◦ Check with the IT administrator or person who set up your firewall.
If the proxy settings used by your firewall have changed, you must update
these settings in either the printer’s control panel. If these settings are not
updated, you will not be able to use HP ePrint.
For more information, see Set up HP ePrint using the printer’s control panel.

TIP: For additional help setting up and using HP ePrint, visit ePrintCenter
(www.eprintcenter.com).
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Solve problems using HP websites

If you are having problems using HP websites from your computer, check the following:

• Make sure the computer that you are using is connected to the Internet.

• Make sure the web browser meets the minimum system requirements. For more
information, see HP website specifications.

• If your web browser uses any proxy settings to connect to the Internet, try turning
off these settings. For more information, see the documentation provided with your
web browser.

Solve wired (Ethernet) network problems
If you are unable to connect the printer to your wired (Ethernet) network, perform one
or more of the following tasks.

NOTE: After correcting any of the following, run the installation program again.

TIP: You can visit the HP online support website at www.hp.com/go/customercare
for information and utilities that can help you correct many common printer
problems.

• General network troubleshooting

General network troubleshooting

If you are unable to install the HP software provided with the printer, verify the
following:

• All cable connections to the computer and the printer are secure.

• The network is operational and the network hub is turned on.

• All applications, including virus protection programs, spyware protection programs,
and firewalls, are closed or disabled for computers running Windows

• The printer is installed on the same subnet as the computers that use the printer.

If the installation program cannot discover the printer, print the network configuration
page, and enter the IP address manually in the installation program. For more
information, see Understand the network configuration page or you can download the
HP Home Network Diagnostic Utility on the HP website.

Solve wireless problems
This section provides information about solving problems you might encounter when
connecting the printer to your wireless network.

Follow these suggestions in order, starting with those listed in the “Basic wireless
troubleshooting” section. If you still encounter problems, follow the suggestions
provided in the “Advanced wireless troubleshooting” section.

• Basic wireless troubleshooting

• Advanced wireless troubleshooting

• After resolving the problems

• Wireless Direct Printing
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TIP: For more information about troubleshooting wireless problems, go to
www.hp.com/go/wirelessprinting.

TIP: If you are using a computer running Windows, HP provides a tool called HP
Home Network Diagnostic Utility that can help retrieve this information for some
systems. To use this tool, visit the HP Wireless Printing Center (www.hp.com/go/
wirelessprinting), and then click Network Diagnostic Utility in the Quick Links
section. (At this time, this tool might not available in all languages.)

NOTE: After you resolve the problem, follow the instructions in After resolving the
problems.

Basic wireless troubleshooting

Perform the following steps in the order presented.

Step 1 - Make sure the wireless (802.11) light is turned on

If the blue light near the printer's wireless button is not lit, the wireless capabilities

might not have been turned on. Press the  (Wireless) button to turn on the printer's
wireless capabilities.

NOTE: If your printer supports Ethernet networking, make sure that an Ethernet
cable has not been connected to the printer. Connecting an Ethernet cable turns off
the printer's wireless capabilities.

Step 2 - Restart components of the wireless network

Turn off the router and the printer, and then turn them back on in this order: router first
and then the printer. If you still are unable to connect, turn off the router, printer, and
your computer. Sometimes, turning off the power and then turning it back on recovers
from a network communication issue.

Step 3 - Run the Wireless Network Test

For wireless networking issues, run the Wireless Network Test. To print a Wireless

Network Test page, press  (Wireless) button, and  (Resume) button together. If a
problem is detected, the printed test report includes recommendations that might help
solve the problem.

TIP: : If the Wireless Network Test indicates the signal is weak, try moving the
printer closer to the wireless router.

Advanced wireless troubleshooting

If you have tried the suggestions provided in Basic wireless troubleshooting and are
still unable to connect to your printer to the wireless network, try the following
suggestions in the order presented:

• Step 1: Make sure your computer is connected to your network

• Step 2: Make sure that the printer is connected to your network

• Step 3: Check to see if the firewall software is blocking communication

• Step 4: Make sure the printer is online and ready
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• Step 5: Make sure the wireless version of the printer is set as the default printer
driver (Windows only)

• Step 6: Make sure your computer is not connected to your network over a Virtual
Private Network (VPN)

Step 1: Make sure your computer is connected to your network

Make sure your computer is connected to your network—either your wired (Ethernet)
network or your wireless network. If the computer is not connected to the network, you
cannot use the printer over the network.

To check a wired (Ethernet) connection

▲ Many computers have indicator lights beside the port where the Ethernet cable
from the router connects to your computer. Usually there are two indicator lights,
one that is on and another that blinks. If your computer has indicator lights, check
to see if the indicator lights are on. If the lights are not on, try reconnecting the
Ethernet cable to the computer and the router. If you still do not see lights, there
might be a problem with the router, the Ethernet cable, or your computer.

NOTE: Macintosh computers do not have indicator lights. To check the
Ethernet connection on a Macintosh computer, click System Preferences in
the Dock, and then click Network. If the Ethernet connection is working
correctly, Built-in Ethernet appears in the list of connections, along with the IP
address and other status information. If Built-in Ethernet does not appear in
the list, there might be a problem with the router, the Ethernet cable, or your
computer. For more information, click the Help button in the window.

To check a wireless connection

1. Make sure that your computer's wireless has been turned on. (For more
information, see the documentation that came with your computer.)

2. If you are not using a unique network name (SSID), then it is possible that your
wireless computer could be connected to a nearby network that is not yours.
The following steps can help you determine if your computer is connected to your
network.

Windows

a. Click Start, click Control Panel, point to Network Connections, and then click
View Network Status and Tasks.
– OR –
Click Start, select Settings, click Control Panel, double-click Network
Connections, click the View menu, and then select Details.
Leave the network dialog box open while you continue to the next step.

b. Disconnect the power cord from the wireless router. The connection status of
your computer should change to Not Connected.

c. Reconnect the power cord to the wireless router. The connection status should
change to Connected.
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Mac OS X

▲ Click the AirPort icon in the menu bar at the top of the screen. From the menu
that appears, you can determine if the AirPort is turned on and which wireless
network your computer is connected to.

NOTE: For more detailed information about your AirPort connection, click
System Preferences in the Dock, and then click Network. If the wireless
connection is working correctly, a green dot appears next to AirPort in the
list of connections. For more information, click the Help button in the
window.

If you are unable to get your computer connected to your network, contact the person
who set up your network or the router manufacturer as there might be a hardware
issue with either your router or computer.

TIP: If you are able to access the Internet and are using a computer running
Windows, you can also use the HP Network Assistant for help in setting up a
network. To use this tool, visit www.hp.com/sbso/wireless/tools-setup.html?
jumpid=reg_R1002_USEN. (This Web site is only available in English.)

Step 2: Make sure that the printer is connected to your network

If your printer is not connected to the same network as your computer, you cannot use
the printer over the network. Follow the steps described in this section to find out if your
printer is actively connected to the correct network.

NOTE: If your wireless router or Apple AirPort Base Station is using a hidden
SSID, your printer cannot automatically detect the network

A: Make sure the printer is on the network

1. If the printer supports Ethernet networking and is connected to an Ethernet
network, make sure an Ethernet cable is not plugged into the back of the printer. If
an Ethernet cable is plugged into the back, then wireless connectivity is disabled.

2. If the printer is connected to a wireless network, print the network configuration
page. For more information, see Understand the network configuration page.

3. After the page has been printed, check the Network Status and URL:

Network Status • If the Network Status is Ready, the
printer is actively connected to
a network.

• If the Network Status is Offline, the
printer is not connected to a network.
Run the Wireless Network Test (using
the instructions at the beginning of this
section) and follow any
recommendations.

URL The URL shown here is the network address
assigned to the printer by your router. You
need this to connect to the embedded web
server (EWS).
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For information about connecting the printer to a wireless network, see Set up the
printer for wireless communication.

B: Check to see if you can access the EWS

▲ After you establish that the computer and the printer both have active connections
to a network, you can verify if they are on the same network by opening the
printer's EWS. For more information, see Embedded web server.

To access the EWS

a. On your computer, open the EWS. For more information, see Embedded web
server.

NOTE: If you are using a proxy server in your browser, you might need to
disable it to access the EWS.

b. If you can open the EWS, try using the printer over the network (such as to
print) to see if your network setup was successful.

c. If you cannot open the EWS or are still having problems using the printer over
the network, continue to the next section regarding firewalls.

Step 3: Check to see if the firewall software is blocking communication

If you cannot access the EWS and are sure both the computer and printer have active
connections to the same network, the firewall security software might be blocking
communication. Temporarily turn off any firewall security software running on your
computer and then try to open the EWS again. If you can open the EWS, try using the
printer (for printing).

If you are able to open the EWS and use your printer with the firewall turned off, you
need to reconfigure your firewall settings to allow the computer and printer to
communicate with each other over the network. For more information, see Configure
your firewall software to work with the printer.

If you are able to open the EWS, but are still unable to use the printer even with the
firewall turned off, try enabling the firewall software to recognize the printer. For more
information, see the documentation provided with your firewall software.

Step 4: Make sure the printer is online and ready

If you have the HP software installed, you can check the printer’s status from your
computer to see if the printer is paused or offline, preventing you from using it.

To check the printer’s status, follow the instructions for your operating system:

Windows

1. Click Start, point to Settings, and then click Printers or Printers and Faxes.
- Or -
Click Start, click Control Panel, and then double-click Printers.

2. If the printers on your computer are not being displayed in Details view, click the
View menu, and then click Details.
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3. Do one of the following, depending on the printer status:

a. If the printer is Offline, right-click the printer, and click Use Printer Online.

b. If the printer is Paused, right-click the printer, and click Resume Printing.

4. Try using the printer over the network.

Mac OS X

1. Click System Preferences in the Dock, and then click Print & Fax.

2. Select the printer, and then click Open Print Queue.

3. If the print job is on hold, click Resume.

4. If the printer is paused, click Resume Printer.

If you can use the printer after performing the steps above but find that the symptoms
persist as you continue to use the printer, your firewall might be interfering. For more
information, see Configure your firewall software to work with the printer

If you still cannot use the printer over the network, continue to the next section for
additional troubleshooting help

Step 5: Make sure the wireless version of the printer is set as the default printer
driver (Windows only)

If you install the HP software again, the installer might create a second version of the
printer driver in your Printers or Printers and Faxes folder. If you have difficulties
printing or connecting to the printer, make sure the correct version of the printer driver
is set as the default.

1. Click Start, point to Settings, and then click Printers or Printers and Faxes.
- Or -
Click Start, click Control Panel, and then double-click Printers.

2. Determine if the version of the printer driver in the Printers or Printers and Faxes
folder is connected wirelessly:

a. Right-click the printer icon, and then click Properties, Document Defaults, or
Printing Preferences.

b. On the Ports tab, look for a port in the list with a checkmark. The version of the
printer driver that is connected wirelessly has HP network re-discovery port
monitor as the Port description, next to the checkmark.

3. Right-click the printer icon for the version of the printer driver that is connected
wirelessly, and select Set as Default Printer.

NOTE: If there is more than one icon in the folder for the printer, right-click the
printer icon for the version of the printer driver that is connected wirelessly, and
select Set as Default Printer.

Step 6: Make sure your computer is not connected to your network over a Virtual
Private Network (VPN)

A Virtual Private Network (VPN) is a computer network that uses the Internet to provide
a remote, secure connection to an organization’s network. However, most VPN
services do not allow you to access local devices (like your printer) on your local
network while your computer is connected to the VPN.

To connect to the printer, disconnect from the VPN.
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TIP: To use the printer while connected to the VPN, you can connect the printer to
your computer with a USB cable. The printer uses its USB and network
connections at the same time.

For more information, contact your network administrator or the person who set up the
wireless network.

After resolving the problems

After you resolve any problems and have successfully connected the printer to your
wireless network, complete the following steps for your operating system:

Windows

1. On the computer desktop, click Start, select Programs or All Programs, click HP,
select your printer name, and then click Printer Setup & Software.

2. Click Connect a new printer, and then select the type of connection you want to
use.

Mac OS X

1. Open HP Utility. For more information, see HP Utility (Mac OS X).

2. Click the Applications icon on the toolbar, double-click HP Setup Assistant, and
then follow the onscreen instructions.

Wireless Direct Printing

You can print directly to the printer wirelessly, without a wireless router, from your
wireless-enabled computers and mobile devices with Wireless Direct Printing.

NOTE: The Wireless Direct Printing connection is available even if the printer is
also connected to a wireless network. Also, all functionality available on your
wireless network, such as printing, scanning, and printer maintenance, is also
available when a computer (with the HP printer software installed) is connected to
the printer with a Wireless Direct Printing connection. However, some functionality
might not be supported if the printer has a simultaneous wireless connection to
your wireless network and Wireless Direct Printing.

To turn on Wireless Direct Printing

To turn on Wireless Direct Printing, complete the following steps:

1. Open the EWS. For more information, see Embedded web server.

2. On the Network tab, click Status in the Wireless Direct Printing section.

3. Click Edit Settings, and then follow the onscreen instructions.

NOTE: To prevent unauthorized people from connecting to the printer, turn on
security. Select On (with security), and then enter a passcode.

NOTE: If you do not see these options, updating the printer might provide this
feature. For more information, see Update the printer.
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TIP: You can customize the Wireless Direct Printing name and security passcode
from the embedded web server (EWS). For information about using the embedded
web server, see Embedded web server.

To print using Wireless Direct Printing

NOTE: To print using Wireless Direct Printing from a computer, be sure you’ve
installed the HP printer software. To print using Wireless Direct Printing from a
mobile device, make sure you have a print application installed on the mobile
device. For more information, see the documentation provided with the print
application.

1. From your wireless computer or mobile device, search for and connect to the
printer’s Wireless Direct Printing name.

2. If you have security enabled, enter the passcode.

Configure your firewall software to work with the printer
A personal firewall, which is security software running on your computer, can block
network communication between your printer and your computer.

If you are having problems such as:

• Printer not found when installing HP software

• Unable to print, print job stuck in queue or printer goes offline

• Scan communication errors or scanner busy messages

• Unable to see printer status on your computer

The firewall might be preventing your printer from notifying computers on your network
where it can be found.

If you are using the HP software on a computer running Windows and cannot find the
printer during installation (and you know the printer is on the network)—or if you have
already successfully installed HP software and experience problems—check the
following:

• If you have just installed the HP software, try turning off your computer and the
printer, and then turning them both on again.

• Keep your security software up to date. Many security software vendors provide
updates that correct known issues and provide the latest defenses against new
security threats.

• If your firewall has "High", "Medium", or "Low" security settings, use the "Medium"
setting when your computer is connected to your network.

• If you have changed any firewall settings from default, try going back to the default
setting.

• If your firewall has a setting called "trusted zone", use this setting when your
computer is connected to your network.
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• If your firewall has a setting to "not show alert messages", you should disable this.
When installing the HP software and using the HP printer you may see alert
messages from your firewall software that provide options to "allow", "permit" or
"unblock". You should allow any HP software that causes an alert. Also, if the alert
has a "remember this action" or "create a rule for this" selection, select it. This is
how the firewall learns what can be trusted on your network.

• Do not have more than one firewall enabled at the same time on your computer. An
example would be having both the Windows firewall provided by the operating
system and a 3rd party firewall enabled at the same time. Having more than one
firewall enabled at the same time will not make your computer any safer and may
cause problems.

For more information about using your printer with personal firewall software, visit
www.hp.com/go/wirelessprinting, and then click Firewall Help in the Need Help
Troubleshooting? section.

NOTE: At this time, some portions of this site are not available in all languages.

Solve printer management problems

TIP: You can visit the HP online support website at www.hp.com/go/customercare
for information and utilities that can help you correct many common printer
problems.

This section provides solutions to common problems that involve managing the printer.
This section contains the following topic:

• Embedded web server cannot be opened

NOTE: To use the embedded EWS, the printer must be connected to a network
using either an Ethernet or a wireless connection. You cannot use the embedded
web server if the printer is connected to a computer with a USB cable.

Embedded web server cannot be opened

Check your network setup

• Make sure you are not using a phone cord or a crossover cable to connect the
printer to the network.

• Make sure the network cable is securely connected to the printer.

• Make sure the network hub, switch, or router is turned on and working correctly.

Check the computer

Make sure the computer that you are using is connected to the network.

NOTE: To use the EWS, the printer must be connected to a network using either
an Ethernet or a wireless connection. You cannot use the embedded web server if
the printer is connected to a computer with a USB cable.
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Check your web browser

• Make sure the web browser meets the minimum system requirements. For more
information, see Embedded web server specifications.

• If your web browser uses any proxy settings to connect to the Internet, try turning
off these settings. For more information, see the documentation available with your
web browser.

• Make sure JavaScript and cookies are enabled in your web browser. For more
information, see the documentation available with your web browser.

Check the printer IP address

• To check the IP address of the printer, obtain the IP address on the network

configuration page. To print a network configuration page, press the  (Wireless)
button.

• Ping the printer using the IP address from the command prompt (Windows) or from
Network Utility (Mac OS X). (Network Utility is located in the Utilities folder in the
Applications folder at the top level of the hard disk.).
For example, if the IP address is 123.123.123.123, type the following at the
command prompt (Windows):
C:\Ping 123.123.123.123
- OR –
In Network Utility (Mac OS X) click the Ping tab, type the 123.123.123.123 in the
box, and then click Ping.
If a reply appears, the IP address is correct. If a time-out response appears, the IP
address is incorrect.

Troubleshoot installation issues

TIP: You can visit the HP online support website at www.hp.com/go/customercare
for information and utilities that can help you correct many common printer
problems.

If the following topics do not help, see HP support for information about HP support.

• Hardware installation suggestions

• HP software installation suggestions

• Solve network problems

Hardware installation suggestions

Check the printer

• Make sure that all packing tape and material have been removed from outside and
inside the printer.

• Make sure that the printer is loaded with paper.

• Make sure that no lights are on or blinking except the Ready light, which should be
on. If the Attention light is blinking, check for messages on the printer control panel.

Chapter 5

66 Solve a problem

http://h20180.www2.hp.com/apps/Nav?h_pagetype=s-001&h_page=hpcom&h_client=s-h-e008-1&h_product=4322967&h_lang=en&h_cc=us


Check the hardware connections

• Make sure that any cords and cables that you are using are in good working order.

• Make sure that the power cord is connected securely to both the printer and to
a working power outlet.

Check the printheads and ink cartridges

• Make sure that all of the printheads and ink cartridges are firmly installed in their
correct, color-coded slot. Press down firmly on each one to ensure proper contact.
The printer cannot work if they are not all installed.

• Make sure that the printhead latch is closed correctly.

• If the display shows a printhead error message, clean the contacts on the
printheads.

HP software installation suggestions

Check the computer system

• Make sure that your computer is running one of the supported operating systems.
For more information, see System requirements

• Make sure that the computer meets at least the minimum system requirements.

• In the Windows Device Manager, make sure that the USB drivers have not been
disabled.

• If you are using a computer running Windows, and the computer cannot detect the
printer, run the uninstallation utility (util\ccc\uninstall.bat on the installation CD) to
perform a clean uninstallation of the printer driver. Restart your computer, and
reinstall the printer driver.

Verify installation preliminaries

• Make sure to use the installation CD that contains the correct HP software for your
operating system.

• Before installing HP software, make sure that all other programs are closed.

• If the computer does not recognize the path to the CD-ROM drive that you type,
make sure that you are specifying the correct drive letter.

• If the computer cannot recognize the installation CD in the CD-ROM drive, inspect
the installation CD for damage. You can download the printer driver from the HP
website (www.hp.com/go/customercare).

NOTE: After correcting any problems, run the installation program again.

Solve network problems

General network troubleshooting

• If you are unable to install the HP software, verify that:
You can access HP Home Network Diagnostic Utility on the HP website for help in
setting up a network.

◦ All cable connections to the computer and the printer are secure.

◦ The network is operational and the network hub is turned on.
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◦ All applications, including virus protection programs, spyware protection
programs, and firewalls, are closed or disabled for computers running
Windows.

◦ Make sure the printer is installed on the same subnet as the computers that use
the printer.

◦ If the installation program cannot discover the printer, print the network
configuration page and enter the IP address manually in the installation
program. For more information, see Understand the network configuration
page.

• If you are using a computer running Windows, make sure that the network ports
created in the printer driver match the printer IP address:

◦ Print the printer’s network configuration page.

◦ Click Start, then click Printers or Printers and Faxes.
- Or -
Click Start, click Control Panel, and then double-click Printers.

◦ Right-click the printer icon, click Properties, and then click the Ports tab.

◦ Select the TCP/IP port for the printer, and then click Configure Port.

◦ Compare the IP address listed in the dialog box and make sure it matches the
IP address listed on the network configuration page. If the IP addresses are
different, change the IP address in the dialog box to match the address on the
network configuration page.

◦ Click OK twice to save the settings and close the dialog boxes.

Problems connecting to a wired network

• If the Network light on the printer control panel does not turn on, make sure that all
of the “General network troubleshooting” conditions are met.

• Though it is not recommended that you assign the printer with a static IP address,
you might resolve some installation problems (such as a conflict with a personal
firewall) by doing so.

To reset the printer's network settings

1. To reset the network settings, press and hold the  (Cancel),  (Wireless), and

 (Power) buttons for three seconds.

2. Press the  (Resume) and  (Wireless) buttons together, and then release to
print the network configuration page and verify that the network settings have been
reset.

Understand the Printer Status Report
Use the printer status report to view current printer information and ink cartridge status.
Also use the printer status report to help you troubleshoot problems with the printer.

The printer status report also contains a log of recent events.
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If you need to call HP, it is often useful to print the printer status report before calling.

1

2

3

1. Printer Information: Shows printer information (such as the printer name, model
number, serial number, and firmware version number), the accessories that are
installed (such as the duplexer), and the connectivity settings.

2. Print Usage Information: Provides the total number of pages printed, as well as
the number of borderless pages printed.

3. Ink Delivery System Information: Shows the estimated ink levels (represented in
graphical form as gauges) and the part numbers and warranty expiration dates of
the ink cartridges.

NOTE: Ink level warnings and indicators provide estimates for planning
purposes only. When you receive a low on ink message, consider having
a replacement cartridge available to avoid possible printing delays. You do not
need to replace cartridges until prompted to do so.

4. Print Head Information: Shows the pen ID number and first-installation date of the
printhead. 

5. Additional Assistance: Provides information about available methods for finding
more information about the printer.

6. Wireless Network Test: Provides information about testing the wireless network
connection to the printer.

To print the Printer Status report

On the printer control panel, press and hold the  (Cancel) button for three seconds.
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Understand the network configuration page
If the printer is connected to a network, you can print a network configuration page to
view the network settings for the printer. You can use the network configuration page to
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help troubleshoot network connectivity problems. If you need to call HP, it is often
useful to print this page before calling.

1

2

3

4

5
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4

5

1. General Information: Shows information about the current status and active
connection type of the network, and other information, such as the URL of the
embedded web server.

2. 802.3 Wired: Shows information about the active wired network connection, such
as the IP address, subnet mask, default gateway, as well as the hardware address
of the printer.

3. 802.11 Wireless: Shows information about your wireless network connection, such
as the hostname, IP address, subnet mask, default gateway, and server.
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4. Miscellaneous: Shows information about more advanced network settings.

• Port 9100: The printer supports raw IP printing through TCP Port 9100. This
HP-proprietary TCP/IP port on the printer is the default port for printing. It is
accessed by HP software (for example, the HP Standard Port).

• LPD: Line Printer Daemon (LPD) refers to the protocol and programs
associated with line-printer spooling services that may be installed on various
TCP/IP systems.

NOTE: The LPD functionality can be used with any host implementation of
LPD that complies with the RFC 1179 document. The process for
configuring printer spoolers, however, might differ. See your system
documentation for information about configuring these systems.

• Bonjour: Bonjour services (which use mDNS, or Multicast Domain Name
System) are typically used on small networks for IP address and name
resolution (through UDP port 5353), where a conventional DNS server is not
used.

• SLP: Service Location Protocol (SLP) is an Internet standard network protocol
that provides a framework to allow networking applications to discover the
existence, location, and configuration of networked services in enterprise
networks. This protocol simplifies discovery and use of network resources such
as printers, web servers, fax machines, video cameras, files systems, backup
devices (tape drives), databases, directories, mail servers, calendars.

• Microsoft web Services: Enable or disable the Microsoft web Services
Dynamic Discovery (WS Discovery) protocols or Microsoft web Services for
Devices (WSD) Print services supported on the printer. Disable unused print
services to prevent access through those services.

NOTE: For more information about WS Discovery and WSD Print, visit
www.microsoft.com.

• SNMP: SNMP (Simple Network Management Protocol) is used by network
management applications for device management. The printer supports
SNMPv1 protocol on IP networks.

• WINS: If you have a Dynamic Host Configuration Protocol (DHCP) server on
your network, the printer automatically obtains its IP address from that server
and registers its name with any RFC 1001 and 1002-compliant dynamic name
services as long as a WINS server IP address has been specified.

• IPP:

5. Number of 802.11 networks discovered: Lists the wireless networks in range of
the printer.

To print the network configuration page from the printer control panel

Press the  (Wireless) button and then release.

Printhead maintenance
If you are experiencing problems with printing, you might have a problem with the
printhead. You should perform the procedures in the following sections only when
directed to do so for resolving print quality issues.
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Performing the aligning and cleaning procedures unnecessarily can waste ink and
shorten the life of the cartridges.

This section contains the following topics:

• Clean the printhead

• Align the printhead

• Remove and reinstall the printhead

Clean the printhead

If your printed output is streaked or has any incorrect or missing colors, the printhead
might need to be cleaned.

There are two stages of cleaning. Each stage lasts about two minutes, uses one sheet
of paper, and uses an increasing amount of ink. After each stage, review the quality of
the printed page. You should only initiate the next phase of cleaning if the print quality
is poor.

If print quality still seems poor after you complete both stages of cleaning, try aligning
the printer. If print quality problems persist after cleaning and aligning, contact HP
support. For more information, see HP support.

NOTE: Cleaning uses ink, so clean the printheads only when necessary. The
cleaning process takes a few minutes. Some noise might be generated in the
process. Before cleaning the printheads, make sure you load paper. For more
information, see Load media.

Not turning the printer off correctly can cause print quality problems. For more
information, see Turn the printer off.

To clean the printhead from the printer control panel

1. On the printer control panel, press and hold  (Power) button.

2. Press  (Cancel) button two times, and then press  (Resume) button once.

3. Release  (Power) button.

To clean the printhead from Toolbox (Windows)

1. Open Toolbox. For more information, see Open the Toolbox.

2. Click Printer Preferences, click Maintenance Tasks, and then click Clean
Printheads.

3. Follow the onscreen instructions.

To clean the printhead from HP Utility (Mac OS X)

1. Open HP Utility. For more information, see HP Utility (Mac OS X).

2. In the Information And Support section, click Clean Printheads.

3. Click Clean, and then follow the onscreen instructions.
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To clean the printhead from the embedded web server (EWS)

1. Open the EWS. For more information, see To open the embedded web server.

2. Click the Tools tab, and then click Print Quality Toolbox in the Utilities section.

3. Click Clean Printhead and follow the onscreen instructions.

Align the printhead

The printer automatically aligns the printhead during the initial setup.

You might want to use this feature when the printer status page shows streaking or
white lines through any of the blocks of color or if you are having print quality issues
with your printouts.

To align the printhead from the printer control panel

1. Load letter, A4, or legal unused plain white paper into the main input tray.

2. On the printer control panel, press and hold the  (Power) button.

3. Press  (Resume) button three times.

To align the printhead from Toolbox (Windows)

1. Open Toolbox. For more information, see Open the Toolbox.

2. Click Printer Preferences, click Maintenance Tasks, and then click Align
Printhead.

3. Follow the onscreen instructions.

To align the printhead from HP Utility (Mac OS X)

1. Open HP Utility. For more information, see HP Utility (Mac OS X).

2. In the Information And Support section, click Align Printhead.

3. Click Align, and then follow the onscreen instructions.

To align the printhead from the embedded web server (EWS)

1. Open the EWS. For more information, see To open the embedded web server.

2. Click the Tools tab, and then click Print Quality Toolbox in the Utilities section.

3. Click Align Printhead and follow the onscreen instructions.

Remove and reinstall the printhead

NOTE: This procedure should only be performed when a Missing or Failed
Printhead message has been seen and the printer has first been turned off and
then back on to try to resolve the message. If the message persists, try this
procedure.
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Remove and reinstall the printhead

1. Make sure that the printer is turned on.

2. Open the top cover and the ink-cartridge access door.

3. Lift the latch handle on the print carriage.

4. Remove the printhead by lifting it up and then pulling it out of the printer.
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5. Make sure the latch handle is raised, and then reinsert the printhead.

6. Carefully lower the latch handle.

NOTE: Make sure you lower the latch handle before reinserting the ink
cartridges. Leaving the latch handle raised can result in incorrectly seated ink
cartridges and problems printing. The latch must remain down in order to
correctly install the ink cartridges.

7. Close the ink-cartridge access door and the top cover.

Clear jams
Occasionally, media becomes jammed during a job. Try the following remedies before
you attempt to clear the jam.

• Make sure that you are printing with media that meets specifications. For more
information, see Media specifications.

• Make sure that you are printing with media that is not wrinkled, folded, or damaged.

• Make sure that the printer is clean. For more information, see Maintain the printer.

• Make sure that the trays are loaded correctly and are not too full. For more
information, see Load media.

This section contains the following topics:

• Clear paper jams

• Avoid paper jams

Clear paper jams

If the paper was loaded in the input tray, you might need to clear the paper jam from
the duplexer.

Clear jams 77



To clear a jam

Use these steps to clear a paper jam.

1. Remove all media from the output tray.

CAUTION: Trying to clear a paper jam from the front of the printer can
damage the print mechanism. Always access and clear paper jams through the
duplexer.

2. Check the duplexer.

a. Push the button on either side of the duplexer, and then remove the unit.

b. Locate any jammed media inside the printer, grasp it with both hands and then
pull it towards you.

c. If the jam is not there, push the latch on the top of the duplexer and lower its
cover. If the jam is inside, carefully remove it. Close the cover.

d. Reinsert the duplexer into the printer.

3. Open the top cover and remove any debris.
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4. If you have not found the jam and have Tray 2 installed, pull out the tray and
remove the jammed media, if possible. If not, do the following:

a. Ensure the printer is turned off and disconnect the power cord.

b. Lift the printer off Tray 2.

c. Remove the jammed media from the bottom of the printer or from Tray 2.

d. Reposition the printer on top of Tray 2.

5. Open the print carriage access door. If there is paper remaining inside the printer,
ensure the carriage has moved to the right of the printer, free any paper scraps or
wrinkled media, and pull the media towards you through the top of the printer.

WARNING! Do not reach into the printer when it is on and the carriage is
stuck. When you open the print carriage access door, the carriage should return
to its position on the right side of the printer. If it does not move to the right, turn
off the printer before you remove any jam.

6. After clearing the jam, close all covers, turn on the printer (if you turned it off) and
resend the print job.

Avoid paper jams

To help avoid paper jams, follow these guidelines.

• Remove printed papers from the output tray frequently.

• Prevent curled or wrinkled paper by storing all unused paper flat in a resealable
bag.

• Ensure that paper loaded in the input tray lays flat and the edges are not bent or
torn.

• Do not combine different paper types and paper sizes in the input tray; the entire
stack of paper in the input tray must be the same size and type.

• Adjust the paper-width guide in the input tray to fit snugly against all paper. Make
sure the paper-width guide does not bend the paper in the input tray.

• Do not force paper too far forward in the input tray.

• Use paper types that are recommended for the printer. For more information, see
Select print media.

• If the printer is about to run out of paper, allow the printer to run out of paper first
and then add paper. Do not try to add paper while the printer is trying to pickup a
sheet.

• If you are printing on both sides of a page, do not print highly saturated images on
light weight paper.

Control-panel lights reference
The control-panel lights indicate status and are useful for diagnosing printing problems.
This section contains information about the lights, what they indicate, and what action
to take if necessary.
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For more information about the printer control panel, see Use the printer control panel.

21 3 4

12

5

6

7

911 810

Label Name and Description

1 Printhead align icon. Shows that the printhead requires alignment.

2 Ink cartridge access door open icon. Shows that the printer's ink cartridge access door or
top cover is open.

3 Out of paper icon. Shows that the printer is out of paper.

4 Paper jam icon. Shows that the printer has a paper jam.

5 Resume button and light. Press to continue a print job after a paper jam or adding paper or
press to cancel a print job when a media size mismatch occurs. Press and hold for three
seconds to print a marketing demo page. The Resume light blinks when the button must be
pressed to resume printing.

6 Cancel button. Press once to stop a print job, or press and hold for three seconds to print a
printer status report.

7 Power button and light. Press to turn the printer on or off. The light indicates whether the
printer is on or off.

8 ePrint button and light.Press to enable the HP ePrint function. Press and hold for three
seconds to print the firmware information page. The light indicates when the printer is
connected to an ePrint server.

9 Wireless button and light. Press to turn the 802.11 wireless feature on or off. The button
lights when the wireless feature is on.

10 Wired network icon. Shows that a wired network connection exists.

11 Wireless network icon. Shows that a wireless network connection exists.

12 Ink cartridge information icons. Displays ink cartridge information, including fill levels.
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Label Name and Description

NOTE: Ink level warnings and indicators provide estimates for planning purposes only.
When you receive a low on ink message, consider having a replacement cartridge available
to avoid possible printing delays. You do not need to replace cartridges until prompted to do
so.

Interpreting control-panel lights

Light description/Light pattern Explanation and
recommended action

All lights are off. The printer is off.

• Connect the power cable.

• Press  (Power) button.

The Power light is on. The printer is ready.

No action is required.

The media width setting does
not match the media loaded.

Change the media setting in
the print driver to match the
media loaded. For more
information, see Print on
special and custom-size paper.

The Out of Paper icon is blinking. The printer is out of paper.

Load paper and press
 (Resume) button.

(continued)
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Light description/Light pattern Explanation and
recommended action

The Access Door Open icon is blinking. The access door or top cover is
not closed completely.

Make sure the access door and
top cover are completely
closed.

The Power light blinks. The printer is turning on or off,
or is processing a print job.

No action is required.

The printer is pausing for the
ink to dry.

Wait for the ink to dry.

The Paper Jam icon blinks. Print media is jammed in the
printer.

Remove all media from the
output tray. Locate and clear
the jam. For more information,
see Clear jams.

The Power light and the Resume light blink. The printer carriage has
stalled.

• Open the top cover and
remove any obstructions
(such as jammed media).

• Press  (Resume) button
to continue printing.

• If the error persists, turn
the printer off, and then on
again.
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Light description/Light pattern Explanation and
recommended action

The Printhead Alert icon blinks. The printhead is missing or not
installed properly.

• Ensure the printhead is
properly installed.

• If the error persists,
replace the printhead. For
more information, see
Remove and reinstall the
printhead.

The Printhead Alert icon is on and all other lights are off. The printhead is incompatible
or damaged.

• Ensure the printhead is
properly installed.

• If the error persists,
replace the printhead. For
more information, see
Remove and reinstall the
printhead.

(continued)
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Light description/Light pattern Explanation and
recommended action

The Power light is on and one or more of the ink cartridge
icons blink.

One or more of the ink
cartridges are missing.

There is a duplicate cartridge
installed in the printer.

• Install the indicated ink
cartridge, and then try to
print. Remove and reinsert
the ink cartridge a few
times if necessary.

• If the error persists,
replace the indicated ink
cartridge.

Ink level is low and might affect
print quality.

Replace the indicated ink
cartridge. For ordering
information, see Supplies.

NOTE: Ink level alerts and
indicators provide estimates for
planning purposes only. When
you receive a low on ink
message, consider having a
replacement cartridge available
to avoid possible printing
delays. You do not need to
replace the ink cartridges until
prompted to do so.

The Power light and one or more of the ink cartridge lights
blink.

One or more of the ink
cartridges are faulty, need
attention, incorrect, missing,
damaged, or incompatible.

• Ensure the indicated ink
cartridge is properly
installed, and then try to
print. Remove and reinsert
the ink cartridge a few
times if necessary.

• If the error persists,
replace the indicated ink
cartridge.
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Light description/Light pattern Explanation and
recommended action

The Power light is on, and one or more of the ink cartridge
lights are on.

One or more of the ink
cartridges are low on ink and
will need to be replaced soon.

Get new ink cartridges and
replace the existing cartridges
when prompted to do so.

NOTE: Ink level alerts and
indicators provide estimates for
planning purposes only. When
you receive a low on ink
message, consider having a
replacement cartridge available
to avoid possible printing
delays.

The Power light is on, and the Resume light and one or more
ink cartridge lights blink.

One or more of the ink
cartridges are almost depleted.

NOTE: Ink level alerts and
indicators provide estimates for
planning purposes only. When
you receive a low on ink
message, consider having a
replacement cartridge available
to avoid possible printing
delays.

One or more ink cartridge icons blink. One or more of the ink
cartridges are depleted.

Get new ink cartridges and
replace the existing cartridges
when prompted to do so.

NOTE: Ink level alerts and
indicators provide estimates for
planning purposes only. When
you receive a low on ink
message, consider having a
replacement cartridge available
to avoid possible printing
delays.

(continued)
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A Technical information
This section contains the following topics:

• Warranty information

• Printer specifications

• Regulatory information

• Environmental product stewardship program

• Third-party licenses

Warranty information
This section contains the following topics:

• Hewlett-Packard limited warranty statement

• Ink cartridge warranty information
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Hewlett-Packard limited warranty statement

A. Extent of limited warranty
  1. Hewlett-Packard (HP) warrants to the end-user customer that the HP products specified above will be free from defects 

in materials and workmanship for the duration specified above, which duration begins on the date of purchase by the 
customer.

  2. For software products, HP’s limited warranty applies only to a failure to execute programming instructions. HP does not 
warrant that the operation of any product will be interrupted or error free.

  3. HP's limited warranty covers only those defects that arise as a result of normal use of the product, and does not cover 
any other problems, including those that arise as a result of:

   a. Improper maintenance or modification;
   b. Software, media, parts, or supplies not provided or supported by HP;
   c. Operation outside the product's specifications;
   d. Unauthorized modification or misuse.
  4. For HP printer products, the use of a non-HP cartridge or a refilled cartridge does not affect either the warranty to the 

customer or any HP support contract with the customer. However, if printer failure or damage is attributable to the use of 
a non-HP or refilled cartridge or an expired ink cartridge, HP will charge its standard time and materials charges to 
service the printer for the particular failure or damage.

  5. If HP receives, during the applicable warranty period, notice of a defect in any product which is covered by HP's 
warranty, HP shall either repair or replace the product, at HP's option.

  6. If HP is unable to repair or replace, as applicable, a defective product which is covered by HP's warranty, HP shall, 
within a reasonable time after being notified of the defect, refund the purchase price for the product.

  7. HP shall have no obligation to repair, replace, or refund until the customer returns the defective product to HP.
  8. Any replacement product may be either new or like-new, provided that it has functionality at least equal to that of the 

product being replaced.
  9. HP products may contain remanufactured parts, components, or materials equivalent to new in performance.
  10. HP's Limited Warranty Statement is valid in any country where the covered HP product is distributed by HP. Contracts 

for additional warranty services, such as on-site service, may be available from any authorized HP service facility in 
countries where the product is distributed by HP or by an authorized importer.

B. Limitations of warranty
TO THE EXTENT ALLOWED BY LOCAL LAW, NEITHER HP NOR ITS THIRD PARTY SUPPLIERS MAKES ANY 
OTHER WARRANTY OR CONDITION OF ANY KIND, WHETHER EXPRESS OR IMPLIED WARRANTIES OR 
CONDITIONS OF MERCHANTABILITY, SATISFACTORY QUALITY, AND FITNESS FOR A PARTICULAR PURPOSE.

C. Limitations of liability
  1. To the extent allowed by local law, the remedies provided in this Warranty Statement are the customer's sole and 

exclusive remedies.
  2. TO THE EXTENT ALLOWED BY LOCAL LAW, EXCEPT FOR THE OBLIGATIONS SPECIFICALLY SET FORTH IN 

THIS WARRANTY STATEMENT, IN NO EVENT SHALL HP OR ITS THIRD PARTY SUPPLIERS BE LIABLE FOR 
DIRECT, INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES, WHETHER BASED ON 
CONTRACT, TORT, OR ANY OTHER LEGAL THEORY AND WHETHER ADVISED OF THE POSSIBILITY OF 
SUCH DAMAGES.

D. Local law
  1. This Warranty Statement gives the customer specific legal rights. The customer may also have other rights which vary 

from state to state in the United States, from province to province in Canada, and from country to country elsewhere in 
the world.

  2. To the extent that this Warranty Statement is inconsistent with local law, this Warranty Statement shall be deemed 
modified to be consistent with such local law. Under such local law, certain disclaimers and limitations of this Warranty 
Statement may not apply to the customer. For example, some states in the United States, as well as some governments 
outside the United States (including provinces in Canada), may:

   a. Preclude the disclaimers and limitations in this Warranty Statement from limiting the statutory rights of a consumer 
(e.g., the United Kingdom);

   b. Otherwise restrict the ability of a manufacturer to enforce such disclaimers or limitations; or
   c. Grant the customer additional warranty rights, specify the duration of implied warranties which the manufacturer 

cannot disclaim, or allow limitations on the duration of implied warranties.
  3. THE TERMS IN THIS WARRANTY STATEMENT, EXCEPT TO THE EXTENT LAWFULLY PERMITTED, DO NOT 

EXCLUDE, RESTRICT, OR MODIFY, AND ARE IN ADDITION TO, THE MANDATORY STATUTORY RIGHTS 
APPLICABLE TO THE SALE OF THE HP PRODUCTS TO SUCH CUSTOMERS.

HP Limited Warranty
Dear Customer,
You will find below the name and address of the HP entity responsible for the performance of the HP Limited Warranty in your 
country. 
You may have additional statutory rights against the seller based on your purchase agreement. Those rights are not 
in any way affected by this HP Limited Warranty.
Ireland: Hewlett-Packard Ireland Limited, 63-74 Sir John Rogerson's Quay, Dublin 2  
United Kingdom: Hewlett-Packard Ltd, Cain Road, Bracknell, GB-Berks RG12 1HN 
Malta: Hewlett-Packard International Trade B.V., Malta Branch, 48, Amery Street, Sliema SLM 1701, MALTA
South Africa: Hewlett-Packard South Africa Ltd, 12 Autumn Street, Rivonia, Sandton, 2128, Republic of South Africa

HP product Duration of limited warranty
Software Media 90 days
Printer 1 year 
Print or Ink cartridges  Until the HP ink is depleted or the “end of warranty” date printed 

 on the cartridge has been reached, whichever occurs first. This 
warranty does not cover HP ink products that have been refilled, 
remanufactured, refurbished, misused, or tampered with.

Printheads (only applies to products with customer 1 year 
replaceable printheads)
Accessories 1 year unless otherwise stated
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Ink cartridge warranty information
The HP cartridge warranty is applicable when the product is used in its designated HP printing
device. This warranty does not cover HP ink products that have been refilled, remanufactured,
refurbished, misused, or tampered with.

During the warranty period the product is covered as long as the HP ink is not depleted and the
end of warranty date has not been reached. The end of warranty date, in YYYY-MM format, may
be found on the product as indicated:

Appendix A
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Printer specifications
This section contains the following topics:

• Physical specifications

• Product features and capacities

• Processor and memory specifications

• System requirements

• Network protocol specifications

• Embedded web server specifications

• Media specifications

• Print specifications

• HP ePrint and HP website specifications

• Environmental specifications

• Electrical specifications

• Acoustic emission specifications

Physical specifications
• Size (width x height x depth): 494 x 202 x 399 mm (15.9 x 7.9 x 15.7 inches)

• With Tray 2: Adds 82 mm (3.2 inches) to the height of the printer.

• Printer weight (with duplexer but without printing supplies): 8.11kg (17.9 lb)

• With Tray 2: Adds 2.79 kg (6.2 lb)

Product features and capacities

Feature Capacity

Connectivity • USB 2.0 high speed compliant
• Wireless 802.11b/g/n*
• Wired 802.3 network (Ethernet)

* The printer supports the 802.11n 2.4 GHz
frequency band.

Print method Drop-on-demand thermal inkjet printing

Ink cartridges Four ink cartridges (one each for black, cyan,
magenta, and yellow)

NOTE: Not all ink cartridges are supported in
all countries/regions.

Printhead One printhead

Supply yields For more information on estimated ink
cartridge yields, visit www.hp.com/go/
learnaboutsupplies/.

Printer languages HP PCL 3

Font support US fonts: CG Times, CG Times Italic,
Universe, Universe Italic, Courier, Courier
Italic, Letter Gothic, Letter Gothic Italic.

Duty cycle Up to 20,000 pages per month
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Feature Capacity

Printer control-panel language support

Language availability varies by country/region.

Bulgarian, Croatian, Czech, Danish, Dutch,
English, Finnish, French, German, Greek,
Hungarian, Italian, Japanese, Korean,
Norwegian, Polish, Portuguese, Romanian,
Russian, Simplified Chinese, Slovak,
Slovenian, Spanish, Swedish, Traditional
Chinese, Turkish.

Processor and memory specifications

Printer processor

ARM R4

Printer memory

64 MB built-in RAM

System requirements

NOTE: For the most current information about supported operating systems and system
requirements, visit www.hp.com/go/customercare.

Operating system compatibility

• Windows XP Service Pack 3, Windows Vista, Windows 7

• Mac OS X v10.5, v10.6

• Linux (For more information, see http://hplipopensource.com/hplip-web/index.html)

Minimum system requirements

• Microsoft® Windows® 7: 1 GHz 32-bit (x86) or 64-bit (x64) processor; 2 GB hard disk space,
CD-ROM/DVD drive or Internet connection, USB port; Internet Explorer

• Microsoft Windows Vista®: 800 MHz 32-bit (x86) or 64-bit (x64) processor; 2 GB hard disk
space, CD-ROM/DVD drive or Internet connection, USB port; Internet Explorer

• Microsoft Windows XP Service Pack 3 or higher (32-bit only): Intel® Pentium® II , Celeron®,
or compatible processor; 233 MHz or higher; CD-ROM/DVD drive or Internet connection, USB
port, Internet Explorer 6.0 or higher

• Mac OS X v10.5 or v10.6: PowerPC G4, G5, or Intel Core processor, 500 MB free hard disk
space, CD-ROM/DVD drive or Internet connection, USB port

Network protocol specifications

Network operating system compatibility

• Windows XP (32-bit) (Professional and Home Editions), Windows Vista 32-bit and 64-bit
(Ultimate Edition, Enterprise Edition and Business Edition), Windows 7 (32-bit and 64-bit)

• Windows Small Business Server 2003 32-bit and 64-bit, Windows 2003 Server 32-bit and 64-
bit, Windows 2003 Server R2 32-bit and 64-bit (Standard Edition, Enterprise Edition)

• Windows Small Business Server 2008 64-bit, Windows 2008 Server 32-bit and 64-bit,
Windows 2008 Server R2 64-bit (Standard Edition, Enterprise Edition)

• Citrix XenDesktop 4

• Citrix XenServer 5.5

• Mac OS X v10.5, v10.6

• Microsoft Windows 2003 Server Terminal Services

• Microsoft Windows 2003 Server Terminal Services with Citrix Presentation Server 4.0

• Microsoft Windows 2003 Server Terminal Services with Citrix Presentation Server 4.5
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• Microsoft Windows 2003 Server Terminal Services with Citrix XenApp 5.0

• Microsoft Windows 2003 Server Terminal Services with Citrix Metaframe XP with Feature
Release 3

• Microsoft Windows 2003 Small Business Server Terminal Services

• Microsoft Windows Server 2008 Terminal Services

• Microsoft Windows Small Business Server 2008 Terminal Services

• Microsoft Windows 2008 Server Terminal Services with Citrix XenApp 5.0

• Novell Netware 6.5, Open Enterprise Server 2

Compatible network protocols

TCP/IP

Network management

Embedded web server (Ability to remotely configure and manage network printers)

Embedded web server specifications

Requirements

• A TCP/IP-based network (IPX/SPX-based networks are not supported)

• A web browser (either Microsoft Internet Explorer 7.0 or higher, Mozilla Firefox 3.0 or higher,
Safari 3.0 or higher, or Google Chrome 3.0 or higher)

• A network connection (you cannot use the embedded web server connected directly to
a computer with a USB cable)

• An Internet connection (required for some features)

NOTE: You can open the embedded web server without being connected to the
Internet. However, some features are not available.

NOTE: The embedded web server must be on the same side of a firewall as the printer.

Media specifications
Use these tables to determine the correct media to use with your printer, and determine what
features work with your media.

• Understand specifications for supported media

• Set minimum margins

• Guidelines for printing on both sides of a page

Understand specifications for supported media
Use the tables to determine the correct media to use with your printer, and to determine what
features work with your media.

• Understand supported sizes

• Understand supported media types and weights

Understand supported sizes

NOTE: Tray 2 is available as an option.

Media size Tray 1 Tray 2 Duplexer

Standard media sizes    

10x15cm*   
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Media size Tray 1 Tray 2 Duplexer

2L   

U.S. Letter (216 x 279 mm; 8.5 x 11
inches)

8.5 x 13 inches (216 x 330 mm)   

U.S. Legal (216 x 356 mm; 8.5 x 14
inches)

 

A4 (210 x 297 mm; 8.3 x 11.7 inches)*

U.S. Executive (184 x 267 mm; 7.25 x 10.5
inches)

 

U.S. Statement (140 x 216 mm; 5.5 x 8.5
inches)

  

B5 (JIS) (182 x 257 mm; 7.17 x 10.12
inches)*

 

A5 (148 x 210 mm; 5.8 x 8.3 inches)*   

6 x 8 inches   

Edge-to-Edge A4*  

Edge-to-Edge Letter*  

Envelopes    

U.S. #10 Envelope (105 x 241 mm; 4.12
x 9.5 inches)

  

Monarch Envelope (98 x 191 mm; 3.88
x 7.5 inches)

  

Card Envelope (111 x 152 mm; 4.4 x 6
inches)

  

A2 Envelope (111 x 146 mm; 4.37 x 5.75
inches)

  

DL Envelope (110 x 220 mm; 4.3 x 8.7
inches)

  

C5 Envelope (162 x 229 mm; 6.4 x 9
inches)

  

C6 Envelope (114 x 162 mm; 4.5 x 6.4
inches)

  

Japanese Envelope Chou #3 (120 x 235
mm; 4.7 x 9.3 inches)

  

Japanese Envelope Chou #4 (90 x 205
mm; 3.5 x 8.1 inches)

  

Cards    
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Media size Tray 1 Tray 2 Duplexer

Index card (76.2 x 127 mm; 3 x 5 inches)   

Index card (102 x 152 mm; 4 x 6 inches)   

Index card (127 x 203 mm; 5 x 8 inches)   

A6 card (105 x 148.5 mm; 4.13 x 5.83
inches)

  

A4 index card (210 x 297 mm; 8.3 x 11.7
inches)

  

Hagaki** (100 x 148 mm; 3.9 x 5.8 inches)   

Ofuku Hagaki** (200 x 148 mm; 7.8 x 5.8
inches)

  

Index Card Letter (216 x 279 mm; 8.5 x 11
inches)

  

Photo media    

Photo media (76.2 x 127 mm; 3 x 5
inches)

  

Photo media (102 x 152 mm; 4 x 6 inches)   

Photo media (5 x 7 inches)   

Photo media (8 x 10 inches)   

Photo media (8.5 x 11 inches)   

Photo L (89 x 127 mm; 3.5 x 5 inches)   

Photo 2L (127 x 178 mm)   

13 x 18 cm*   

Other media 

NOTE: Defining custom-sized media
sizes in the HP printing software is only
available in Mac OS X.

   

Custom-sized media between 76.2 to 216
mm wide and 127 to 356 mm long (3 to 8.5
inches wide and 5 to 14 inches long)

  

Custom-sized media between 127 to 216
mm wide and 241 to 305 mm long (5 to 8.5
inches wide and 9.5 to 12 inches long)

   

* These sizes can be used for borderless printing.

** The printer is compatible with plain and inkjet hagaki from Japan Post only. It is not compatible
with photo hagaki from Japan Post.
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Understand supported media types and weights

NOTE: Tray 2 is available with some models.

Tray Type Weight Capacity

Tray 1 Paper 60 to 105 g/m2

(16 to 28 lb bond)

Up to 250 sheets of
plain paper

(25 mm or 1 inch
stacked)

Photo media 280 g/m2

(75 lb bond)

Up to 100 sheets

(17 mm or 0.67 inch
stacked)

Labels  Up to 100 sheets

(17 mm or 0.67 inch
stacked)

Envelopes 75 to 90 g/m2

(20 to 24 lb bond
envelope)

Up to 30 sheets

(17 mm or 0.67 inch
stacked)

Cards Up to 200 g/m2

(110 lb index)

Up to 80 cards

Tray 2 Plain paper only 60 to 105 g/m2

(16 to 28 lb bond)

Up to 250 sheets of
plain paper

(25 mm or 1.0 inch
stacked)

Duplexer Plain and brochure 60 to 105 g/m2

(16 to 28 lb bond)

Not applicable

Output tray All supported media  Up to 150 sheets of
plain paper (text
printing)

Set minimum margins
The document margins must match (or exceed) these margin settings in portrait orientation.
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Media (1) Left
margin

(2) Right
margin

(3) Top
margin

(4) Bottom
margin

U.S. Letter

U.S. Legal

A4

U.S. Executive

U.S. Statement

8.5 x 13 inch

B5

A5

Cards

Custom-sized media

Photo media

3.3 mm (0.13
inch)

3.3 mm (0.13
inch)

3.3 mm (0.13
inch)

3.3 mm (0.13
inch)
Windows and
12mm (0.47
inch) Mac OS
X and Linux

Envelopes 3.3 mm (0.13
inch)

3.3 mm (0.13
inch)

16.5 mm
(0.65 inch)

16.5 mm
(0.65 inch)

Guidelines for printing on both sides of a page
• Always use media that conforms to the printer specifications. For more information, see

Media specifications.

• Specify two-sided printing options in your application or in the printer driver.

• Do not print on both sides of envelopes, photo paper, glossy media, or paper lighter than 16
lb bond (60 g/m2) or heavier than 28 lb bond (105 g/m2). Jams might occur with these media
types.

• Several kinds of media require a specific orientation when you print on both sides of a page.
These include letterhead, preprinted paper, and paper with watermarks and prepunched
holes. When you print from a computer running Windows, the printer prints the first side of the
media first. Load the media with the print side facing down.

• For auto-duplexing, when printing finishes on one side of the media, the printer holds the
media and pauses while the ink dries. Once the ink dries, the media is pulled back into the
printer and the second side is printed. When printing is complete, the media is dropped onto
the output tray. Do not grab it before printing is complete.

• You can print on both sides of supported custom-sized media by turning the media over and
feeding it into the printer again. For more information, see Media specifications.

Print specifications

Black print resolution

600 x 600 dpi with pigmented black ink

Color print resolution

Up to 4800 x 1200 dpi Optimized on HP Advanced Photo Paper with 1200 x 1200 input dpi

HP ePrint and HP website specifications
This section contains the following topics:

• HP ePrint specifications

• HP website specifications

HP ePrint specifications
• An Internet connection using either a wired (Ethernet) or wireless connection.

• Maximum size of email and attachments: 5 MB
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• Maximum number of attachments: 10

NOTE: The printer’s email address must be the only address listed in the “To” line of the
email message.

• Supported file types:

◦ PDF

◦ HTML

◦ Standard text file formats

◦ Microsoft Word, PowerPoint

◦ Image files, such as PNG, JPEG, TIFF, GIF, BMP

NOTE: You might be able to use other types of files with HP ePrint. However, HP
cannot guarantee that they correct functionality with the printer because they have not
been fully tested.

HP website specifications
• A web browser (either Microsoft Internet Explorer 6.0 or higher, Mozilla Firefox 2.0 or higher,

Safari 3.2.3 or higher, or Google Chrome 3.0) with the Adobe Flash plug-in (version 10 or
higher).

• An Internet connection

Environmental specifications

Operating environment

Operating temperature: 5° to 40° C (41° to 104° F)
Operating humidity: 15 to 80% RH non-condensing
Recommended operating conditions: 15° to 32° C (59° to 90° F)
Recommended relative humidity: 20 to 80 % RH non-condensing

Shipping environment

Maximum shipping temperature: -40° to 60° C (-40° to 140° F)
Maximum shipping humidity: 5 to 90% RH non-condensing

Electrical specifications

Power supply

Universal power adapter (external)

Power requirements

Input voltage: 100 to 240 VAC (± 10%), 50/60 Hz (± 3 Hz)
Output voltage: 32 Vdc at 2000 mA

Power consumption

30 watts printing (Fast Draft Mode)

Acoustic emission specifications
Print in Draft mode, noise levels per ISO 7779

• Sound pressure (bystander position)

LpAm 57 (dBA) (mono Draft print)

• Sound power

LwAd 7.1 (BA)
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Regulatory information
The printer meets product requirements from regulatory agencies in your country/region.

This section contains the following topics:

• FCC statement

• Notice to users in Korea

• VCCI (Class B) compliance statement for users in Japan

• Notice to users in Japan about the power cord

• Noise emission statement for Germany

• LED indicator statement

• Gloss of housing of peripheral devices for Germany

• European Union Regulatory Notice

• Regulatory information for wireless products

• Regulatory model number

FCC statement

FCC statement

The United States Federal Communications Commission (in 47 CFR 15.105) has specified 
that the following notice be brought to the attention of users of this product. 
This equipment has been tested and found to comply with the limits for a Class B digital 
device, pursuant to Part 15 of the FCC Rules.  These limits are designed to provide reason-
able protection against harmful interference in a residential installation.  This equipment 
generates, uses and can radiate radio frequency energy and, if not installed and used in 
accordance with the instructions, may cause harmful interference to radio communications.  
However, there is no guarantee that interference will not occur in a particular installation.  
If this equipment does cause harmful interference to radio or television reception, which can 
be determined by turning the equipment off and on, the user is encouraged to try to correct 
the interference by one or more of the following measures:
• Reorient the receiving antenna.
• Increase the separation between the equipment and the receiver.
• Connect the equipment into an outlet on a circuit different from that to which the 

receiver is connected.
• Consult the dealer or an experienced radio/TV technician for help.
For further information, contact:

Manager of Corporate Product Regulations
Hewlett-Packard Company
3000 Hanover Street
Palo Alto, Ca 94304
(650) 857-1501

Modifications (part 15.21)
The FCC requires the user to be notified that any changes or modifications made to this 
device that are not expressly approved by HP may void the user's authority to operate the 
equipment.
This device complies with Part 15 of the FCC Rules.  Operation is subject to the following 
two conditions:  (1) this device may not cause harmful interference, and (2) this device must 
accept any interference received, including interference that may cause undesired 
operation.
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Notice to users in Korea

VCCI (Class B) compliance statement for users in Japan

Notice to users in Japan about the power cord

Noise emission statement for Germany

Geräuschemission
LpA < 70 dB am Arbeitsplatz im Normalbetrieb nach DIN 45635 T. 19

LED indicator statement

LED indicator statement
The display LEDs meet the requirements of EN 60825-1.
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Gloss of housing of peripheral devices for Germany

European Union Regulatory Notice
Products bearing the CE marking comply with the following EU Directives:

• Low Voltage Directive 2006/95/EC

• EMC Directive 2004/108/EC

• Ecodesign Directive 2009/125/EC, where applicable

CE compliance of this product is valid only if powered with the correct CE-marked AC adapter
provided by HP.

If this product has telecommunications functionality, it also complies with the essential
requirements of the following EU Directive:

R&TTE Directive 1999/5/EC

Compliance with these directives implies conformity to applicable harmonized European
standards (European Norms) that are listed in the EU Declaration of Conformity issued by HP for
this product or product family and available (in English only) either within the product
documentation or at the following website: www.hp.com/go/certificates (type the product number
in the search field).

The compliance is indicated by one of the following conformity markings placed on the product:

For non-telecommunications
products and for EU harmonized
telecommunications products, such
as Bluetooth® within power class
below 10mW.

For EU non-harmonized
telecommunications products (If
applicable, a 4-digit notified body
number is inserted between CE
and !).

Please refer to the regulatory label provided on the product.

The telecommunications functionality of this product may be used in the following EU and EFTA
countries: Austria, Belgium, Bulgaria, Cyprus, Czech Republic, Denmark, Estonia, Finland,
France, Germany, Greece, Hungary, Iceland, Ireland, Italy, Latvia, Liechtenstein, Lithuania,
Luxembourg, Malta, Netherlands, Norway, Poland, Portugal, Romania, Slovak Republic, Slovenia,
Spain, Sweden, Switzerland, and United Kingdom.

The telephone connector (not available for all products) is intended for connection to analogue
telephone networks.

Products with wireless LAN devices

Some countries may have specific obligations or special requirements about the operation of
Wireless LAN networks such as indoor use only or restrictions of the channels available. Please
make sure that the country settings of the wireless network are correct.

France

For 2.4-GHz Wireless LAN operation of this product, certain restrictions apply: This product may
be used indoors for the entire 2400-MHz to 2483.5-MHz frequency band (channels 1 to 13). For
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outdoor use, only the 2400-MHz to 2454-MHz frequency band (channels 1 to 7) may be used. For
the latest requirements, see www.arcep.fr.

The point of contact for regulatory matters is:

Hewlett-Packard GmbH, Dept./MS: HQ-TRE, Herrenberger Strasse 140, 71034 Boeblingen,
GERMANY

Regulatory information for wireless products
This section contains the following regulatory information pertaining to wireless products:

• Exposure to radio frequency radiation

• Notice to users in Brazil

• Notice to users in Canada

• Notice to users in Taiwan

Exposure to radio frequency radiation

Exposure to radio frequency radiation 

Caution The radiated output power of this device is far below the FCC radio 
frequency exposure limits. Nevertheless, the device shall be used in such a manner 
that the potential for human contact during normal operation is minimized. This 
product and any attached external antenna, if supported, shall be placed in such 
a manner to minimize the potential for human contact during normal operation. In 
order to avoid the possibility of exceeding the FCC radio frequency exposure 
limits, human proximity to the antenna shall not be less than 20 cm (8 inches) 
during normal operation. 

Notice to users in Brazil

Aviso aos usuários no Brasil

Este equipamento opera em caráter secundário, isto é, não tem direito à proteção 
contra interferência prejudicial, mesmo de estações do mesmo tipo, e não pode causar 
interferência a sistemas operando em caráter primário. (Res.ANATEL 282/2001).

Notice to users in Canada

Notice to users in Canada/Note à l'attention des utilisateurs canadiens

For Indoor Use. This digital apparatus does not exceed the Class B limits for radio noise 
emissions from the digital apparatus set out in the Radio Interference Regulations of the 
Canadian Department of Communications. The internal wireless radio complies with RSS 
210 and RSS GEN of Industry Canada.
Utiliser à l'intérieur. Le présent appareil numérique n'émet pas de bruit radioélectrique 
dépassant les limites applicables aux appareils numériques de la classe B prescrites dans 
le Règlement sur le brouillage radioélectrique édicté par le ministère des Communications 
du Canada. Le composant RF interne est conforme a la norme RSS-210 and RSS GEN 
d'Industrie Canada.
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Notice to users in Taiwan

Regulatory model number
For regulatory identification purposes, your product is assigned a Regulatory Model Number. The
Regulatory Model Number for your product is VCVRA-1101. This regulatory number should not be
confused with the marketing name (HP Officejet Pro 8100 ePrinter) or product number.
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Environmental product stewardship program
Hewlett-Packard is committed to providing quality products in an environmentally sound manner.
Design for recycling has been incorporated into this product. The number of materials has been
kept to a minimum while ensuring proper functionality and reliability. Dissimilar materials have
been designed to separate easily. Fasteners and other connections are easy to locate, access,
and remove using common tools. High priority parts have been designed to access quickly for
efficient disassembly and repair.

For more information, visit HP’s Commitment to the Environment website at:

www.hp.com/hpinfo/globalcitizenship/environment/index.html

This section contains the following topics:

• Paper use

• Plastics

• Material safety data sheets

• Recycling program

• HP inkjet supplies recycling program

• Disposal of waste equipment by users in private households in the European Union

• Power consumption

• Chemical Substances

• Battery information

• RoHS notices (China only)

• RoHS notices (Ukraine only)

Paper use
This product is suited for the use of recycled paper according to DIN 19309 and EN 12281:2002.

Plastics
Plastic parts over 25 grams are marked according to international standards that enhance the
ability to identify plastics for recycling purposes at the end of product life.

Material safety data sheets
Material safety data sheets (MSDS) can be obtained from the HP website at:

www.hp.com/go/msds

Recycling program
HP offers an increasing number of product return and recycling programs in many countries/
regions, and partners with some of the largest electronic recycling centers throughout the world.
HP conserves resources by reselling some of its most popular products. For more information
regarding recycling of HP products, please visit:

www.hp.com/hpinfo/globalcitizenship/environment/recycle/

HP inkjet supplies recycling program
HP is committed to protecting the environment. The HP Inkjet Supplies Recycling Program is
available in many countries/regions, and lets you recycle used print cartridges and ink cartridges
free of charge. For more information, go to the following website:

www.hp.com/hpinfo/globalcitizenship/environment/recycle/
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Disposal of waste equipment by users in private households in the European Union

Disposal of Waste Equipment by Users in Private Households in the European Union
This symbol on the product or on its packaging indicates that this product must not be disposed of with your other household waste. Instead, it is your responsibility to dispose of your waste 
equipment by handing it over to a designated collection point for the recycling of waste electrical and electronic equipment. The separate collection and recycling of your waste equipment 
at the time of disposal will help to conserve natural resources and ensure that it is recycled in a manner that protects human health and the environment. For more information about where 
you can drop off your waste equipment for recycling, please contact your local city office, your household waste disposal service or the shop where you purchased the product.
Évacuation des équipements usagés par les utilisateurs dans les foyers privés au sein de l'Union européenne
La présence de ce symbole sur le produit ou sur son emballage indique que vous ne pouvez pas vous débarrasser de ce produit de la même façon que vos déchets courants. 
Au contraire, vous êtes responsable de l'évacuation de vos équipements usagés et, à cet effet, vous êtes tenu de les remettre à un point de collecte agréé pour le recyclage des 
équipements électriques et électroniques usagés. Le tri, l'évacuation et le recyclage séparés de vos équipements usagés permettent de préserver les ressources naturelles et de s'assurer 
que ces équipements sont recyclés dans le respect de la santé humaine et de l'environnement. Pour plus d'informations sur les lieux de collecte des équipements usagés, veuillez contacter 
votre mairie, votre service de traitement des déchets ménagers ou le magasin où vous avez acheté le produit.
Entsorgung von Elektrogeräten durch Benutzer in privaten Haushalten in der EU
Dieses Symbol auf dem Produkt oder dessen Verpackung gibt an, dass das Produkt nicht zusammen mit dem Restmüll entsorgt werden darf. Es obliegt daher Ihrer Verantwortung, das 
Gerät an einer entsprechenden Stelle für die Entsorgung oder Wiederverwertung von Elektrogeräten aller Art abzugeben (z.B. ein Wertstoffhof). Die separate Sammlung und das 
Recyceln Ihrer alten Elektrogeräte zum Zeitpunkt ihrer Entsorgung trägt zum Schutz der Umwelt bei und gewährleistet, dass sie auf eine Art und Weise recycelt werden, die keine 
Gefährdung für die Gesundheit des Menschen und der Umwelt darstellt. Weitere Informationen darüber, wo Sie alte Elektrogeräte zum Recyceln abgeben können, erhalten Sie bei 
den örtlichen Behörden, Wertstoffhöfen oder dort, wo Sie das Gerät erworben haben.
Smaltimento di apparecchiature da rottamare da parte di privati nell'Unione Europea 
Questo simbolo che appare sul prodotto o sulla confezione indica che il prodotto non deve essere smaltito assieme agli altri rifiuti domestici. Gli utenti devono provvedere allo 
smaltimento delle apparecchiature da rottamare portandole al luogo di raccolta indicato per il riciclaggio delle apparecchiature elettriche ed elettroniche. La raccolta e il riciclaggio 
separati delle apparecchiature da rottamare in fase di smaltimento favoriscono la conservazione delle risorse naturali e garantiscono che tali apparecchiature vengano rottamate 
nel rispetto dell'ambiente e della tutela della salute. Per ulteriori informazioni sui punti di raccolta delle apparecchiature da rottamare, contattare il proprio comune di residenza, 
il servizio di smaltimento dei rifiuti locale o il negozio presso il quale è stato acquistato il prodotto.
Eliminación de residuos de aparatos eléctricos y electrónicos por parte de usuarios domésticos en la Unión Europea
Este símbolo en el producto o en el embalaje indica que no se puede desechar el producto junto con los residuos domésticos. Por el contrario, si debe eliminar este tipo de residuo, es 
responsabilidad del usuario entregarlo en un punto de recogida designado de reciclado de aparatos electrónicos y eléctricos. El reciclaje y la recogida por separado de estos residuos 
en el momento de la eliminación ayudará a preservar recursos naturales y a garantizar que el reciclaje proteja la salud y el medio ambiente. Si desea información adicional sobre los 
lugares donde puede dejar estos residuos para su reciclado, póngase en contacto con las autoridades locales de su ciudad, con el servicio de gestión de residuos domésticos o con la 
tienda donde adquirió el producto.
Likvidace vysloužilého zařízení uživateli v domácnosti v zemích EU
Tato značka na produktu nebo na jeho obalu označuje, že tento produkt nesmí být likvidován prostým vyhozením do běžného domovního odpadu. Odpovídáte za to, že vysloužilé 
zařízení bude předáno k likvidaci do stanovených sběrných míst určených k recyklaci vysloužilých elektrických a elektronických zařízení. Likvidace vysloužilého zařízení samostatným 
sběrem a recyklací napomáhá zachování přírodních zdrojů a zajišťuje, že recyklace proběhne způsobem chránícím lidské zdraví a životní prostředí. Další informace o tom, kam můžete 
vysloužilé zařízení předat k recyklaci, můžete získat od úřadů místní samosprávy, od společnosti provádějící svoz a likvidaci domovního odpadu nebo v obchodě, kde jste produkt 
zakoupili.
Bortskaffelse af affaldsudstyr for brugere i private husholdninger i EU
Dette symbol på produktet eller på dets emballage indikerer, at produktet ikke må bortskaffes sammen med andet husholdningsaffald. I stedet er det dit ansvar at bortskaffe affaldsudstyr 
ved at aflevere det på dertil beregnede indsamlingssteder med henblik på genbrug af elektrisk og elektronisk affaldsudstyr. Den separate indsamling og genbrug af dit affaldsudstyr på 
tidspunktet for bortskaffelse er med til at bevare naturlige ressourcer og sikre, at genbrug finder sted på en måde, der beskytter menneskers helbred samt miljøet. Hvis du vil vide mere 
om, hvor du kan aflevere dit affaldsudstyr til genbrug, kan du kontakte kommunen, det lokale renovationsvæsen eller den forretning, hvor du købte produktet.
Afvoer van afgedankte apparatuur door gebruikers in particuliere huishoudens in de Europese Unie
Dit symbool op het product of de verpakking geeft aan dat dit product niet mag worden afgevoerd met het huishoudelijk afval. Het is uw verantwoordelijkheid uw afgedankte apparatuur 
af te leveren op een aangewezen inzamelpunt voor de verwerking van afgedankte elektrische en elektronische apparatuur. De gescheiden inzameling en verwerking van uw afgedankte 
apparatuur draagt bij tot het sparen van natuurlijke bronnen en tot het hergebruik van materiaal op een wijze die de volksgezondheid en het milieu beschermt. Voor meer informatie over 
waar u uw afgedankte apparatuur kunt inleveren voor recycling kunt u contact opnemen met het gemeentehuis in uw woonplaats, de reinigingsdienst of de winkel waar u het product 
hebt aangeschaft.
Eramajapidamistes kasutuselt kõrvaldatavate seadmete käitlemine Euroopa Liidus
Kui tootel või toote pakendil on see sümbol, ei tohi seda toodet visata olmejäätmete hulka. Teie kohus on viia tarbetuks muutunud seade selleks ettenähtud elektri- ja elektroonikaseadmete 
utiliseerimiskohta. Utiliseeritavate seadmete eraldi kogumine ja käitlemine aitab säästa loodusvarasid ning tagada, et käitlemine toimub inimeste tervisele ja keskkonnale ohutult. 
Lisateavet selle kohta, kuhu saate utiliseeritava seadme käitlemiseks viia, saate küsida kohalikust omavalitsusest, olmejäätmete utiliseerimispunktist või kauplusest, kust te seadme 
ostsite.
Hävitettävien laitteiden käsittely kotitalouksissa Euroopan unionin alueella
Tämä tuotteessa tai sen pakkauksessa oleva merkintä osoittaa, että tuotetta ei saa hävittää talousjätteiden mukana. Käyttäjän velvollisuus on huolehtia siitä, että hävitettävä laite 
toimitetaan sähkö- ja elektroniikkalaiteromun keräyspisteeseen. Hävitettävien laitteiden erillinen keräys ja kierrätys säästää luonnonvaroja. Näin toimimalla varmistetaan myös, 
että kierrätys tapahtuu tavalla, joka suojelee ihmisten terveyttä ja ympäristöä. Saat tarvittaessa lisätietoja jätteiden kierrätyspaikoista paikallisilta viranomaisilta, jäteyhtiöiltä tai tuotteen 
jälleenmyyjältä.
Απόρριψη άχρηστων συσκευών στην Ευρωπαϊκή Ένωση
Το παρόν σύμβολο στον εξοπλισμό ή στη συσκευασία του υποδεικνύει ότι το προϊόν αυτό δεν πρέπει να πεταχτεί μαζί με άλλα οικιακά απορρίμματα. Αντίθετα, ευθύνη σας είναι να 
απορρίψετε τις άχρηστες συσκευές σε μια καθορισμένη μονάδα συλλογής απορριμμάτων για την ανακύκλωση άχρηστου ηλεκτρικού και ηλεκτρονικού εξοπλισμού. Η χωριστή συλλογή και 
ανακύκλωση των άχρηστων συσκευών θα συμβάλει στη διατήρηση των φυσικών πόρων και στη διασφάλιση ότι θα ανακυκλωθούν με τέτοιον τρόπο, ώστε να προστατεύεται η υγεία των 
ανθρώπων και το περιβάλλον. Για περισσότερες πληροφορίες σχετικά με το πού μπορείτε να απορρίψετε τις άχρηστες συσκευές για ανακύκλωση, επικοινωνήστε με τις κατά τόπους αρμόδιες 
αρχές ή με το κατάστημα από το οποίο αγοράσατε το προϊόν.
A hulladékanyagok kezelése a magánháztartásokban az Európai Unióban
Ez a szimbólum, amely a terméken vagy annak csomagolásán van feltüntetve, azt jelzi, hogy a termék nem kezelhető együtt az egyéb háztartási hulladékkal. Az Ön feladata, 
hogy a készülék hulladékanyagait eljuttassa olyan kijelölt gyűjtőhelyre, amely az elektromos hulladékanyagok és az elektronikus berendezések újrahasznosításával foglalkozik. 
A hulladékanyagok elkülönített gyűjtése és újrahasznosítása hozzájárul a természeti erőforrások megőrzéséhez, egyúttal azt is biztosítja, hogy a hulladék újrahasznosítása az 
egészségre és a környezetre nem ártalmas módon történik. Ha tájékoztatást szeretne kapni azokról a helyekről, ahol leadhatja újrahasznosításra a hulladékanyagokat, forduljon 
a helyi önkormányzathoz, a háztartási hulladék begyűjtésével foglalkozó vállalathoz vagy a termék forgalmazójához.
Lietotāju atbrīvošanās no nederīgām ierīcēm Eiropas Savienības privātajās mājsaimniecībās
Šis simbols uz ierīces vai tās iepakojuma norāda, ka šo ierīci nedrīkst izmest kopā ar pārējiem mājsaimniecības atkritumiem. Jūs esat atbildīgs par atbrīvošanos no nederīgās ierīces, 
to nododot norādītajā savākšanas vietā, lai tiktu veikta nederīgā elektriskā un elektroniskā aprīkojuma otrreizējā pārstrāde. Speciāla nederīgās ierīces savākšana un otrreizējā pārstrāde 
palīdz taupīt dabas resursus un nodrošina tādu otrreizējo pārstrādi, kas sargā cilvēku veselību un apkārtējo vidi. Lai iegūtu papildu informāciju par to, kur otrreizējai pārstrādei var 
nogādāt nederīgo ierīci, lūdzu, sazinieties ar vietējo pašvaldību, mājsaimniecības atkritumu savākšanas dienestu vai veikalu, kurā iegādājāties šo ierīci.
Europos Sąjungos vartotojų ir privačių namų ūkių atliekamos įrangos išmetimas
Šis simbolis ant produkto arba jo pakuotės nurodo, kad produktas negali būti išmestas kartu su kitomis namų ūkio atliekomis. Jūs privalote išmesti savo atliekamą įrangą atiduodami ją 
į atliekamos elektronikos ir elektros įrangos perdirbimo punktus. Jei atliekama įranga bus atskirai surenkama ir perdirbama, bus išsaugomi natūralūs ištekliai ir užtikrinama, kad įranga 
yra perdirbta žmogaus sveikatą ir gamtą tausojančiu būdu. Dėl informacijos apie tai, kur galite išmesti atliekamą perdirbti skirtą įrangą kreipkitės į atitinkamą vietos tarnybą, namų ūkio 
atliekų išvežimo tarnybą arba į parduotuvę, kurioje pirkote produktą.
Utylizacja zużytego sprzętu przez użytkowników domowych w Unii Europejskiej
Symbol ten umieszczony na produkcie lub opakowaniu oznacza, że tego produktu nie należy wyrzucać razem z innymi odpadami domowymi. Użytkownik jest odpowiedzialny za 
dostarczenie zużytego sprzętu do wyznaczonego punktu gromadzenia zużytych urządzeń elektrycznych i elektronicznych. Gromadzenie osobno i recykling tego typu odpadów 
przyczynia się do ochrony zasobów naturalnych i jest bezpieczny dla zdrowia i środowiska naturalnego. Dalsze informacje na temat sposobu utylizacji zużytych urządzeń można 
uzyskać u odpowiednich władz lokalnych, w przedsiębiorstwie zajmującym się usuwaniem odpadów lub w miejscu zakupu produktu.
Descarte de equipamentos por usuários em residências da União Européia
Este símbolo no produto ou na embalagem indica que o produto não pode ser descartado junto com o lixo doméstico. No entanto, é sua responsabilidade levar os equipamentos 
a serem descartados a um ponto de coleta designado para a reciclagem de equipamentos eletro-eletrônicos. A coleta separada e a reciclagem dos equipamentos no momento do 
descarte ajudam na conservação dos recursos naturais e garantem que os equipamentos serão reciclados de forma a proteger a saúde das pessoas e o meio ambiente. Para obter mais 
informações sobre onde descartar equipamentos para reciclagem, entre em contato com o escritório local de sua cidade, o serviço de limpeza pública de seu bairro ou a loja em que 
adquiriu o produto.
Postup používateľov v krajinách Európskej únie pri vyhadzovaní zariadenia v domácom používaní do odpadu
Tento symbol na produkte alebo na jeho obale znamená, že nesmie by vyhodený s iným komunálnym odpadom. Namiesto toho máte povinnos odovzda toto zariadenie na zbernom 
mieste, kde sa zabezpečuje recyklácia elektrických a elektronických zariadení. Separovaný zber a recyklácia zariadenia určeného na odpad pomôže chráni prírodné zdroje a 
zabezpečí taký spôsob recyklácie, ktorý bude chráni ľudské zdravie a životné prostredie. Ďalšie informácie o separovanom zbere a recyklácii získate na miestnom obecnom úrade, 
vo firme zabezpečujúcej zber vášho komunálneho odpadu alebo v predajni, kde ste produkt kúpili.
Ravnanje z odpadno opremo v gospodinjstvih znotraj Evropske unije
Ta znak na izdelku ali embalaži izdelka pomeni, da izdelka ne smete odlagati skupaj z drugimi gospodinjskimi odpadki. Odpadno opremo ste dolžni oddati na določenem zbirnem 
mestu za recikliranje odpadne električne in elektronske opreme. Z ločenim zbiranjem in recikliranjem odpadne opreme ob odlaganju boste pomagali ohraniti naravne vire in zagotovili, 
da bo odpadna oprema reciklirana tako, da se varuje zdravje ljudi in okolje. Več informacij o mestih, kjer lahko oddate odpadno opremo za recikliranje, lahko dobite na občini, 
v komunalnem podjetju ali trgovini, kjer ste izdelek kupili.
Kassering av förbrukningsmaterial, för hem- och privatanvändare i EU
Produkter eller produktförpackningar med den här symbolen får inte kasseras med vanligt hushållsavfall. I stället har du ansvar för att produkten lämnas till en behörig återvinningsstation 
för hantering av el- och elektronikprodukter. Genom att lämna kasserade produkter till återvinning hjälper du till att bevara våra gemensamma naturresurser. Dessutom skyddas både 
människor och miljön när produkter återvinns på rätt sätt. Kommunala myndigheter, sophanteringsföretag eller butiken där varan köptes kan ge mer information om var du lämnar 
kasserade produkter för återvinning.
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Power consumption
Hewlett-Packard printing and imaging equipment marked with the ENERGY STAR® logo is
qualified to the U.S. Environmental Protection Agency’s ENERGY STAR specifications for
imaging equipment. The following mark appears on ENERGY STAR qualified imaging products:

ENERGY STAR is a U.S. registered service mark of the U.S. EPA. As an ENERGY STAR
partner, HP has determined that this product meets ENERGY STAR guidelines for energy
efficiency.

Additional ENERGY STAR qualified imaging product model information is listed at:

www.hp.com/go/energystar

Chemical Substances
HP is committed to providing our customers with information about the chemical substances in our
products as needed to comply with legal requirements such as REACH (Regulation EC No
1907/2006 of the European Parliament and the Council). A chemical information report for this
product can be found at: www.hp.com/go/reach

Battery information
The printer has internal batteries that are used to maintain printer settings when the printer is
turned off. These batteries might require special handling and disposal.

This section contains the following topics:

• Battery disposal in Taiwan

• Attention California users

Battery disposal in Taiwan

Attention California users
The battery supplied with this product may contain perchlorate material. Special handling may
apply. For more information, go to the following website: www.dtsc.ca.gov/hazardouswaste/
perchlorate.

Appendix A

104 Technical information

http://www.hp.com/go/energystar
http://www.hp.com/go/reach
http://www.dtsc.ca.gov/hazardouswaste/perchlorate
http://www.dtsc.ca.gov/hazardouswaste/perchlorate


RoHS notices (China only)

Toxic and hazardous substance table

RoHS notices (Ukraine only)
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Third-party licenses

LICENSE.aes-pubdom--crypto

---------------------

/* rijndael-alg-fst.c

 *

 * @version 3.0 (December 2000)

 *

 * Optimised ANSI C code for the Rijndael cipher (now AES)

 *

 * @author Vincent Rijmen <vincent.rijmen@esat.kuleuven.ac.be>

 * @author Antoon Bosselaers <antoon.bosselaers@esat.kuleuven.ac.be>

 * @author Paulo Barreto <paulo.barreto@terra.com.br>

 *

 * This code is hereby placed in the public domain.

 *

 * THIS SOFTWARE IS PROVIDED BY THE AUTHORS ''AS IS'' AND ANY EXPRESS

 * OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED

 * WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE

 * ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHORS OR CONTRIBUTORS BE

 * LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR

 * CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF

 * SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR

 * BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY,

 * WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE

 * OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE,

 * EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

 */

LICENSE.expat-mit--expat

---------------------

Copyright (c) 1998, 1999, 2000 Thai Open Source Software Center Ltd

Permission is hereby granted, free of charge, to any person obtaining

a copy of this software and associated documentation files (the

"Software"), to deal in the Software without restriction, including

without limitation the rights to use, copy, modify, merge, publish,

distribute, sublicense, and/or sell copies of the Software, and to

permit persons to whom the Software is furnished to do so, subject to

the following conditions:

The above copyright notice and this permission notice shall be included

in all copies or substantial portions of the Software.
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THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND,

EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF

MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT.

IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY

CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT,

TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE

SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

LICENSE.hmac-sha2-bsd--nos_crypto

---------------------

/* HMAC-SHA-224/256/384/512 implementation

* Last update: 06/15/2005

* Issue date: 06/15/2005

*

* Copyright (C) 2005 Olivier Gay <olivier.gay@a3.epfl.ch>

* All rights reserved.

*

* Redistribution and use in source and binary forms, with or without

* modification, are permitted provided that the following conditions

* are met:

* 1. Redistributions of source code must retain the above copyright

* notice, this list of conditions and the following disclaimer.

* 2. Redistributions in binary form must reproduce the above copyright

* notice, this list of conditions and the following disclaimer in the

* documentation and/or other materials provided with the distribution.

* 3. Neither the name of the project nor the names of its contributors

* may be used to endorse or promote products derived from this software

* without specific prior written permission.

*

* THIS SOFTWARE IS PROVIDED BY THE PROJECT AND CONTRIBUTORS ``AS IS'' AND

* ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE

* IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE

* ARE DISCLAIMED. IN NO EVENT SHALL THE PROJECT OR CONTRIBUTORS BE LIABLE

* FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL

* DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS

* OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)

* HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,
STRICT

* LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY

* OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF

* SUCH DAMAGE.

*/

LICENSE.open_ssl--open_ssl

---------------------

Copyright (C) 1995-1998 Eric Young (eay@cryptsoft.com)
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All rights reserved.

This package is an SSL implementation written

by Eric Young (eay@cryptsoft.com).

The implementation was written so as to conform with Netscapes SSL.

This library is free for commercial and non-commercial use as long as

the following conditions are aheared to. The following conditions

apply to all code found in this distribution, be it the RC4, RSA,

lhash, DES, etc., code; not just the SSL code. The SSL documentation

included with this distribution is covered by the same copyright terms

except that the holder is Tim Hudson (tjh@cryptsoft.com).

Copyright remains Eric Young's, and as such any Copyright notices in

the code are not to be removed.

If this package is used in a product, Eric Young should be given attribution

as the author of the parts of the library used.

This can be in the form of a textual message at program startup or

in documentation (online or textual) provided with the package.

Redistribution and use in source and binary forms, with or without

modification, are permitted provided that the following conditions

are met:

1. Redistributions of source code must retain the copyright

 notice, this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright

 notice, this list of conditions and the following disclaimer in the

 documentation and/or other materials provided with the distribution.

3. All advertising materials mentioning features or use of this software

 must display the following acknowledgement:

 "This product includes cryptographic software written by

 Eric Young (eay@cryptsoft.com)"

 The word 'cryptographic' can be left out if the rouines from the library

 being used are not cryptographic related :-).

4. If you include any Windows specific code (or a derivative thereof) from 

 the apps directory (application code) you must include an acknowledgement:

 "This product includes software written by Tim Hudson (tjh@cryptsoft.com)"

THIS SOFTWARE IS PROVIDED BY ERIC YOUNG ``AS IS'' AND

ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE

IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE

ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE

FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL

DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS

OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)

Appendix A

108 Technical information



HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,
STRICT

LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY

OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF

SUCH DAMAGE.

The licence and distribution terms for any publically available version or

derivative of this code cannot be changed. i.e. this code cannot simply be

copied and put under another distribution licence

[including the GNU Public Licence.]

====================================================================

Copyright (c) 1998-2001 The OpenSSL Project. All rights reserved.

Redistribution and use in source and binary forms, with or without

modification, are permitted provided that the following conditions

are met:

1. Redistributions of source code must retain the above copyright

 notice, this list of conditions and the following disclaimer. 

2. Redistributions in binary form must reproduce the above copyright

 notice, this list of conditions and the following disclaimer in

 the documentation and/or other materials provided with the

 distribution.

3. All advertising materials mentioning features or use of this

 software must display the following acknowledgment:

 "This product includes software developed by the OpenSSL Project

 for use in the OpenSSL Toolkit. (http://www.openssl.org/)"

4. The names "OpenSSL Toolkit" and "OpenSSL Project" must not be used to

 endorse or promote products derived from this software without

 prior written permission. For written permission, please contact

 openssl-core@openssl.org.

5. Products derived from this software may not be called "OpenSSL"

 nor may "OpenSSL" appear in their names without prior written

 permission of the OpenSSL Project.

6. Redistributions of any form whatsoever must retain the following

 acknowledgment:

 "This product includes software developed by the OpenSSL Project

 for use in the OpenSSL Toolkit (http://www.openssl.org/)"

THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT ``AS IS'' AND ANY
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EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE

IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR

PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE OpenSSL PROJECT OR

ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,

SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT

NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;

LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)

HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,

STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)

ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED

OF THE POSSIBILITY OF SUCH DAMAGE.

====================================================================

This product includes cryptographic software written by Eric Young

(eay@cryptsoft.com). This product includes software written by Tim

Hudson (tjh@cryptsoft.com).

====================================================================

Copyright (c) 1998-2006 The OpenSSL Project. All rights reserved.

Redistribution and use in source and binary forms, with or without

modification, are permitted provided that the following conditions

are met:

1. Redistributions of source code must retain the above copyright

 notice, this list of conditions and the following disclaimer. 

2. Redistributions in binary form must reproduce the above copyright

 notice, this list of conditions and the following disclaimer in

 the documentation and/or other materials provided with the

 distribution.

3. All advertising materials mentioning features or use of this

 software must display the following acknowledgment:

 "This product includes software developed by the OpenSSL Project

 for use in the OpenSSL Toolkit. (http://www.openssl.org/)"

4. The names "OpenSSL Toolkit" and "OpenSSL Project" must not be used to

 endorse or promote products derived from this software without

 prior written permission. For written permission, please contact

 openssl-core@openssl.org.

5. Products derived from this software may not be called "OpenSSL"

 nor may "OpenSSL" appear in their names without prior written

 permission of the OpenSSL Project.
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6. Redistributions of any form whatsoever must retain the following

 acknowledgment:

 "This product includes software developed by the OpenSSL Project

 for use in the OpenSSL Toolkit (http://www.openssl.org/)"

THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT ``AS IS'' AND ANY

EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE

IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR

PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE OpenSSL PROJECT OR

ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,

SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT

NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;

LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)

HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,

STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)

ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED

OF THE POSSIBILITY OF SUCH DAMAGE.

====================================================================

This product includes cryptographic software written by Eric Young

(eay@cryptsoft.com). This product includes software written by Tim

Hudson (tjh@cryptsoft.com).

====================================================================

Copyright 2002 Sun Microsystems, Inc. ALL RIGHTS RESERVED.

ECC cipher suite support in OpenSSL originally developed by 

SUN MICROSYSTEMS, INC., and contributed to the OpenSSL project.

LICENSE.sha2-bsd--nos_crypto

---------------------

/* FIPS 180-2 SHA-224/256/384/512 implementation

 * Last update: 02/02/2007

 * Issue date: 04/30/2005

 *

 * Copyright (C) 2005, 2007 Olivier Gay <olivier.gay@a3.epfl.ch>

 * All rights reserved.

 *

 * Redistribution and use in source and binary forms, with or without

 * modification, are permitted provided that the following conditions

 * are met:

 * 1. Redistributions of source code must retain the above copyright

 * notice, this list of conditions and the following disclaimer.

 * 2. Redistributions in binary form must reproduce the above copyright
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 * notice, this list of conditions and the following disclaimer in the

 * documentation and/or other materials provided with the distribution.

 * 3. Neither the name of the project nor the names of its contributors

 * may be used to endorse or promote products derived from this software

 * without specific prior written permission.

 *

 * THIS SOFTWARE IS PROVIDED BY THE PROJECT AND CONTRIBUTORS ``AS IS'' AND

 * ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE

 * IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE

 * ARE DISCLAIMED. IN NO EVENT SHALL THE PROJECT OR CONTRIBUTORS BE LIABLE

 * FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL

 * DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE
GOODS

 * OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)

 * HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,
STRICT

 * LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY

 * OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF

 * SUCH DAMAGE.

 */

LICENSE.zlib--zlib

---------------------

zlib.h -- interface of the 'zlib' general purpose compression library

version 1.2.3, July 18th, 2005

Copyright (C) 1995-2005 Jean-loup Gailly and Mark Adler

This software is provided 'as-is', without any express or implied

warranty. In no event will the authors be held liable for any damages

arising from the use of this software.

Permission is granted to anyone to use this software for any purpose,

including commercial applications, and to alter it and redistribute it

freely, subject to the following restrictions:

1. The origin of this software must not be misrepresented; you must not

 claim that you wrote the original software. If you use this software

 in a product, an acknowledgment in the product documentation would be

 appreciated but is not required.

2. Altered source versions must be plainly marked as such, and must not be

 misrepresented as being the original software.

3. This notice may not be removed or altered from any source distribution.

Jean-loup Gailly Mark Adler
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jloup@gzip.org madler@alumni.caltech.edu

The data format used by the zlib library is described by RFCs (Request for

Comments) 1950 to 1952 in the files http://www.ietf.org/rfc/rfc1950.txt

(zlib format), rfc1951.txt (deflate format) and rfc1952.txt (gzip format).
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B HP supplies and accessories
This section provides information on HP supplies and accessories for the printer. The information
is subject to changes, visit the HP website (www.hpshopping.com) for the latest updates. You
may also make purchases through the website.

This section contains the following topics:

• Order printing supplies online

• Supplies

Order printing supplies online
To order supplies online or create a printable shopping list, open the HP software that came with
your printer and click Shopping. Select Shop for Supplies Online. The HP software uploads,
with your permission, printer information, including model number, serial number, and estimated
ink levels. The HP supplies that work in your printer are pre-selected. You can change quantities,
add or remove items, and then print the list or purchase online at the HP Store or other online
retailers (options differ by country/region). Cartridge information and links to online shopping also
appear on low on ink messages.

You can also order online by visiting www.hp.com/buy/supplies. If prompted, select your country/
region, follow the prompts to select your printer, and then the supplies you need.

NOTE: Ordering cartridges online is not supported in all countries/regions. However, many
countries have information on ordering by telephone, locating a local store and printing
a shopping list. In addition, you can select the 'How to Buy' option at the top of the
www.hp.com/buy/supplies page to obtain information about purchasing HP products in your
country.

Supplies
• Ink cartridges and printheads

• HP media

Ink cartridges and printheads
Ordering cartridges online is not supported in all countries/regions. However, many countries have
information on ordering by telephone, locating a local store and printing a shopping list. In
addition, you can select the How to Buy option at the top of the www.hp.com/buy/supplies page to
obtain information about purchasing HP products in your country.

Use only the replacement cartridges that have the same cartridge number as the ink cartridge you
are replacing. You can find the cartridge number in the following places:

• In the embedded web server, by clicking the Tools tab, and then, under Product Information
clicking Ink Gauge. For more information, see Embedded web server.

• On the printer status page (see Understand the Printer Status Report).

• On the label of the ink cartridge you are replacing.

• On a sticker inside the printer.

CAUTION: The Setup ink cartridge that comes with the printer is not available for
separate purchase. Check for the correct cartridge number through the EWS, on the
printer status report, or on the sticker inside the printer.

114 HP supplies and accessories

http://www.hpshopping.com
http://www.hp.com/buy/supplies
http://www.hp.com/buy/supplies


NOTE: Ink level warnings and indicators provide estimates for planning purposes only.
When you receive a low on link message, consider having a replacement cartridge available
to avoid possible printing delays. You do not need to replace cartridges until prompted to do
so.

HP media
To order media such as HP Premium Paper, go to www.hp.com.

HP recommends plain papers with the ColorLok logo for printing
of everyday documents. All papers with the ColorLok logo are
independently tested to meet high standards of reliability and
print quality, and produce documents with crisp, vivid color,
bolder blacks, and that dry faster than ordinary plain papers.
Look for papers with the ColorLok logo in a variety of weights
and sizes from major paper manufacturers.
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C Network setup
You can manage network settings for the printer through the printer control panel as described in
the next section. Additional advanced settings are available in the embedded web server,
a configuration and status tool you access from your web browser using an existing network
connection to the printer. For more information, see Embedded web server.

This section contains the following topics:

• Change basic network settings

• Change advanced network settings

• Set up the printer for wireless communication

• Uninstall and reinstall the HP software

Change basic network settings
The control-panel options enable you to set up and manage a wireless connection and to perform
a variety of network management tasks. This includes viewing the network settings, restoring the
network defaults, turning the wireless radio on and off, and changing the network settings.

This section contains the following topics:

• View and print network settings

• Turn the wireless radio on and off

View and print network settings
You can display a summary of the network settings on the printer control panel or the HP software
that came with the printer. You can print a more detailed network configuration page, which lists
all of the important network settings such as the IP address, link speed, DNS, and mDNS. For
more information, see Understand the network configuration page.

Turn the wireless radio on and off
The wireless radio is on by default, as indicated by the blue light on the front of the printer. In
order to stay connected to a wireless network, the radio must stay on. However, if your printer is
connected to a wired network or you have a USB connection, the radio is not used. In this case
you might want to turn the radio off. To turn the wireless radio off, press and hold the

 (Wireless) button.

Change advanced network settings

CAUTION: Network settings are provided for your convenience. However, unless you are an
advanced user, you should not change some of these settings (such as the link speed, IP
settings, default gateway, and firewall settings).

This section contains the following topics:

• Set link speed

• View IP settings

• Change IP settings

• Configure the printer’s firewall settings

• Reset network settings
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Set link speed
You can change the speed at which data is transmitted over the network. The default is
Automatic.

1. Open the embedded web server (EWS). For more information, see To open the embedded
web server.

2. Click the Network tab, and then click Advanced in the Wired (802.3) section.

3. In the Link Settings section, click Manual.

4. Click to select the link speed that matches your network hardware:

• 2. 10-Full

• 3. 10-Half

• 4. 100-Full

• 5. 100-Half

View IP settings
To view the IP address of the printer:

• Print the network configuration page. For more information, see Understand the network
configuration page.

• Or, open the HP software (Windows), double-click Estimated Ink Levels, click the Device
Information tab. The IP address is listed in the Network Information section.

Change IP settings
The default IP setting for the IP settings is Automatic, which sets the IP settings automatically.
However, if you are an advanced user, you might want to manually change settings such as the IP
address, subnet mask, or the default gateway.

CAUTION: Be careful when manually assigning an IP address. If you enter an invalid IP
address during the installation, your network components cannot connect with the printer.

1. Open the embedded web server (EWS). For more information, see To open the embedded
web server.

2. Click the Network tab, and then click IPv4 in the Wired (802.3) section.

3. In the IP Address Configuration section, click Manual.

4. A message appears warning that changing the IP address removes the printer from the
network. Click OK to continue.

5. Change the IP settings:

• Manual IP Address

• Manual Subnet Mask

• Manual Default Gateway

6. Click Apply.

Configure the printer’s firewall settings
Firewall features provide network-layer security on both IPv4 and IPv6 networks. The firewall
provides simple control of IP addresses that are allowed access.

NOTE: In addition to firewall protection at the network layer, the printer also supports open
secure sockets layer (SSL) standards at the transport layer for secure client-server
applications, such as client-server authentication or HTTPS web browsing.

For firewall operation on the printer, you must configure a firewall policy to apply to specified IP
traffic. Firewall policy pages are accessed through the EWS and displayed by your web browser.

After a policy is configured, it is not activated until you click Apply in the EWS.
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Creating and using firewall rules
Firewall rules allow you to control IP traffic. Use firewall rules to allow or drop IP traffic based on
IP addresses and services.

Enter up to ten rules, each rule specifying the host addresses, services, and the action to take for
those addresses and services.

This section contains the following topics:

• Create a firewall rule

• Change the priority of firewall rules

• Change firewall options

• Reset firewall settings

• Limitations to rules, templates, and services

Create a firewall rule

To create a firewall rule, complete the following steps:

1. Open the embedded web server. For more information, see Embedded web server.

2. Click the Settings tab, click Firewall Rules.

3. Click New, and then follow the onscreen instructions.

NOTE: After clicking Apply, the connection to the EWS might be temporarily disrupted for a
short period of time. If the IP address was unchanged, the EWS connection will be enabled
again. However, if the IP address was changed, use the new IP address to open the EWS.

Change the priority of firewall rules

To change the priority in which a firewall rule is used, complete the following steps:

1. Open the embedded web server. For more information, see Embedded web server.

2. Click the Settings tab, click Firewall Rules Priority.

3. Select the priority in which you want the rule to be used from the Rule Precedence list, with
10 having the highest priority and 1 having the lowest priority.

4. Click Apply.

Change firewall options

To change firewall options for the printer, complete the following steps:

1. Open the embedded web server. For more information, see Embedded web server.

2. Click the Settings tab, click Firewall Options.

3. Change any settings, and then click Apply.

NOTE: After clicking Apply, the connection to the EWS might be temporarily disrupted for a
short period of time. If the IP address was unchanged, the EWS connection will be enabled
again. However, if the IP address was changed, use the new IP address to open the EWS.

Reset firewall settings

To reset the firewall settings to the factory defaults, restore the printer’s network settings.

To reset the printer's network settings

1. To reset the network settings, press and hold the  (Cancel),  (Wireless), and  (Power)
buttons for three seconds.

2. Press the  (Resume) and  (Wireless) buttons together, and then release to print the
network configuration page and verify that the network settings have been reset.
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Limitations to rules, templates, and services

When creating firewall rules, note the following limitations to rules, templates, and services.

Item Limit

Maximum number of rules. 10 (one default rule)

Maximum number of Address Templates. 12

Maximum number of user-defined address
templates.

5

Maximum number of services you can add to
a user-defined service template.

NOTE: The predefined All Services template
is not subject to this limitation and includes all
services supported by the print server.

40

Maximum number of services you can add to
the policy.

For a given rule, only one address template
and one service template can be added.

40

Maximum number of service templates in the
policy.

10

Maximum number of user-defined custom
service templates.

5

Reset network settings

To reset the administrator password and network settings, press and hold  (Wireless button)
and  (Cancel button) for three seconds.

NOTE: Print the network configuration page and verify that the network settings have been
reset. For more information, see Understand the network configuration page.

NOTE: Resetting the printer’s network settings also resets the printer’s firewall settings. For
more information about configuring the printer’s firewall settings, see Configure the printer’s
firewall settings.

Set up the printer for wireless communication
You may set up the printer for wireless communication.

This section contains the following topics:

• Before you begin

• Set up the printer on your wireless network

• Set up the printer using the HP printer software (Recommended)

• Set up the printer using WiFi Protected Setup (WPS)

• Set up the printer using the embedded web server (EWS)

• Change the connection type

• Test the wireless connection

• Guidelines for ensuring wireless network security

• Guidelines for reducing interference on a wireless network

NOTE: If you encounter problems connecting the printer, see Solve wireless problems

Set up the printer for wireless communication 119



TIP: For more information about setting up and using the printer wirelessly, visit the HP
Wireless Printing Center (www.hp.com/go/wirelessprinting).

Before you begin
Before you begin setting up the wireless connection, check the following:

• The printer is not connected to the network using a network cable.

• The wireless network is set up and functioning correctly.

• The printer and the computers that use the printer are on the same network (subnet).

While connecting the printer, you might be prompted to enter the wireless network name (SSID)
and a wireless password:

• The wireless network name is the name of your wireless network.

• The wireless password prevents other people from connecting to your wireless network
without your permission. Depending on the level of security required, your wireless network
might use either a WPA key or WEP passphrase.

If you have not changed the network name or the security passkey since setting up your wireless
network, you can sometimes find them on the back or side of the wireless router.

If you cannot find the network name or the security passkey or cannot remember this information,
see the documentation available with your computer or with the wireless router. If you still cannot
find this information, contact your network administrator or the person who set up the wireless
network.

TIP: If you are using a computer running Windows, HP provides a tool called HP Home
Network Diagnostic Utility that can help retrieve this information for some systems. To use this
tool, visit the HP Wireless Printing Center (www.hp.com/go/wirelessprinting), and then click
Network Diagnostic Utility in the Quick Links section. (At this time, this tool might not available
in all languages.)

Set up the printer on your wireless network
To set up the printer on your wireless network, use one of the following methods:

• Set up the printer using the Wireless Setup Wizard (Recommended)

• Set up the printer using the HP printer software (Recommended)

• Set up the printer using WiFi Protected Setup (WPS)

• Set up the printer using the embedded web server (EWS)

NOTE: If you have already been using the printer with a different type of connection, such as
a USB connection, follow the instructions in Change the connection type to set up the printer
on your wireless network.

Set up the printer using the HP printer software (Recommended)
In addition to enabling key printer features, you can use the HP printer software that came with
your printer to set up wireless communication.

If you have already been using the printer with a different type of connection, such as a USB
connection, follow the instructions in Change the connection type to set up the printer on your
wireless network.

Set up the printer using WiFi Protected Setup (WPS)
Wi-Fi Protected Setup (WPS) allows you to quickly set up the printer on your wireless network,
without having to enter the wireless network name (SSID), wireless password (WPA passphrase,
WEP key), or other wireless settings.
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NOTE: Only set up wireless using WPS if your wireless network uses WPA data encryption.
If your wireless network uses WEP or is not using any encryption at all, use one of the other
methods provided in this section to set up the printer on your wireless network.

NOTE: To use WPS, make sure your wireless router or wireless access point supports
WPS. Routers that support WPS often have a Wireless (WPS) button or a button labeled
“WPS”.

You can use one of the following methods to set up the printer using WPS:

• Push Button Method: Use the Wireless (WPS) or WPS button, if available, on your router.

• PIN Method: Enter the PIN generated by the printer in the router’s configuration software.

To connect the printer using the Push Button Method
1. On the printer, press and hold the Wireless (Wireless) button for 3 seconds. The wireless light

starts blinking.

2. On the wireless router or wireless access point, press and hold the WPS button for 3
seconds.

Wait for about 2 minutes. If the printer connects successfully, the wireless light stops blinking but
remains lit.

To connect the printer using the PIN Method
1. Print the network configuration page. For more information, see Understand the network

configuration page. A WPS PIN is printed at the bottom of the page.

2. On the printer, press and hold the Wireless (Wireless) button for 3 seconds. The Wireless
light starts blinking.

3. Open the configuration utility or software for the wireless router or wireless access point, and
then enter the WPS PIN printed at the bottom of the network configuration page.

NOTE: For more information about using the configuration utility, see the documentation
provided with the router or wireless access point.

Wait for about 2 minutes. If the printer connects successfully, the wireless light stops blinking but
remains lit.

Set up the printer using the embedded web server (EWS)
If the printer is connected to a network, you can use the printer’s embedded web server (EWS) to
set up wireless communication.

1. Open the EWS. For more information, see Embedded web server.

2. On the Home tab, click Wireless Setup Wizard in the Setup box.

3. Follow the onscreen instructions.

TIP: You can also set up wireless communication by entering or changing individual wireless
settings. To change these settings, on the Network tab, click Advanced in the Wireless
(802.11) section on the left, change the wireless settings, and then click Apply.

Change the connection type
After you have installed the HP software and connected the printer to your computer or to a
network, you can use the HP software to change the connection type (for example, from a USB
connection to a wireless connection).
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To change from an Ethernet connection to a wireless connection

Windows

1. On the computer desktop, click Start, select Programs or All Programs, click HP, select
your printer name, and then click Printer Setup & Software.

2. Click Connect a new printer, and then select the type of connection you want to use.

3. Follow the display instructions to complete the setup.

Mac OS X

1. Open HP Utility. For more information, see .HP Utility (Mac OS X)

2. Click the Applications icon on the HP Utility toolbar.

3. Double-click HP Setup Assistant, and then follow the onscreen instructions.

To change from a USB connection to a wireless connection
Follow the instructions for your operating system.

Windows

1. On the computer desktop, click Start, select Programs or All Programs, click HP, select
your printer name, and then click Printer Setup & Software.

2. Click Connect a new printer, and then click Convert a USB connected printer to wireless.

3. Follow the display instructions to complete the setup.

Mac OS X

1. Open HP Utility. For more information, see HP Utility (Mac OS X).

2. Click the Applications icon on the HP Utility toolbar.

3. Double-click HP Setup Assistant, and then follow the onscreen instructions.

To change from a wireless connection to a USB or Ethernet connection
To change from a wireless connection to a USB or Ethernet connection, connect the USB or
Ethernet cable to the printer.

NOTE: If you are using a computer with Mac OS X, add the printer to the print queue. Click
System Preferences in the Dock, click Print & Fax in the Hardware section, click +, and
then select the printer.

Test the wireless connection
Print the wireless test page for information about the printer's wireless connection. The wireless
test page provides information about the printer's status, hardware (MAC) address, and IP
address. If the printer is connected to a network, the test page displays details about the network
settings.

To print the wireless test page

▲ To print the wireless test page, pressWireless] (Wireless) button and Resume (Resume)
button simultaneously when the network is enabled.

Guidelines for ensuring wireless network security
The following information can help you keep your wireless network and wireless printer secure
from unauthorized use.

For more information, visit www.hp.com/go/wirelessprinting.

This section contains the following topics:

• Overview of security settings

• Add hardware addresses to a wireless router (MAC filtering)

• Other wireless security guidelines
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Overview of security settings
To help improve the security of the wireless network and prevent unauthorized access, the printer
supports many common types of network authentication, including WEP, WPA, and WPA2.

• WEP: Provides security by encrypting data sent over radio waves from one wireless device to
another wireless device. Devices on a WEP-enabled network use WEP keys to encode data.
If your network uses WEP, you must know the WEP key(s) it uses.

• WPA: Increases the level of over-the-air data protection and access control on existing and
future wireless networks. It addresses all known weaknesses of WEP, the original native
security mechanism in the 802.11 standard. WPA uses the Temporal Key Integrity Protocol
(TKIP) for encryption and employs 802.1X authentication with one of the standard Extensible
Authentication Protocol (EAP) types available today.

• WPA2: Provides enterprise and consumer wireless users with a high level of assurance that
only authorized users can access their wireless networks. WPA2 provides the Advanced
Encryption Standard (AES). AES is defined in counter cipher-block chaining mode (CCM) and
supports the Independent Basic Service Set (IBSS) to enable security between client
workstations operating connected wirelessly without a wireless router (such as a Linksys
wireless router or Apple AirPort Base Station).

Add hardware addresses to a wireless router (MAC filtering)
MAC filtering is a security feature in which a wireless router or wireless access point is configured
with a list of hardware addresses (also called "MAC addresses") of devices that are allowed to
gain access to the network through the router.

If the router filters hardware addresses, then the printer's hardware address must be added to the
router’s list of accepted hardware addresses. If the router does not have the hardware address of
a printer attempting to access the network, the router denies the printer access to the network.

CAUTION: This method is not recommended, however, because your MAC addresses can
easily be read and falsified by unwanted users outside your network.

To add hardware addresses to a wireless router or wireless access point

1. Print the network configuration page, and then locate the printer’s hardware address. For
more information, see Understand the network configuration page.

NOTE: The printer maintains separate hardware addresses for the Ethernet connection
and for wireless connection. Both hardware addresses are listed on the printer’s network
configuration page.

2. Open the configuration utility for the wireless router or wireless access point, and add the
printer's hardware address to the list of accepted hardware addresses.

NOTE: For more information about using the configuration utility, see the documentation
provided with the router or wireless access point.

Other wireless security guidelines
To keep the wireless network secure, follow these guidelines:

• Use a wireless password with at least 20 random characters. You can use up to 64
characters in a WPA wireless password.

• Avoid any common words or phrases, easy sequences of characters (such as all 1s), and
personally-identifiable information for wireless passwords. Always use random strings
composed of uppercase and lowercase letters, numbers, and if allowed, special characters
such as punctuation.

• Change the default wireless password provided by the manufacturer for administrator access
to the access point or wireless router. Some routers let you change the administrator name as
well.
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• Turn off administrative access over wireless if possible. If you do this, you need to connect to
the router with a wired Ethernet connection when you want to make configuration changes.

• Turn off remote administrative access over the Internet on your router, if possible. You can
use Remote Desktop to make an encrypted connection to a computer running behind your
router and make configuration changes from the local computer you are accessing over the
Internet.

• To avoid accidentally connecting to another party's wireless network, turn off the setting to
automatically connect to non-preferred networks. This is disabled by default in Windows XP.

Guidelines for reducing interference on a wireless network
The following tips will help reduce the chances for interference in a wireless network:

• Keep the wireless devices away from large metal objects, such as filing cabinets, and other
electromagnetic devices, such as microwaves and cordless telephones, as these objects can
disrupt radio signals.

• Keep the wireless devices away from large masonry structures and other building structures
as these objects can absorb radio waves and lower signal strength.

• Position the access point or wireless router in a central location in line of sight with the
wireless devices on the network.

• Keep all wireless devices on the network within range of one another.

Uninstall and reinstall the HP software
If your installation is incomplete, or if you connected the USB cable to the computer before
prompted by the HP software installation screen, you might need to uninstall and then reinstall the
HP software that came with the printer. Do not simply delete the printer application files from your
computer. Make sure to remove them correctly using the uninstall utility provided when you
installed the HP software.

Windows

To uninstall, method 1

1. Disconnect the printer from your computer. Do not connect it to your computer until after you
have reinstalled the HP software.

2. On the computer desktop, click Start, select Programs or All Programs, click HP, click the
printer name, and then click Uninstall.

3. Follow the onscreen instructions.

4. If you are asked whether you would like to remove shared files, click No.
Other programs that use these files might not work correctly if the files are deleted.

5. Restart your computer.

6. To reinstall the HP software, insert the HP software CD into your computer's CD drive, and
follow the onscreen instructions.

7. Connect the printer when the HP software prompts you to connect it to the computer.

8. Press the  (Power) button to turn the printer on.
After connecting and turning on the printer, you might have to wait several minutes for all of
the Plug and Play events to complete.

9. Follow the onscreen instructions.

To uninstall, method 2

NOTE: Use this method if Uninstall is not available in the Windows Start menu.
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1. On the computer desktop, click Start, select Settings, click Control Panel, and then click
Add/Remove Programs.
- Or -
Click Start, click Control Panel, and then double-click Programs and Features.

2. Select the printer name, and then click Change/Remove or Uninstall/Change.
Follow the onscreen instructions.

3. Disconnect the printer from your computer.

4. Restart your computer.

NOTE: It is important that you disconnect the printer before restarting your computer.
Do not connect the printer to your computer until after you have reinstalled the HP
software.

5. Insert the HP software CD into your computer's CD drive and then start the Setup program.

6. Follow the onscreen instructions.

Mac OS X

To uninstall

1. Double-click the HP Uninstaller icon (located in the Hewlett-Packard folder in the
Applications folder at the top level of the hard disk), and then click Continue.

2. When prompted, type the correct administrator’s name and password, and then click OK.

3. Follow the onscreen instructions.

4. When the HP Uninstaller finishes, restart your computer.
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D Printer management tools
This section contains the following topics:

• Toolbox (Windows)

• HP Utility (Mac OS X)

• Embedded web server

Toolbox (Windows)
The Toolbox provides maintenance information about the printer.

NOTE: The Toolbox can be installed from the HP Software CD if the computer meets the
system requirements.

Open the Toolbox
1. From the computer desktop, click the Start tab, select Programs or All Programs, click HP,

click the folder for your printer, and then select the icon with your printer’s name.

2. Double-click Printer Preferences, and then double-click Maintenance Tasks.

HP Utility (Mac OS X)
HP Utility contains tools to configure print settings, calibrate the printer, order supplies online, and
find website support information.

NOTE: The features available in HP Utility vary depending on the selected printer.

Ink level warnings and indicators provide estimates for planning purposes only. When you
receive a low on ink message, consider having a replacement cartridge available to avoid
possible printing delays. You do not need to replace cartridges until prompted to do so.

Open HP Utility
To open HP Utility

Click System Preferences in the Dock, click Print & Fax in the Hardware section, click Open
Print Queue, and then do the following for your version of Mac OS X:

• Mac OS X v10.5: Click Utility on the toolbar.

• Mac OS X v10.6: Click Printer Setup on the toolbar, click the Utility tab, and then click Open
Printer Utility.

– Or –

Double-click the HP Utility icon. This icon is located in the Hewlett-Packard folder in the
Applications folder at the top level of the hard disk.

Embedded web server
When the printer is connected to a network, you can use the printer's home page (embedded web
server or EWS) to view status information, change settings, and manage it from your computer.

NOTE: For a list of system requirements for the embedded web server, see Embedded web
server specifications.

To view or change some settings, you might need a password.

You can open and use the embedded web server without being connected to the Internet.
However, some features are not available.
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This section contains the following topics:

• About cookies

• To open the embedded web server

About cookies
The embedded web server (EWS) places very small text files (cookies) on your hard drive when
you are browsing. These files let the EWS recognize your computer the next time you visit. For
example, if you have configured the EWS language, a cookie helps remember which language
you have selected so that the next time you access the EWS, the pages are displayed in that
language. Though some cookies are cleared at the end of each session (such as the cookie that
stores the selected language), others (such as the cookie that stores customer-specific
preferences) are stored on the computer until you clear them manually.

You can configure your browser to accept all cookies, or you can configure it to alert you every
time a cookie is offered, which allows you to decide which cookies to accept or refuse. You can
also use your browser to remove unwanted cookies.

NOTE: Depending on your printer, if you disable cookies, you also disable one or more of
the following features:

• Starting where you left the application (especially useful when using setup wizards)

• Remembering the EWS browser language setting

• Personalizing the EWS Home page

For information about how to change your privacy and cookie settings and how to view or delete
cookies, see the documentation available with your web browser.

To open the embedded web server

NOTE: The printer must be on a network and must have an IP address. The IP address and
hostname for the printer are listed on the status report. For more information, see Understand
the network configuration page.

In a supported web browser on your computer, type the IP address or hostname assigned to the
printer.
For example, if the IP address is 123.123.123.123, type the following address into the web
browser: http://123.123.123.123.

TIP: After opening the embedded web server, you can bookmark it so that you can return to
it quickly.

TIP: If you are using the Safari web browser in Mac OS X, you can also use the Bonjour
bookmark to open the EWS without typing the IP address. To use the Bonjour bookmark,
open Safari, and then from the Safari menu, click Preferences. On the Bookmarks tab, in
the Bookmarks bar section, select Include Bonjour, and then close the window. Click the
Bonjour bookmark, and then select your networked printer to open the EWS.
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E How do I?
• Get started

• Print

• Work with ink cartridges

• Solve a problem
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F Errors (Windows)

Unable to Communicate with Printer
The computer cannot communicate with the printer because one of the following events has
occurred:

• The printer has been turned off.

• The cable connecting the printer - such as a USB cable or a network (Ethernet) cable – has
been disconnected.

• If the printer is connected to a wireless network, the wireless connection has been broken.

To solve this problem, try the following solutions:

• Make sure the printer is turned on and that the  (Power) light is on.

• Make sure the power cord and other cables are working and are firmly connected to the
printer.

• Make sure the power cord is connected firmly to a functioning, alternating current (AC) power
outlet.

• If the printer is connected to a network, make sure the network is functioning properly. For
more information, see Solve wired (Ethernet) network problems.

• If the printer is connected to a wireless network, make sure the wireless network is functioning
properly. For more information, see Solve wireless problems.

Low on ink
The ink cartridge identified in the message is low on ink.

Ink level warnings and indicators provide estimates for planning purposes only. When you receive
a low on ink message, consider having a replacement cartridge available to avoid possible
printing delays. You do not need to replace cartridges until prompted to do so.

For information about replacing ink cartridges, see Replace the ink cartridges. For information
about ordering ink cartridges, see Order printing supplies online. For information about recycling
used ink supplies, see HP inkjet supplies recycling program.

NOTE: Ink from the cartridges is used in the printing process in a number of different ways,
including in the initialization process, which prepares the printer and cartridges for printing. In
addition, some residual ink is left in the cartridge after it is used. For more information see
www.hp.com/go/inkusage.

Printhead problem
The printhead is missing, not detected, incorrectly installed, or incompatible.

If this error occurs at printer setup, try the following solutions.

Solution 1: Remove and reinstall the printhead.

CAUTION: The printheads contain electrical contacts that can be damaged easily.

For more information, see Remove and reinstall the printhead.

If the problem persists after you reinstall the printhead, contact HP support. For more information,
see HP support.

If this error occurs after the printer has been used for a period of time, try the following
solutions.
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Solution 1: Turn the printer off and on.

Turn off the printer, and then turn it on again.

If the problem persists, contact HP support for service or replacement.

Cartridge Problem
The ink cartridge identified in the message is missing, damaged, incompatible, or inserted into the
wrong slot in the printer.

NOTE: If the cartridge is identified in the message as incompatible, see Order printing
supplies online for information about obtaining cartridges for the printer.

To solve this problem, try the following solutions. Solutions are listed in order, with the most likely
solution first. If the first solution does not solve the problem, continue trying the remaining
solutions until the issue is resolved.

• Solution 1: Turn the printer off and on

• Solution 2: Install the ink cartridges correctly

• Solution 3: Clean the electrical contacts

• Solution 4: Replace the ink cartridge

Solution 1: Turn the printer off and on

Turn off the printer, and then turn it on again.

If the problem persists, try the next solution.

Solution 2: Install the ink cartridges correctly

Make sure all of the ink cartridges are properly installed:

1. Gently pull open the ink cartridge cover.

2. Remove the ink cartridge by grasping it and pulling it firmly toward you.

3. Insert the cartridge into the slot. Press firmly on the cartridge to ensure proper contact.

4. Close the ink cartridge cover and check if the error message has gone away.

If the problem persists, try the next solution.

Solution 3: Clean the electrical contacts

To clean the electrical contacts in the printer

1. Lightly dampen a clean, lint-free cloth with bottled or distilled water.

2. Clean the electrical contacts in the printer by wiping with the cloth from top to bottom. Use as
many fresh, clean cloths as necessary. Clean until no ink shows on the cloth.

3. Wipe the area dry with a dry lint-free cloth before proceeding to the next step.

Solution 4: Replace the ink cartridge

Replace the indicated ink cartridge. For more information, seeReplace the ink cartridges.

NOTE: If your cartridge is still under warranty, contact HP support for service or
replacement. For more information about ink cartridge warranty, see Ink cartridge warranty
information. If the problem persists after you replace the cartridge, contact HP support. For
more information, seeHP support.

Paper Mismatch
The paper size or type selected in the printer driver does not match the paper loaded in the
printer. Make sure that the correct paper is loaded in the printer, and then print the document
again. For more information, see Load media.

NOTE: If the paper loaded in the printer is the correct size, change the selected paper size
in the printer driver, and then print the document again.
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The cartridge cradle cannot move
Something is blocking the ink cartridge cradle (the part of the printer that holds the ink cartridges).

To clear the obstruction, press  (Power) button to turn off the printer, and then check the printer
for jams.

For more information, see Clear jams.

Paper Jam
Paper has become jammed in the printer.

Before you try to clear the jam, check the following:

• Make sure that you have loaded paper that meets specifications and is not wrinkled, folded,
or damaged. For more information, see Media specifications.

• Make sure that the printer is clean. For more information, see Maintain the printer.

• Make sure that the trays are loaded correctly and are not too full. For more information, see
Load media.

For instructions on clearing jams, as well as more information about how to avoid jams, see Clear
jams.

The printer is out of paper
The default tray is empty.

Load more paper, and then touch OK.

For more information, see Load media.

Printer Offline
The printer is currently offline. While offline, the printer cannot be used.

To change the printer's status, complete the following steps.

1. Click Start, point to Settings, and then click Printers or Printers and Faxes.
- Or -
Click Start, click Control Panel, and then double-click Printers.

2. If the printers listed in the dialog box are not being displayed in Details view, click the View
menu, and then click Details.

3. If the printer is Offline, right-click the printer, and click Use Printer Online.

4. Try using the printer again.

Printer Paused
The printer is currently paused. While paused, new jobs are added to the queue but are not
printed.

To change the printer’s status, complete the following steps.

1. Click Start, point to Settings, and then click Printers or Printers and Faxes.
- Or -
Click Start, click Control Panel, and then double-click Printers.

2. If the printers listed in the dialog box are not being displayed in Details view, click the View
menu, and then click Details.

3. If the printer is paused, right-click the printer, and click Resume Printing.

4. Try using the printer again.
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Document failed to print
The printer could not print the document because a problem occurred in the printing system.

For information about solving printing problems, see Solve printer problems.

Printer failure
There was a problem with the printer. Usually, you can resolve such problems by completing the
following steps:

1. Press the  (Power) button to turn off the printer.

2. Unplug the power cord, and then plug in the power cord again.

3. Press the  (Power) button to turn on the printer.

If this problem persists, write down the error code provided in the message, and then contact HP
support. For more information about contacting HP support, see HP support.

Door or cover open
Before the printer can print documents, all doors and covers must be closed.

TIP: When completely closed, most doors and covers snap into place.

If the problem persists after you’ve securely closed all doors and covers, contact HP support. For
more information, see HP support.

Previously used ink cartridge installed
The ink cartridge identified in the message was previously used in a different printer.

You can use ink cartridges in different printers, but if the cartridge was left outside of a printer for
an extended period of time, the print quality of your documents might be affected. Also, if you use
ink cartridges that have been used in a different printer, the ink level indicator might be inaccurate
or unavailable.

If the print quality is unsatisfactory, try cleaning the printheads. For more information, see Clean
the printhead.

NOTE: Ink from the cartridges is used in the printing process in a number of different ways,
including in the initialization process, which prepares the printer and cartridges for printing,
and in printhead servicing, which keeps print nozzles clear and ink flowing smoothly. In
addition, some residual ink is left in the cartridge after it is used. For more information, see
www.hp.com/go/inkusage.

For more information about storing ink cartridges, see Supplies.

Ink cartridges depleted
The cartridges listed in the message must be replaced to resume printing. HP recommends that
you do not remove an ink cartridge until a replacement is ready to install. For more information,
see Replace the ink cartridges.

Ink cartridge failure
The cartridges listed in the message are damaged or have failed. For more information, see
Replace the ink cartridges.
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Printer supply upgrade
The cartridge listed in the message can only be used to upgrade one printer. Click OK to use it on
this printer. If you do not wish to proceed with the supply upgrade for this printer, click Cancel
Print and then remove the cartridge.

Printer supply upgrade successful
The supply upgrade was successful. The cartridges listed in the message can now be used in the
printer.

Printer supply upgrade problem
The supply upgrade was not successful. The cartridges listed in the message can still be used in
this printer. Replace the Supply Upgrade cartridge. For more information, see Replace the ink
cartridges.

Non-HP ink cartridges installed
HP cannot guarantee the quality or reliability of non-HP supplies. Printer service or repairs
required as a result of using a non-HP supply will not be covered under warranty. If you believe
you purchased Genuine HP ink cartridges, visit HP at www.hp.com/go/anticounterfeit for more
information or to report fraud.

Using Genuine HP Cartridges has its Rewards
HP rewards loyal customers for using genuine HP supplies. Click the button below the message
to view Rewards online. Reward may not be available in all regions.

Counterfeit Cartridge Advisory
The installed cartridge is not a new, genuine HP cartridge. Contact the store where this cartridge
was purchased. To report suspected fraud, visit HP at www.hp.com/go/anticounterfeit. To
continue using the cartridge, click Continue.

Used, Refilled or Counterfeit Cartridge Detected
The original HP ink in the cartridge has been depleted. The solution for this problem is to replace
the ink cartridge or click OK to continue using the cartridge. For more information about replacing
the cartridge, see Replace the ink cartridges. HP rewards loyal customers for using genuine HP
supplies. Click the button below the message to view Rewards online. Rewards may not be
available in all regions.

WARNING! HP's ink cartridge warranty does not cover non-HP ink or cartridges. HP's
printer warranty does not cover repairs or service due to use of non-HP cartridges or ink. HP
does not guarantee the quality or reliability of non-HP ink. Information about ink levels will not
be available.

Use SETUP cartridges
Use the SETUP cartridges that came with the printer for printer initialization. You must replace the
cartridge with the setup cartridge to clear this message. For more information, see Replace the ink
cartridges.
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Do not use SETUP cartridges
SETUP cartridges cannot be used after the printer has been initialized. Remove and install non-
SETUP cartridges. For more information, see Replace the ink cartridges.

New printhead low on ink
The used cartridges listed in the message might not have enough ink to complete one-time
startup processes.

Solution: Install new cartridges or click Continue to use installed cartridges.

If startup cannot complete with installed cartridges, new cartridges will be needed. For information
on how to install new cartridges, see Replace the ink cartridges.

Use black ink only?
The cartridges listed in the message are low on ink.

Solutions: To print in color, replace the empty cartridges. For information about how to install new
cartridges, see Replace the ink cartridges.

To temporarily print using Black ink only, click Use Black Only. The printer will replace color with
grayscale. The empty cartridges will need to be replaced soon.

CAUTION: Do not remove the empty cartridge to print in black-ink only mode.

Use color ink only?
The black cartridge is low on ink.

Solutions: To temporarily replace black with color, click Use Color Only. Black will be simulated.
Text and photo quality will differ from those printed when using all cartridges. The black cartridge
will need to be replaced soon.

CAUTION: Do not remove the empty cartridge to print in color-ink only mode.

To print with black, replace the black ink cartridge. For information about how to install new
cartridges, see Replace the ink cartridges.

Incompatible ink
The printer has detected that the type of ink in the cartridges listed in the message is incompatible
with the ink system for the printer and can cause serious harm to the printhead.

Solution: Remove this cartridge immediately and replace with a compatible ink cartridge. For
information about how to install new cartridges, see Replace the ink cartridges.

Ink sensor warning
The ink sensor is reporting an unexpected condition. This could be caused by the cartridge, or the
sensor may have failed. If the sensor has failed, it can no longer sense when your cartridges are
low on ink. Printing with an empty cartridge will cause air to enter the ink system, which causes
poor print quality. Significant amounts of ink will be used up to recover from this condition, which
will deplete much of the ink supply for all cartridges.

Solution: Click OK to continue printing or replace the cartridge. For information about how to
install new cartridges, see Replace the ink cartridges.
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Problem with printer preparation
The printer clock has failed and ink preparation may not be complete. The estimated Ink Level
gauge might be inaccurate.

Solution: Check the print quality of your print job. If it is not satisfactory, running the printhead
cleaning procedure from the toolbox might improve it. For more information about cleaning the
printhead, see Clean the printhead.

Color cartridge low on ink
The cartridges listed in the message are low on ink.

Solutions: To print in color, replace the empty cartridges. For information about how to install new
cartridges, see Replace the ink cartridges.

To temporarily print using black ink only, click Cancel Print and then re-send the print job. The
Use black ink only? message appears before the job prints. The empty cartridges will need to be
replaced soon.

CAUTION: Do not remove the empty cartridge to print in black-ink only mode.

Black cartridge low on ink
The black cartridge is low on ink.

Solutions: Replace the black ink cartridge. For information about how to install new cartridges, see
Replace the ink cartridges.

To temporarily replace black with color, click Cancel Print and re-send the print job. The Use
color ink only? message appears before the job prints. The black cartridge will need to be
replaced soon.

CAUTION: Do not remove the empty cartridge to print in color-ink only mode.

Startup routine ink alert
The cartridges listed might not have enough ink to complete one-time startup processes.

Use of installed cartridges may result in air left in the print system after one time startup routine,
which causes poor print quality. Significant amounts of ink will be used to try to recover from this
situation.

If you received cartridges with your replacement printer or printhead, use them for startup. Install
new cartridges or click OK to use currently installed cartridges.

Problem with ink system
Please remove the ink cartridges and examine them for any sign of leaks. If any cartridges have
leaks, contact HP. Do not use cartridges that are leaking.

If there are no leaks, re-install cartridges and close the printer cover. Turn the printer off then on
again. If you get this message a second time, contact HP.

Replace the ink cartridge
Replace the indicated ink cartridge. For more information, see Replace the ink cartridges.
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NOTE: If your cartridge is still under warranty, contact HP support for service or
replacement. For more information about ink cartridge warranty, see Ink cartridge warranty
information. If the problem persists after you replace the cartridge, contact HP support. For
more information, see HP support.
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